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1: About Families 
 

The Families windows display information about a family, such as status, individual member names, 
addresses, pictures, and financial activity. You can add new families to the program here. To access family 
information, on the Information tab, click Families. 

 
Fig. 1‐1. 
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Family Fields that are Always Visible 
As you access the different sections of the Families window, the following fields remain visible at the top 
of the window: 

ID Number 
If required, each family must have a unique ID number.  To view available ID numbers, click Avail? It is not 
recommended that you use leading zeros, symbols, or letters of the alphabet in the family ID. 

 
Fig. 1‐2. 

To configure the use of IDs in the program, on the File menu, click Setup > ID Number Options. 

 
Fig. 1‐3. 

If you share data with Church Office, you can select to use the Church ID/Envelope numbers for family IDs.  
If you select this option, then the ID/Envelope number for the family record in Church Office is shared 
with the ID number for the family record in Formation. So any changes to the ID numbers will affect both 
programs.  If you clear this option, each program maintains its own set of ID numbers. 
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Family Name 

Build the family name in the Family Name dialog box. At the end of the Family Name field, click  . 

 
Fig. 1‐4. 

As you enter the different parts of the name, the program fills in the mailing name and salutations. When 
you add a family, this dialog box has check boxes next to the Head and Spouse names. Select these check 
boxes to automatically add member records for the Head and Spouse. 

 
Fig. 1‐5. 
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You can set up these check boxes to be selected by default. On the File menu, click Setup > Initial Setup. 
Select or clear the Disable Add Head/Spouse when Add Family option. 

 
Fig. 1‐6. 

Also Visible In 
If you share a database with another Office program, some families from that program may be visible in 
Formation Office. A blue icon indicates the family is also a Church Office family. A red icon indicates the 
family is also a School Office family. For more information about the different icons that can display here, 
see the Appendix chapter of this training guide. 

 
Fig. 1‐7. 

Active/Inactive vs. Delete 
To indicate that the family and all of its members are no longer active, select Inactive. Inactive families 
still display in the program and can be included in (or excluded from) reports. Depending on your 
organization's needs, you can define what "inactive" means and decide when to select this check box. 

 
 Useful Information 

In a shared environment, each program maintains its own inactive flags unless you select to share 
inactive flags. In Church Office, on the File menu, click Setup > Initial Setup. In the Share Data Options 
section, select Share Church Inactive Flags. Then, in the Initial Setup window of Formation Office, select 
to use the shared fields. 

 

To permanently remove a family from the program, locate the family's record, and in the Tasks group, 
click Delete Family. When you run reports, there is no option to include deleted families. If the family is 
used by any other program, it is hidden from view. However, if no other program uses the family record, 
you can either hide the family or permanently delete the family record. Once a family is permanently 
deleted, the only way to recover their information is to restore data from a backup or manually re‐enter 
their information. 
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Entering Primary Information 
In the Primary Information window, you can enter or view the family’s address, email addresses, phone 
numbers, picture, family keywords, and remarks. To access this window, in the navigation pane, click 
Primary Information. 

 
Fig. 1‐8. 

Status, City/State, Phone Number Description, and Family Keywords — These are all keyword fields. The 
program maintains multiple keyword lists for values you frequently enter. This helps avoid duplicate and 
inconsistent entries. You can access a keyword list by clicking Manage on any corresponding keyword 
drop‐down list. For more information, see the Keywords chapter of this training guide. 

Left Parish ‐ When a family is no longer registered at your parish, enter the date they left, or click   to 
select a date. When entering a Left Parish date, the program will prompt you to make the family inactive. 
Select Yes if you want to mark the family as Inactive.  At the end of several date fields, there is a 

 button you can use this to change the date format. 

 
Fig. 1‐9. 

Map — At the end of most address fields, there is a  button. To display a picture of the address 
location, click this button. 
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Fig. 1‐10. 

From the Mapping Preferences menu, you can select one of the following mapping services: 

 Google 

 Yahoo 

 MapQuest 

 Other 

These mapping services require an active internet connection. The map that displays depends on the 
address entered in the program. 

ZIP/Postal — At the end of most ZIP/Postal Code fields, there is an ellipsis button   you can click to 
display additional information used by the EZ‐Mail (bulk mailing feature). This extra information is not 
typically entered by hand, but rather imported by the CASSIt! Certification process. The Longitude and 
Latitude settings provide an alternative way of pinpointing an address location. 

 
Fig. 1‐11. 
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Geog. Area — Enter the geographic area. Use this field to group families by address. You can use any 
combination of numbers or you can leave this field blank. 

If you use numbers and letters, entry must be consistent or it may seem as though families are not sorted 
correctly when you print reports sorted by area. If you use letters and numbers, with letters first, always 
enter the same number of letters and numbers. If the highest number has three digits, then all numbers 
must have three digits (ex. 001). Otherwise, 1 will process as 100. If you enter numbers first, it is not 
necessary to lead a single digit number with zero’s. 

Email — Enter the family's email address. You can add an unlimited number of email addresses and send 
an email to all listed email addresses at once. Select Pref. if the family prefers email instead of mail when 
possible, and select Unl. if you want the email address to be omitted from reports created for external 

use. Click   to send an email to the selected email address using your default email application. 

Phones — You can enter an unlimited number of phone numbers for each family. In this grid, enter the 
phone number, a description (such as Home or Office), and indicate if the number is unlisted. When you 
print reports, you can select to print unlisted numbers as XXX‐XXXX. To maintain the list of phone 
numbers, use the Insert, Line Delete, and Reorder buttons. 

Picture File Name — Enter the file path to the family's picture. To locate the path, click  . Once you 
insert a picture, click the thumbnail to enlarge it. 

 
 Useful Information 

To indicate where family pictures are located, on the File menu, click Setup > Initial Setup. For the 
Default Picture Subdirectory, enter the file path to your family pictures. 

 

Remarks — Enter general or confidential remarks. You can password‐protect confidential remarks, so that 
only authorized users can view them. 

Family Keywords — You can add an unlimited number of keywords per family. Family keywords are used 
to identify a group of families with something in common, such as Receives Newsletter, Founding Family, 
or School Family. You can enter keywords "on the fly". If you enter a keyword that is not in the list, you 
can add it in this window if you have appropriate user rights. For more information about keywords, see 
the Keywords chapter of this training guide. 
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Entering Other Addresses 
To enter or view the family's mailing address and alternate address information, in the navigation pane, 
click Other Addresses. 

 
Fig. 1‐12. 

Mailing Address 
If the family's mailing address is different than the street address, enter it in this window. For example, 
the family might have a P.O. box. If the mailing address is the same as the street address entered in the 
Primary Information window, leave this section blank. 

When you run reports, the program looks here for a mailing address. If you leave this section blank, the 
program uses the street address entered in the Primary Information window. 

Alternate Address 
If the family has an alternate address, such as a vacation home, enter it here. Indicate the date range that 
this alternate address is used. You can also enter alternate email addresses here and select whether 
letters should be sent via email instead of mail. 
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Entering Relationships 
For a family or members of a family, you can add any number of relationships with other 
members/families in your PDS Office database as well as with people outside of your parish. 

You may want to add a relationship when there's someone outside of the family that you need to contact 
or send information to. For example, with divorced families, you may need to contact the birth parent or 
send them a letter regarding their child. Other examples include grandparents, godparents, emergency 
contacts, family friends, and doctors/dentists. 

To add relationships, in the navigation pane, click Relationships.

 
Fig. 1‐13. 

 

 
 Useful Information 

If you share data between your PDS Office programs, the relationship information you enter in Formation 
Office is automatically added in Church and School. Also, the drop‐down list for members and families 
includes all visible data in your data file, so you can select records from Formation and School Office 
within your Church program. 

 

To add a relationship with an existing member or family  

1. Locate the record of the family you want to add a relationship for. 
2. In the navigation pane, click Relationships. 
3. Click Use Existing Member or Use Existing Family. 
4. Select the member or family who has a relationship with the family. 
5. In the grid, select the family member(s) the person has a relationship with, or select [Name] 

Family to create the relationship with the entire family. 
6. In the Relationship and Reciprocal Relationship column, enter or select the relationship. 
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 Useful Information 

For example, if the member is the grandmother of the family member(s) you selected in the 
grid, enter Grandmother in the Relationship column and enter Grandchild in the Reciprocal 
Relationship column. 

7. Click Use/OK. 
8. Select whether or not you want to add the family relationship to the member's family record. 
9. When you're finished, click Save. 

 

To add a relationship with someone who isn't in your database  

1. Locate the record of the family you want to add a relationship for. 
2. In the navigation pane, click Relationships. 
3. Enter the name of the person who has a relationship with the family. 
4. Select the member(s) who the person has a relationship with, or select [Name] Family to create 

the relationship with the entire family. 
5. Enter any additional information about the person. 
6. When you're finished, click Save. 

 

Send Courtesy Copies – Marks the relationship so you can send a courtesy copy when sending a letter to 
the family. 

Show on Fam Directory – Prints the relationship information on Family Directory reports. This is helpful 
for divorced families 
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Viewing the Family Recap 
To view a list of members and funds associated with a family, in the navigation pane, click Family Recap. 
Double‐click a family member or fund to go directly to their respective windows. To print the recap, click 
Print. 

 
Fig. 1‐14. 
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Keeping Track of Family Letters, Visits, Etc. 
You can track outgoing and incoming correspondence such as letters and emails, phone calls, and visits. 
To keep track of correspondence with the family, in the navigation pane, click Letters, Visits, Etc. 

 
Fig. 1‐15. 

To keep track of family correspondence  

1. Locate the record of the family. 

2. In the navigation pane, click Letters, Visits, Etc. 
3. Click Insert, and enter information about the correspondence. 

 
 Useful Information 

You can enter up to 30 characters in each field. 

Some examples of what you can enter in the Description field include "Birthday Letter", "4th of 
July Email", or "Ministry Campaign Phone Call". 

The Type field uses entries from the Letter Types keyword list. 

4. Click Save. 

 

When you run a letter report or send an email to a family, the program asks if you want to log a history of 
the letter correspondence. 
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Using the Navigation Tools to Locate Families 
Use the Navigation tools to locate or scroll through family records. 

 
Fig. 1‐16. 

To scroll through families, click  or  . To jump to the first or last family, click  or  . To 
change the order of families, select an option in the Order by drop‐down list. 

To display a list of members in the current family, click Members. Click a member to go directly to their 
record. 

To locate a particular family, in the Search field, enter the family's name and press Enter, or click  . If 
the name has a special character, right‐click in the Search field and click Insert Symbol. 

In the Search By drop‐down list, select an option to search by. 

 
Fig. 1‐17. 

If you select an option that could return multiple families, such as Search By Partial Address, the program 
displays a list of matching families. From that list, select the family you want to view. 

The bottom of the Search By drop‐down list displays recently accessed families. Select one of these 
families to return to their record. 
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Family Tasks 
In the Tasks group, you can save or cancel changes to the window, or add or delete families. 

 
Fig. 1‐18. 

Save 
To save all changes to the current family, click Save. The program automatically saves the current family 
when you do the following: 

 Navigate to a different family. 

 Add a new family. 

 Switch between any of the sections in the navigation pane. 

 Leave the Families window. 

 Exit the program. 

Cancel 
To cancel any changes made since the last save, click Cancel. 

Add Family 
To add a new family, click Add Family. If there are families available in the database, but not visible in 
Formation Office, you have the opportunity to select them. 

 
Fig. 1‐19. 

Use This Family — Make the selected family visible in the program. 

Add New Family — Manually create a new family record. 
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Delete Family 
To delete the current family, click Delete Family. The program displays a confirmation dialog box and a 
print dialog box. If the family is not used by another program, you can either hide the family in the 
database or permanently delete the family. 

 
Fig. 1‐20. 

Creating an Individual Family Letter or Label 
To create a letter addressed directly to the family, in the navigation pane, click Individual Letter, Label. A 
report wizard displays. For more information about creating letter reports, see the Reports chapter of this 
training guide. 

 
Fig. 1‐21. 
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Viewing Reasons for Changes 
To view reasons for changes to family information, click Reasons for Changes in the navigation pane of 
any family data entry window. 

 

 
 Useful Information 

To configure the use of Reasons for Changes in the program, on the File menu, click Setup > Initial Setup. 
In the program options section, select Ask for Reason on Significant Changes. 

 

 
Fig. 1‐22. 

There are three buttons provided to help you with sorting, printing, and logging more information 
changes: 

 Click Order by and select a column heading to reorder the log. 

 Click Log Report to print a report of activity. 

 Click Manual Log Entry to add an entry in the log for a change to family information that is 
outside of the range of automatically‐logged changes. For example, if you select the Send No 
Mail check box on the Families window, then click Save, the Reason for Change dialog box does 
not display. You have to log the change manually for it to be on record. 
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Fig. 1‐23. 

To create a manual log entry  

1. In the Families Primary Information window, click Reasons for Changes. 
2. In the View Reasons for Changes dialog box, click Manual Log Entry. 
3. In the General Reason for Change data field, click the drop‐down arrow and make a relevant 

selection. 
4. In the More Info. for the Change data field, enter more information about the change, such as 

the type of change you are making. 
5. In the Original Value data field, enter the original data description. 
6. In the New Value data field, enter the new data description. 
7. Click Log/OK. 
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Exercise 
Exercise #1 

Add your own family.  Include your: 

 Name, using the Family Name dialog box. 

 Address 

 Phone, including work and home, marking the home phone as unlisted. 

 Email 

 Keywords, such as ‘Receives Newsletter’. 

 

Questions 
Answer these questions pertaining to families. 

Q: What two things should not be used in ID numbers? 

A:                      

 

Q: How many phone numbers can a family have? 

A:                      

 

Q: How many keywords can a family have? 

A:                      

 

Q: Where can you record confidential remarks about a family? 

A:                      

 

Q: How can you send a letter addressed directly to the family? 

A:                      
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2: About Students 
 

The Students windows display information specific to a student as well as information about the student's 
family. You can view information pertinent to everything from everyday activities to emergency 
situations. To access student information, on the Information tab, click Students. 

 
Fig. 2‐1. 

Student Fields that are Always Visible 
As you access the different sections of the Students window, the following fields remain visible at the top 
of the window: 

Status Icons 
You may see various icons that indicate certain characteristics of individuals. 

 
Fig. 2‐2. 
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Icon  Description

 

Signifies the individual has something entered for confidential remarks on the Student and Parents 
& Guardians Personal windows. 

 

Signifies the individual has something entered for special circumstances on the Students and 
Parents & Guardians Personal window. 

 

Signifies the individual has a different last name than the family. 

 
Signifies the individual is a student. 

Student Name 

Build the student name in the Member Name dialog box. At the end of the Student Name field, click  . 

 
Fig. 2‐3. 

As you enter the different parts of the name, the program fills in the mailing name and salutations. If you 
manually change the mailing name or salutations, the Recalculate button becomes available. To restore 
the mailing name and salutations to the version the program created, click this button. 

When you finish entering the name, click Apply/OK. In the Students window, if you want to view the 
mailing name and salutations for the student without editing anything, click Show Name Formats. 
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Add and View Documents  
Click Add Documents to upload additional documents to support the information you've already entered. 
Once you have linked files to records in your program, click View Documents to view the documents 
associated with the current record. For more information, see the About Adding and Viewing Documents 
chapter of this training guide. 

 
Fig. 2‐4. 

Also Visible In 
If you share a database with another Office program, some individuals from that program may be visible 
in Formation Office. A blue icon indicates the individual is also a Church Office member. A red icon 
indicates the individual is also a School Office member. For more information about the different icons 
that can display here, see the Appendix chapter of this training guide. 

 
Fig. 2‐5. 

Active/Inactive vs. Delete 
To indicate that the student is no longer active, select Inactive. Inactive individuals still display in the 
program and can be included in (or excluded from) reports. Depending on your organization's needs, you 
can define what "inactive" means and decide when to select this check box. 

 
 Useful Information 

In a shared environment, each program maintains its own inactive flags unless you select to share 
inactive flags. In Church Office, on the File menu, click Setup > Initial Setup. In the Share Data Options 
section, select Share Church Inactive Flags. Then, in the Initial Setup window of the other program, select 
to use the shared fields. 

To permanently remove a student from the program, locate the student's record, and in the Tasks group, 
click Delete Student. When you run reports, there is no option to include deleted students. If the student 
is used by any other program, it is hidden from view. However, if no other program uses this individual’s 
record, you can either hide the student or permanently delete the individual’s record. Once an individual 
is permanently deleted, the only way to recover their information is to restore data from a backup or 
manually re‐enter their information.   
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Entering Student Details 
The Detail window, you can enter or view the details about the student’s sessions. To access this window, 
in the navigation pane, click Details. 

The top portion of the window displays a list of sessions, and the bottom portion displays the details of 
the selected session. To add new sessions to the student's record, click Insert below the grid. 

 
Fig. 2‐6. 

User Defined Remarks 
On the user‐defined remarks tabs, you can track health or miscellaneous information. By default, these 
fields are Health Problems, Other Conditions, Misc. Information, and Remarks.  

 
 Useful Information 

You can change the terms used for these remark fields. On the File menu, click Setup > Initial Setup, and 
click the Student Options tab. Then in the Student Information section, define the names you want to 
use for Student Fields 1 – 4. 
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Entering Personal Information 
In the Personal window, you can enter or view the student's gender, age, and any keywords associated 
with the student. To access this window, in the navigation pane, click Personal. 

 
Fig. 2‐7. 

Relationship, Grade/Degree, Marital Status, Language, and Ethnicity — These are keywords built into the 
program. Any keywords you created also display in this window. In the example above, Religion and 
Occupation are user‐defined keywords. To create user‐keyword lists, on the File menu, click Keywords > 
Student/ Parent/Guardian Keywords > User Keywords. For more information about keywords, see the 
Keywords chapter of this training guide. 

Birth Date and Deceased Date — Enter the birth date and/or deceased date, if applicable. You can use 

 to select the date. When entering a deceased date, the program displays the Mark Member Deceased 
dialog where you can specify common data updates such as adding deceased dates to the sacraments list, 
marking active talents and ministries as no longer involved, etc.  

At the end of several date fields, there is a   button you can use to change the date formats. 

 
Fig. 2‐8. 

Picture File — Enter the file path to the student's picture. To locate the path, click  . Once you insert a 
picture, click the thumbnail to enlarge it.   
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 Useful Information 

To indicate where pictures are located, on the File menu, click Setup > Initial Setup. For the Default 
Picture Subdirectory, enter the file path to your pictures. 

 

Remarks — Enter general, confidential, or special circumstances remarks. You can password‐protect 
confidential remarks and special circumstances, so that only authorized users can view them. On the 
Administration tab, select an access level under Students > Confidential Stu. Remarks and Students > 
Student Special Circ. 

Student Keywords — You can add an unlimited number of keywords per student. Student keywords are 
used to identify a group of students with something in common. Use a student keyword when there is no 
specific field available in the program for something you want to track. You can enter keywords "on the 
fly". If you enter a keyword that is not in the list, you can add it in this window if you have appropriate 
user rights. For more information about keywords, see the Keywords chapter of this training guide. 

Tracking Attendance 
In the Attendance window, you can track information about a student’s attendance. In the navigation 
pane, click Attendance. 

 
Fig. 2‐9. 

To enter attendance information  

1. Click Insert below the grid, and enter the student's attendance information. 

 
 Useful Information 

 The Attendance For field uses entries from the Attendance For Names keyword list. 

 Units typically represent a number of hours or days, but you can define them however 
you want. On the File menu, click Setup > Unit Name Definitions. 

 The Reason field uses entries from the Attendance Reason keyword list. 
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2. Click Save. 

 

To filter the attendance list 

1. In the navigation pane, click Attendance. 
2. Click Filter List below the grid. Specify how you want to filter the list; you can filter the list by 

Session Name, Type and Date. 

 
Fig. 2‐10. 

3. Click Lookup/OK. 

Entering Student Communication 
To enter a student's phone numbers, email addresses, and social media information, in the navigation 
pane, click Communication. This window also displays a recap of the family and member contact 
information. The information in the lower section of the window cannot be changed; however, you can 
print it. 

 
Fig. 2‐11. 

To insert a phone number or email address  

1. Locate the appropriate individual. 
2. In the navigation pane, click Communication. 
3. Click Insert below each grid, and enter the individual's phone number(s) and/or email 

address(es). 
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4. If the phone number or email address is unlisted, select Unl. 
5. If the individual prefers to receive email rather than mail, select Pref. 
6. Click Save. 

 

You can include a link to quickly access an individual's Facebook, Twitter, or Blog page from within the 
program. 

 
Fig. 2‐12. 

To set up links to social media 

1. Locate the appropriate individual. 
2. In the navigation pane, click Communication. 
3. In the Social Media section, click Set Up. 
4. In the Social Media dialog box, enter the webpage address for each link you want to set up. 

 
 Useful Information 

To ensure that the information you enter is correct, copy the webpage address from your 
Internet browser's address bar, then paste it into the appropriate field. 

5. Click Save/OK. 

After you set up the links, in the Communication window, click the icon of the social media page you want 
to view. The webpage opens in your Internet browser. 
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Viewing Service and Retreats 
The Service and Retreats window displays services a student has performed or retreats they attended. In 
the navigation pane, click Service/Retreats. 

 
Fig. 2‐13. 

To enter a student's service/retreat information, click Insert below the grid. Click Save when you're done. 

 
 Useful Information 

The Service/Retreat field uses entries from the Service/Retreat Names keyword list. 
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Viewing Enrollment History and Permanent Records 
The Enrollment/Perm. Rec. window displays a student's enrollment history and their permanent record. 
At the top of the window, the student's enrollment history displays by date, year, and grade. At the 
bottom of the window, a permanent record of sessions displays and whether or not the student passed. 

In the navigation pane, click Enrollment/Perm. Rec.

 
Fig. 2‐14. 

To enter enrollment history information, click Insert below the Enrollment History grid. 

 
 Useful Information 

Enrollment information can also be posted to this window when using the Enrollment process. To use the 
Enrollment process, in the Students navigation pane, click Processes > Enrollment. 

 

The Grade field uses entries from the Grades and Degrees keyword list. 
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To enter permanent record information, click Insert below the Permanent Record grid. 

 
 Useful Information 

Permanent Record information can also be posted to this window when using the End of Year – 
Formation Remove/Advance process. In the Students navigation pane, click Processes > End of Year – 
Formation Remove/Advance. 

To print a simple report of the permanent record information, click Print. 

Entering Sacrament Information 
In the Sacraments window, there are multiple tabs that display detailed sacramental information. In the 
navigation pane, click Sacraments. 

On each tab, you can enter and edit sacramental information.  

 
Fig. 2‐15. 

With the exception of the General Information and Date List tabs, you can customize the sacrament tab 
names. On the File menu, click Keywords > Student/ Parent/Guardian Keywords > Sacrament Date 
Names. You can track an unlimited number of dates. 
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Fig. 2‐16. 

In the Sacraments window, you can view up to eight sacrament tabs. The sacraments you select display 
on individual tabs between the General and Date List tabs. Any additional sacraments you want to track 
display on the Date List tab. 

To select the eight most important sacraments, on the File menu, click Sacrament Setup > Sacrament Tab 
Names. You can also label the Extra Information field in this window, which then displays on the relevant 
tab. 

 
Fig. 2‐17. 

If you share your database with another Office program, the eight tabs you identify in this window are 
used in all programs. If you want to track a sacrament but not display it, clear the Display Tab check box. 
These check boxes are stored individually for each program. For example, in Church Office, you can track 
and display Marriage, and in Formation Office, you can select to hide Marriage. 

In the Sacraments window, on the General Information tab, view or enter birth data. To insert the Birth 
Date, Head of Household, and Spouse values entered in the Personal window, click Use Default Values. 
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On the Date List tab, view a list of all sacraments. If you change information on this tab, the appropriate 
sacrament tab is also updated. 

 
Fig. 2‐18.  

The tabs between the General and Date List tabs display information about the individual sacraments. For 
these tabs, select the sacraments you want to print certificates for or track sponsor information. 

 
Fig. 2‐19. 
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To maintain the names and addresses of churches where the sacraments are administered, on the File 
menu, click Sacrament Setup > Sacrament Place Names and Addresses. 

 
Fig. 2‐20. 

To print the information on the sacrament tabs, click Print Certificate. 

 
Fig. 2‐21. 

Select the style of certificate you want to print. If you click Print Certificate on the Confirmation 
sacrament tab, the program uses the confirmation information from that tab, but you must indicate you 
want to print the information on one of the Confirmation forms. 

To create your own certificates, click Add. Or, to modify a predefined certificate style, click Copy. The 
report wizard steps you through setting up the certificate. For more information, see the Reports chapter 
of this training guide. 
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Fig. 2‐22. 
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Entering Ministries and Talents 
The Ministries/Talents window displays which ministries the student is involved in and the talents the 
student chooses to share. A ministry is a church‐related group or activity that an individual can participate 
in, such as choir or money counter. A talent is a special skill the individual has, such as painting or CPR 
training. Ministries, talents, and statuses are keywords. 

In the navigation pane, click Ministries/Talents. 

 
Fig. 2‐23. 

To insert a ministry or talent  

1. Locate the appropriate record. 
2. In the navigation pane, click Ministries/Talents. 
3. Click Insert below each grid, and enter the student's ministry and/or talents or select one from 

the drop‐down list. 
4. Enter any additional information, if known. 

 
 Useful Information 

The Status field is a keyword field that indicates their level of involvement or interest.

5. Click Save.  
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Viewing the Family Recap 
You can view a list of an individual's family members and the funds associated with his or her family. In 
the navigation pane, click Family Recap. 

 
Fig. 2‐24. 

To view family members and funds  

1. Locate the appropriate individual. 
2. In the navigation pane, click Family Recap. 
3. The members of the family display in the Family Members grid. The family's fund information 

displays in the Funds grid. 

 
 Useful Information 

The information in the grids is view‐only and can't be edited.

4. Double‐click a family member or fund to go directly to their respective windows. 
5. To print a simple report of the information, click Print. 

 
 Useful Information 

Alternatively, you can quickly view the other family members by clicking the 1 of # drop‐down list in the 
Navigation group. 
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Entering Emergency Contacts 
The Contacts window displays a student's emergency contacts, other than the parents/guardians. This can 
include neighbors, grandparents, doctors, etc. You can enter an unlimited number of contacts and an 
unlimited number of phone numbers for each. In the navigation pane, click Contacts. 

 
Fig. 2‐25. 

To add an emergency contact 

1. Locate the appropriate student. 
2. In the navigation pane, click Contacts. 
3. Click Add Contact. 

 
 Useful Information 

Because siblings usually have the same emergency contacts, one student can "borrow" a contact 
from another sibling. When you click Add Contact, the program asks if you want to borrow a 
contact from another family student. To do so, click Yes, select the contact, and the information 
is automatically added to this student's record. 

4. Enter any information you want to include. 

 
 Useful Information 

The Relationship field uses entries from the Relationship Names keyword list. 

5. Click Save. 

 

As you add contacts, a tab displays at the bottom for each contact. 
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About Safe Environment 
In the Safe Environment window, you can track any background checks or other requirements necessary 
for the individual to be around or work with children. In the navigation pane, click Safe Environment. 

 
Fig. 2‐26. 

In the top portion of this window, enter information acquired when doing background checks such as 
federal, employment, and fingerprint background checks. In the bottom portion, enter any other 
requirements that must be met such as sensitivity training, reference letters, etc. 

   

 
 Useful Information 

 The Background Check Description field uses entries from the Background Check 
Descriptions keyword list. 

 The Other Requirements Description field uses entries from the Requirement Descriptions 
keyword list. 

 The Result field uses a pre‐defined list of terms. 

 The Note field is an open remarks field that can contain up to 50 characters of information. 
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We partner with SecureSearch™ to provide background screening results for individuals in your parish, 
such as personnel or volunteers. 

 
 Useful Information 

To use this feature, you must create an account with SecureSearch. Complete the SecureSearch 
Agreement for Service and fax it to 1‐866‐552‐7326. 

For more information, visit www.parishdata.com/backgroundchecks. 

Once you have an account, you can manage an individual's background checks in the Safe Environment 
section where you can: 

 Request a background check for an individual. 

 Receive the background check results from SecureSearch. 

 Enter additional legal requirements. 

 

You can purchase individual background checks from within your PDS program. 

To run a background check  

1. Locate the individual's record. 
2. In the navigation pane, click Safe Environment. 
3. Click Request Background Check, and log in to the service. 
4. Products and prices are listed. Select the options you want, enter the required information, and 

click Submit. 
5. Close the background check window. 
6. Click Check Results to see if your results have been received. 
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Keeping Track of Student Letters, Visits, Etc. 
You can track outgoing and incoming correspondence such as letters and emails, phone calls, and visits. 
To keep track of correspondence with an individual, in the navigation pane, click Letters, Visits, Etc. 

 
Fig. 2‐27. 

To keep track of student correspondence  

1. Locate the record of the student. 
2. In the navigation pane, click Letters, Visits, Etc. 
3. Click Insert, and enter information about the correspondence. 

 
 Useful Information 

You can enter up to 30 characters in each field. 
Some examples of what you can enter in the Description field include "Schedule Letter", 
"Event Calendar", or "Confirmation Certificate". 
The Type field uses entries from the Letter Types keyword list. 

4. Click Save. 

 

When you run a letter report or send an email to a student, the program asks if you want to log a history 
of the letter correspondence. For more information about logging letters, see Logging Letters in the 
Reports chapter of this training guide. 
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Using the Navigation Tools to Locate Students 
Use the Navigation tools to locate or scroll through student records. 

 
Fig. 2‐28. 

To scroll through students, click  or  . To jump to the first or last student, click  or  . To 
change the order of students, select an option in the Order by drop‐down list. 

To display a list of students in the current family, click  . This button depends on the 
number of members in the family. Click a member to go directly to their record. 

To locate a particular individual, in the Search field, enter their name and press Enter, or click  . If the 
name has a special character, right‐click in the Search field and click Insert Symbol. 

In the Search By drop‐down list, select an option to search by. 

 
Fig. 2‐29. 

If you select an option that could return multiple individuals, such as Search By Partial Address, the 
program displays a list of matching individuals. From that list, select the individual you want to view. 

The bottom of the Search By drop‐down list displays recently accessed families and individuals. Select one 
of these families or individuals to return to their record. 
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Student Tasks 
In the Tasks group, you can save or cancel changes to the window, or add or delete students. 

 
Fig. 2‐30. 

Save 
To save all changes to the current student, click Save. The program automatically saves the current record 
when you do the following: 

 Navigate to a different student. 

 Add a new student. 

 Switch between any of the sections in the navigation pane. 

 Leave the Students window. 

 Exit the program. 

Cancel 
To cancel any changes made since the last save, click Cancel. 

Add Student 
To add a new student, click Add Student. If there are members for this family available in the database, 
but not visible in Formation Office, you have the opportunity to select them. 

 
Fig. 2‐31. 

Add to This Family — If the student's family already exists in the program, select it in the drop‐down list, 
then click this button. 

Create a New Family — If the student's family does not exist in the program, click this button to add it. 
For more information, see the About Families chapter of this training guide. 
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Delete Student 
To delete the current student, click Delete Student. The program displays a confirmation dialog box and a 
print dialog box. If the student is not used by another program, you can either hide them in the database 
or permanently delete the student. 

 
Fig. 2‐32. 

Reassigning a Student 
You may need to reassign a student to another family. For example, if a child goes to live with their 
grandparents, you can transfer the child's record to the grandparents' existing record. 

 
Fig. 2‐33. 

To reassign a student  

1. Locate the appropriate record. 
2. In the navigation pane, click Reassign Student. 
3. Select whether to create a new family record or add the student to an existing family. 
4. If you create a new family, select whether to copy addresses and phone numbers. 
5. Enter or select the ID number and family name. 
6. If fund payments have been posted for the student, select an option for their payments. 
7. When you're finished, click Reassign Student. 
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About Deceased Students 
When a student dies, instead of deleting their record from the program, you can indicate they are 
deceased and retain their information.  When entering a deceased date, the program displays the Mark 
Member Deceased dialog where you can specify common data updates, all from one location. The 
student's name displays in red, the Inactive check box displays as Deceased, and the age of the student 
no longer advances. 

  
Fig. 2‐34. 

Deceased Member  
Use the Decease Member section to make some common changes for the deceased student’s record. 

Change Type — Select this option if you want the program to change the individuals type and then specify 
the type using the drop‐down type list.  

Add Entry of Deceased to Sacraments List — Select this option if you want the program to automatically 
add an entry in the Date List tab of the students Sacraments window. 

Mark Talents/Ministries with Status of No Longer Involved — Select this option to change the status of 
any active ministries or talents to No Longer Involved on the student's Ministries/Talents window. 

About Students ‐ Exercises 
Exercise #1 — Add a student to your family. Use the following information: 

 Name — Miss Elizabeth Williams "Betsy" 

 Birth date — 12/10/2003 

 Grade — 3 

Exercise #2 — Add the following sacrament information for Betsy. 

 She was baptized on 12/15/2003 at this parish. 

 The baptism was performed by Fr. Robert Zello. 

 She is sponsored by Melissa Brown, a family friend. 

Exercise #3 — Print the Baptismal Certificate for Betsy. 

Exercise #4 — Add an emergency contact for Betsy. Use the following information: 

 Contact Name — Mrs. Esther Williams, grandmother 

 Address — 123 Sugar Plum Lane, Glendale, AZ 85055 

 Home Phone — (623) 545‐9087 
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About Students ‐ Questions 
Q: What symbol indicates that the student has a different last name? 

A: ________________________________________________________________________ 

 

Q: What information can you add to the Communications window? 

A: ________________________________________________________________________ 

 

Q: How many emergency contacts can a student have? 

A: ________________________________________________________________________ 

 

Q: How can a student "borrow" a sibling's emergency contact? 

A: ________________________________________________________________________ 

 

Q: What is the maximum number of sacraments that can display at once in the Sacraments window? 

A: ________________________________________________________________________ 

 

Q: Where do you change the order of the sacrament tabs? 

A: ________________________________________________________________________ 

 

Q: Where do you maintain the actual Sacrament Date names? 

A: ________________________________________________________________________ 

 

Q: How do you print a Confirmation Certificate from the sacrament tab? 

A: ________________________________________________________________________ 
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3: About Parents and Guardians 
 

The Parents & Guardians windows display information specific to a parent/guardian, including personal 
information, contact information, ministries, talents, funds, and other items. To access parent/guardian 
information, on the Information tab, click Parents & Guardians. 

 
Fig. 3‐1. 
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Parent/Guardian Name 
Build the parent/guardian’s name in the Member Name dialog box. At the end of the Parent/Guard. 

name field, click  . 

 
Fig. 3‐2. 

As you enter the different parts of the name, the program fills in the mailing name and salutations. If you 
manually change the mailing name or salutations, the Recalculate button becomes available. To restore 
the mailing name and salutations to the version the program created, click this button. 

When you finish entering the name, click Apply/OK. In the Parents & Guardians window, if you want to 
view the mailing name and salutations for the parent/guardian without editing anything, click Show Name 
Formats. 
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Add and View Documents  
Click Add Documents to upload additional documents to support the information you've already entered. 
Once you have linked files to records in your program, click View Documents to view the documents 
associated with the current record. For more information, see the About Adding and Viewing Documents 
chapter of this training guide. 

 
Fig. 3‐3. 

Also Visible In 
If you share a database with another Office program, some individuals from that program may be visible 
in Formation Office. A blue icon indicates the individual is also a Church Office member. A red icon 
indicates the individual is also a School Office member. For more information about the different icons 
that can display here, see the Appendix chapter of this training guide. 

 
Fig. 3‐4. 

Active/Inactive vs. Delete 
To indicate that the parent/guardian is no longer active, select Inactive. Inactive individuals still display in 
the program and can be included in (or excluded from) reports. Depending on your organization's needs, 
you can define what "inactive" means and decide when to select this check box. 

 
 Useful Information 

In a shared environment, each program maintains its own inactive flags unless you select to share 
inactive flags. In Church Office, on the File menu, click Setup > Initial Setup. In the Share Data Options 
section, select Share Church Inactive Flags. Then, in the Initial Setup window of the other program, select 
to use the shared fields. 

To permanently remove a parent/guardian from the program, locate the parent/guardian's record, and in 
the Tasks group, click Delete Par/Grd. When you run reports, there is no option to include deleted 
parent/guardians. If the individual is used by any other program, it is hidden from view. However, if no 
other program uses this individual’s record, you can either hide the parent/guardian or permanently 
delete the individual’s record. Once an individual is permanently deleted, the only way to recover their 
information is to restore data from a backup or manually re‐enter their information. 
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Entering Personal Information 
In the Personal window, you can enter or view the parent/guardian's relationship, age, and any keywords 
associated with the parent/guardian. To access this window, in the navigation pane, click Personal. 

 
Fig. 3‐5. 

Relationship, Grade/Degree, Marital Status, Language, and Ethnicity — These are keywords built into the 
program. Any keywords you created also display in this window. In the example above, Religion and 
Occupation are user‐defined keywords. To create user‐keyword lists, on the File menu, click Keywords > 
Student/Parent/Guardian Keywords > User Keywords. For more information about keywords, see the 
Keywords chapter of this training guide. 

Birth Date and Deceased Date — Enter the birth date or deceased date, if applicable. You can use   to 
select the date. When entering a deceased date, the program displays the Mark Member Deceased dialog 
where you can specify common data updates such as adding deceased dates to the sacraments list, 
marking active talents and ministries as no longer involved, etc.  

At the end of several date fields, there is a   button you can use to change the date formats. 

 
Fig. 3‐6. 

Picture File — Enter the file path to the parent/guardian's picture. To locate the path, click  . Once you 
insert a picture, click the thumbnail to enlarge it.   
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 Useful Information 

To indicate where pictures are located, on the File menu, click Setup > Initial Setup. For the Default 
Picture Subdirectory, enter the file path to your pictures. 

 

Remarks — Enter general, confidential, or special circumstances remarks. You can password‐protect 
confidential remarks and special circumstances, so that only authorized users can view them. On the 
Administration tab, select an access level under Parents/Guardians > Confidential P/G Remarks and 
Parents/Guardians > P/G Special Circumstances. 

Keywords — You can add an unlimited number of keywords per parent/guardian. Parent/Guardian 
keywords are used to identify a group of parent/guardians with something in common. Use a keyword 
when there is no specific field available in the program for something you want to track. You can enter 
keywords "on the fly". If you enter a keyword that is not in the list, you can add it in this window if you 
have appropriate user rights. For more information about keywords, see the Keywords chapter of this 
training guide. 

Entering Parent/Guardian Communication 
To enter a parent/guardian’s phone numbers, email addresses, and social media information, in the 
navigation pane, click Communication. This window also displays a recap of the family and member 
contact information. The information in the lower section of the window cannot be changed; however, 
you can print it. 

 
Fig. 3‐7. 

To insert a phone number or email address  

1. Locate the appropriate individual. 
2. In the navigation pane, click Communication. 
3. Click Insert below each grid, and enter the individual's phone number(s) and/or email 

address(es). 
4. If the phone number or email address is unlisted, select Unl. 
5. If the individual prefers to receive email rather than mail, select Pref. 
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6. Click Save. 

 

You can include a link to quickly access an individual's Facebook, Twitter, or Blog page from within the 
program. 

 
Fig. 3‐8. 

To set up links to social media 

1. Locate the appropriate individual. 
2. In the navigation pane, click Communication. 
3. In the Social Media section, click Set Up. 
4. In the Social Media dialog box, enter the webpage address for each link you want to set up. 

 
 Useful Information 

To ensure that the information you enter is correct, copy the webpage address from your 
Internet browser's address bar, then paste it into the appropriate field. 

5. Click Save/OK. 

After you set up the links, in the Communication window, click the icon of the social media page you want 
to view. The webpage opens in your Internet browser. 
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Entering Ministries and Talents 
The Ministries/Talents window displays the ministries the parent/guardian is involved in and the talents 
they choose to share. A ministry is a church‐related group or activity that an individual can participate in, 
such as choir or money counter. A talent is a special skill the individual has, such as painting or CPR 
training. Ministries, talents, and statuses are keywords. 

In the navigation pane, click Ministries/Talents. 

 
Fig. 3‐9. 

To insert a ministry or talent  

1. Locate the appropriate record. 
2. In the navigation pane, click Ministries/Talents. 
3. Click Insert below each grid, and enter the parent/guardian's ministry and/or talents or select 

one from the drop‐down list. 
4. Enter any additional information, if known. 

 
 Useful Information 

The Status field is a keyword field that indicates their level of involvement or interest.

5. Click Save.  
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Viewing the Family Recap 
You can view a list of an individual's family members and the funds associated with his or her family. In 
the navigation pane, click Family Recap. 

 
Fig. 3‐10. 

To view family members and funds  

1. Locate the appropriate individual. 
2. In the navigation pane, click Family Recap. 
3. The members of the family display in the Family Members grid. The family's fund information 

displays in the Funds grid. 

 
 Useful Information 

The information in the grids is view‐only and can't be edited.

4. Double‐click a family member or fund to go directly to their respective windows. 
5. To print a simple report of the information, click Print. 

 
 Useful Information 

Alternatively, you can quickly view the other family members by clicking the 1 of # drop‐down list in the 
Navigation group. 
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Entering Volunteer Areas 
In the Volunteer/Prep Classes section, you can enter information about the volunteer experiences or 
preparation classes that a parent or guardian participates in. In the navigation pane, click Volunteer/Prep 
Classes. 

 
Fig. 3‐11. 

To insert volunteer areas or preparation classes 

1. Locate the appropriate parent or guardian record. 
2. In the navigation pane, click Volunteer/Prep Classes. 
3. Below each grid, click Insert, then enter the parent/guardian's volunteer area or preparation 

class. You can also select one from the drop‐down list. 
4. Enter any additional information. 
5. Click Save. 
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About Safe Environment 
In the Safe Environment window, you can track any background checks or other requirements necessary 
for the individual to be around or work with children. In the navigation pane, click Safe Environment. 

 
Fig. 3‐12. 

In the top portion of this window, enter information acquired when doing background checks such as 
federal, employment, and fingerprint background checks. In the bottom portion, enter any other 
requirements that must be met such as sensitivity training, reference letters, etc. 

   

 
 Useful Information 

 The Background Check Description field uses entries from the Background Check 
Descriptions keyword list. 

 The Other Requirements Description field uses entries from the Requirement Descriptions 
keyword list. 

 The Result field uses a pre‐defined list of terms. 

 The Note field is an open remarks field that can contain up to 50 characters of information. 
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We partner with SecureSearch™ to provide background screening results for individuals in your parish, 
such as personnel or volunteers. 

 
 Useful Information 

To use this feature, you must create an account with SecureSearch. Complete the SecureSearch 
Agreement for Service and fax it to 1‐866‐552‐7326. 

For more information, visit www.parishdata.com/backgroundchecks. 

Once you have an account, you can manage an individual's background checks in the Safe Environment 
section where you can: 

 Request a background check for an individual. 

 Receive the background check results from SecureSearch. 

 Enter additional legal requirements. 

 

You can purchase individual background checks from within your PDS program. 

To run a background check  

1. Locate the individual's record. 
2. In the navigation pane, click Safe Environment. 
3. Click Request Background Check, and log in to the service. 
4. Products and prices are listed. Select the options you want, enter the required information, and 

click Submit. 
5. Close the background check window. 
6. Click Check Results to see if your results have been received. 
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Keeping Track of Parent/Guardian Letters, Visits, Etc. 
You can track outgoing and incoming correspondence such as letters and emails, phone calls, and visits. 
To keep track of correspondence with an individual, in the navigation pane, click Letters, Visits, Etc. 

 
Fig. 3‐13. 

To keep track of parent/guardian correspondence  

1. Locate the record of the individual. 
2. In the navigation pane, click Letters, Visits, Etc. 
3. Click Insert, and enter information about the correspondence. 

 
 Useful Information 

You can enter up to 30 characters in each field. 
Some examples of what you can enter in the Description field include "Schedule Letter", 
"Event Calendar", or "Confirmation Certificate". 
The Type field uses entries from the Letter Types keyword list. 

4. Click Save. 

 

When you run a letter report or send an email to a parent/guardian, the program asks if you want to log a 
history of the letter correspondence. For more information about logging letters, see Logging Letters in 
the Reports chapter of this training guide. 
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Using the Navigation Tools to Locate Parents & Guardians 
Use the Navigation tools to locate or scroll through parent/guardian records. 

 
Fig. 3‐14. 

To scroll through parent/guardian records, click  or  . To jump to the first or last parent/guardian, 

click  or  . To change the order of records, select an option in the Order by drop‐down list. 

To display a list of individuals in the current family, click  . This button depends on the 
number of members in the family. Click a member to go directly to their record. 

To locate a particular individual, in the Search field, enter their name and press Enter, or click  . If the 
name has a special character, right‐click in the Search field and click Insert Symbol. 

In the Search By drop‐down list, select an option to search by. 

 
Fig. 3‐15. 

If you select an option that could return multiple individuals, such as Search By Partial Address, the 
program displays a list of matching individuals. From that list, select the individual you want to view. 

The bottom of the Search By drop‐down list displays recently accessed families and individuals. Select one 
of these families or individuals to return to their record. 
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Parent/Guardian Tasks 
In the Tasks group, you can save or cancel changes to the window, or add or delete parents/guardians. 

 
Fig. 3‐16. 

Save 
To save all changes to the current parent/guardian, click Save. The program automatically saves the 
current record when you do the following: 

 Navigate to a different parent/guardian. 

 Add a new parent/guardian. 

 Switch between any of the sections in the navigation pane. 

 Leave the Parents & Guardians window. 

 Exit the program. 

Cancel 
To cancel any changes made since the last save, click Cancel. 

Add Parents & Guardians 
To add a new parent/guardian, click Add Par/Grd. If there are members for this family available in the 
database, but not visible in Formation Office, you have the opportunity to select them. 

 
Fig. 3‐17. 

Add to This Family — If the individual’s family already exists in the program, select it in the drop‐down 
list, then click this button. 

Create a New Family — If the individual’s family does not exist in the program, click this button to add it. 
For more information, see the About Families chapter of this training guide. 
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Delete Parents & Guardians 
To delete the current parent/guardian, click Delete Par/Grd. The program displays a confirmation dialog 
box and a print dialog box. If the individual is not used by another program, you can either hide them in 
the database or permanently delete them. 

 
Fig. 3‐18. 

Reassigning a Parent or Guardian 
You may need to reassign a parent or guardian to another family. For example, if a student's parents 
separate, divorce, or no longer live together, you can reassign one parent to a new family while retaining 
the connection to their student's record. 

 
Fig. 3‐19. 

To reassign a parent or guardian  

1. Locate the appropriate record. 
2. In the navigation pane, click Reassign Par/Guard. 
3. Select whether to create a new family record or add the parent/guardian to an existing family. 
4. If you create a new family, select whether to copy addresses and phone numbers. 
5. Enter or select the ID number and family name. 
6. Make any additional selections, and when you're finished, click Reassign Parent/Guard. 
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Exercise 
Fill out the information on the Parent/Guardian windows for the family you created in exercise #1. 

Questions 
Q: What is the difference between a talent, a ministry, and a keyword? 

A:                      

                     

                     

 

Q: Where would you record a parent’s attendance to a Sensitivity Training seminar? 

A:                      

 

Q: Where do you record a parent’s attendance to classes associated with their student’s sacraments? 

A:                      
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4: Managing Class Schedules 
 

In the Class Schedules window, you can enter and maintain important information relevant to the daily, 
weekly, and monthly activities associated with formation sessions. You can track important class 
information, such as who is the catechist for the class, class starting and ending dates, room 
number/name, frequency, and minimum attendance required. 

A session refers to each class your students could attend as part of their religious education. If there are 
more students than can fit in one class, or if the classes are held on different days, it would be divided into 
two or more separate sessions. 

To manage your class schedules, on the Information tab, click Class Schedules. 

 
Fig. 4‐1. 

To add a class or session  

1. In the Tasks group, click Add Class. 
2. In the navigation pane, click Session Information. 
3. Enter a Session Name, Year/Period, Grade Level, and Class Size Cap. 
4. Below the Catechists grid, click Insert to add a catechist to the session.  
5. Enter the Class Time, Room Number/Name, and the Starting and Ending Dates. 
6. Click Set Frequency and specify the schedule frequency. Once you select the frequency, click Add 

to Class Dates. The program calculates the actual days within the date range chosen for the 
frequency chosen, and lists them on the Class Dates tab. 

7. Select Calculate Days Present to have the program count how many days the class will meet, 
based on the frequency. 

8. For Min. Attendance, enter the minimum number of days a student must attend in order to pass. 
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9. In the navigation pane, click Class Dates. Verify the class dates and specify any additional 
information. 

10. When you're finished entering class/session information, click Save. 

 
 Useful Information 

Students are NOT added to their sessions from the Class Schedules window. You can add sessions for a 
student on the Students Detail window. You can add sessions for multiple students at once by using the 
Classes or Sessions quick posting or the Enrollment process. 

 

There is no limit on the number of sessions you can maintain in the Formation program; however, each 
class session must have a unique Session Name.  

For example, let’s say you have 120 students that need to attend a First Communion or Eucharist class. 
You have two times available, 9am and 11am. Each of your rooms can hold only twenty students. In this 
case, you would have six First Communion sessions: 9am 1st Communion A, 9am 1st Communion B, 9am 1st 
Communion C, 11am 1st Communion A, 11am 1st Communion B, and 11am 1st Communion C. 

Note: The number of students, times, and room capacity used above is just an example. There is no limit 
on the number of students that can be assigned to a class/session.  

Year/Period is a keyword field that represents the year for the session. For example, you can have a 1st 
Grade Formation session for the period of 2014/2015 and then setup another 1st Grade Formation session 
for the period of 2015/2016. This way, you can enroll your pre‐registering students in the current year for 
the next year. 

Grade Level is a keyword field that represents the public school grade that corresponds to this session. 
For example, 1st Communion is usually 1st graders. 

Class Frequency 
How often a session meets within the starting and ending times is determined by the frequency. When 
you click Set Frequency, you can choose whether the class meets Daily, Weekly, by Date of the Month, or 
by Day of the Month. 

Daily 

Use the Daily option to schedule a session for every day up to every sixth day of the time period specified. 

 
Fig. 4‐2. 
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Weekly 

Use the Weekly option to schedule a session for particular days of the week; for example, every other 
Monday, or every fourth Wednesday and Thursday. 

 
Fig. 4‐3. 

Date of the Month 

Use the Date of the Month option to schedule a session for a specifically‐numbered date of the month; 
for example, the 3rd, 7th, and 15th of each month. 

 
Fig. 4‐4. 

Day of the Month 

Use the Day of the Month option to schedule a session for the selected recurring days of the week within 
a month; for example, the first and third Sunday and Tuesday of the month. 

 
Fig. 4‐5. 
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Class Dates 
The Class Dates window shows the classes calculated by the Frequency and Date Range you selected on 
the Session Information window. 

 

Fig. 4‐6. 

Class Will Meet is automatically selected for each date, indicating that class should meet on that day. 
Clear this check box if class will not meet that day; for example, if it’s a holiday. 

Attendance Required is unselected for each date. Select this for a specific date if attendance on that day 
is crucial to passing the class or for another important reason. The Attendance calculations on the Session 
Information window depend on these checkboxes. A student marked absent for a date marked as 
Attendance Required appears red on the Students Attendance window. 

Note can be used to show why the class does not meet that day, such as a holiday, or why attendance is 
required, such as a final exam. 

Click Set Frequency to recalculate the dates, or click Clear List to start the list over. Click Insert to add 
additional dates. 

   



PDS Formation Office Training Manual Class Schedules  4 - 5 

 

Class List 
The Class List window shows the students assigned to the current session. 

 

Fig. 4‐7. 

Adding Students to Sessions 
Students are NOT added to their sessions from the Class Schedules window or the Class List window.  

To add a session to an individual student 

1. On the Information tab, click Students. 
2. In the navigation pane, click Detail. 
3. In the List of Session section, click Insert.  
4. To add a session to several students at the same time, in the navigation pane, click Quick Posting 

> Classes or Sessions or click Processes > Enrollment. 
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Copy Existing Session 
The Copy Existing Schedule feature allows you to create a new session by copying an existing schedule. 
Then you can make the appropriate changes for the new session. 

For example, all of your classes meet on Tuesday night. You would create a session for the first class, 
including dates, frequency, and time, then copy it and change the session name, catechist, etc. 

 
Fig. 4‐8. 

To create a class or session based on an existing schedule  

1. In the navigation pane, click Copy Existing Schedule. 
2. Select the class/session you want to copy, and click Copy Session. 
3. A new class/session named "Copy of <session>" is created. Make any changes to the new 

class/session. 
4. Rename the class/session, and click Save. 

Exercise 
Create a session with the following:  

Name: Learning the Saints 

Year/Period: 2015/2016 

Grade Level: 5th grade. 

Time: from 7pm to 9pm 

Room: Classroom 101 

Date Range: September through April 

Frequency: Every Third Wednesday of the Month 
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5: About Personnel 
 

The Personnel tab provides access to data windows where you can maintain all of the information about 
your catechists, staff, clergy and religious, and volunteers. 

All Personnel 
The All Personnel windows display information about all parish personnel records stored within the 
program. To access all of your personnel records, on the Personnel tab, click All Personnel. 

 
Fig. 5‐1. 

Using the Navigation Tools to Locate Personnel 
Use the Navigation tools to locate or scroll through personnel records. 

 
Fig. 5‐2. 

To search for a specific record  

1. On the Personnel tab, click All Personnel, Catechists, Staff, Clergy & Religious or Volunteers. 
2. In the appropriate data window, on the ribbon, locate the Navigation group. 
3. Click Search by, and select the type of record for which you are searching. 
4. Click in the field next to the Search by button and begin typing the name, ID number, phone 

number, or email address of the record that you want to locate. 

 
 Useful Information 

If searching for a name, the program displays possible matches as you type in the field. If you 
enter a comma, your cursor moves to the end of the last name selected. 

5. Once you enter the correct value, click   to display the record. Alternatively, click the drop‐
down arrow on the right side of the field and select a record. 
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To scroll through the records  

1. In the appropriate data window, on the ribbon, locate the Navigation group. 
2. Click the Order by drop‐down list and select a method of organizing the records. If, for instance, 

you select to order by name, you can scroll through the records alphabetically based on last 
names. 

3. Click  and  to move to the previous or next record. Click  and  to move to the first or 
last record. 

Catechists 
The Catechists windows display information about all catechist records stored within the program. To 
access catechist information, on the Personnel tab, click Catechists. 

 
Fig. 5‐3. 
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Staff 
The Staff windows display information about all staff records stored within the program. To access staff 
information, on the Personnel tab, click Staff. 

 
Fig. 5‐4. 

Clergy and Religious 
The Clergy & Religious windows display information about all clergy records stored within the program. To 
access information for clergy, on the Personnel tab, click Clergy & Religious. 

 
Fig. 5‐5. 
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Volunteers 
The Volunteers windows display information about all volunteer records stored within the program. To 
access volunteer information, on the Personnel tab, click Volunteers. 

 
Fig. 5‐6. 

Adding and Editing Personnel Records 
You can add or edit personnel records by navigating to Personnel > All Personnel, or select the data 
window for the type of personnel you are adding (Catechists, Staff, Clergy & Religious, or Volunteers). 

 
To add a personnel record  

1. In the Tasks group, click the Add button. The Primary Information window displays. 
2. Enter the name and ID number.  
3. Enter any additional record details, and select the program areas where you want this record to 

display. 
4. Click Save. 

 

To insert personnel pictures  

1. Locate the appropriate personnel record. 
2. In the navigation pane, click Primary Information. 

3. In the Picture File field, click   and locate the individual's digital image file. 

 
 Useful Information 

You must use one of the following file types: .gif, .jpg, .jpeg, .bmp, .emf, .wmf, or .ico.

4. Select the file, and click Open. 
5. Click Save. 
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 Useful Information 

Personnel pictures can be installed as a sub‐directory of your Data folder. The default path to this sub‐
directory is \PDSOffice\Data\Pictures. If you save pictures to this directory, they are backed up each 
time the program makes an automatic backup. Because picture files are large, they take up more space 
on your hard drive and make the backup files larger than ordinary text files. If backing up large files is a 
concern, consider creating a sub‐directory outside the PDS program folder in which to store your picture 
files. They are no longer backed up automatically since they are not in the pictures sub‐directory. In this 
case, you can back them up manually. 

Entering Personnel Communication 
You can enter information for different ways to communicate with your formation's personnel. On the 
Personnel tab, click the type of personnel you want to enter information for. In the navigation pane, click 
Communication. 

 
Fig. 5‐7. 

To insert a phone number or email address  

1. Locate the appropriate individual. 
2. In the navigation pane, click Communication. 
3. Click Insert below each grid, and enter the individual's phone number(s) and/or email 

address(es). 
4. If the phone number or email address is unlisted, select Unl. 
5. If the individual prefers to receive email rather than mail, select Pref. 
6. Click Save. 
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You can also include a link to quickly access an individual's Facebook, Twitter, or blog page from within 
the program. 

 
Fig. 5‐8. 

To set up links to social media  

1. Locate the appropriate individual. 
2. In the navigation pane, click Communication. 
3. In the Social Media section, click Set Up. Copy the URL from the individual's Facebook, Twitter, or 

blog, and paste it into the appropriate field. Click Save/OK. 
4. In the Tasks group, click Save. 

  
After you set up the links, in the Communication window, click the icon of the social media page you want 
to view. The webpage opens in your Internet browser. 

Adding Assignments 
You can assign certain positions to personnel, and enter relevant salary information and date ranges 
associated with that position. On the Personnel tab, click the type of personnel you want to enter 
information for. In the navigation pane, click Assignments. 

 
Fig. 5‐9. 

To add a personnel assignment  

1. Locate the personnel record you want to add assignments to. 
2. In the navigation pane, click Assignments. 
3. Click Add Assignment. 
4. Enter or select any information you want to include. 
5. Click Save. 
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Entering Private and Confidential Information 
You can enter private and confidential information on personnel records. Private information includes 
citizenship status, Social Security number, birth date, hire date, termination date (if applicable), and more. 
You can enter any other confidential information you want to include in the Confidential window. 

To enter private information  

1. Locate the personnel record you want to add information to. 
2. In the navigation pane, click Private. 
3. Enter any information you want to include. 

 
 Useful Information 

You can set each user's access rights to this information on the Administration tab, under Users 
& Passwords. There is a program area for Private Window and for Social Security Number. 

4. Click Save. 

 

To enter confidential information  
1. Locate the personnel record you want to add information to. 
2. In the navigation pane, click Confidential. 
3. Enter any information you want to include. 
4. Select Very Confidential if you want to restrict the information to only users who have rights to 

very confidential information. 

 
 Useful Information 

You can set each user's access rights to this information on the Administration tab, under Users 
& Passwords. There is a program area for Confidential and for Very Confidential. 

5. Click Save. 

Associating a Keyword with Personnel 
You can associate a keyword with personnel. For example, if a catechist is also a youth group chaperon, 
you can "tag" them as such. 

 
Fig. 5‐10. 
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To associate a keyword with personnel  

1. Locate the appropriate personnel record. 
2. In the navigation pane, click Keywords. 
3. Click Insert in the appropriate keywords list. 
4. To select a keyword from a current list, click the drop‐down list. To add a new entry, enter a 

description, press Tab on your keyboard, and click Add to the List. 
5. Click Save. 

  
You can use this keyword when running reports. For example, if you need a list of all the youth group 
chaperons, you can run a listing report with an additional selection as follows: 

 
Fig. 5‐11. 

For more information on selections, refer to the Reports chapter of this training guide. 

Entering Education and Credentials 
You can enter information about a personnel's education and credentials. On the Personnel tab, click the 
type of personnel you want to enter information for. In the navigation pane, click Education/Credentials. 

 
Fig. 5‐12. 

To enter information about education and credentials  

1. Locate the appropriate personnel record. 
2. In the navigation pane, click Education/Credentials. 
3. To enter education details, click Insert below the Education grid. 
4. To enter credential details, click Insert below the Credentials grid. 
5. After entering all relevant information, click Save. 
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Adding Achievements 
You can add achievements that your personnel have accomplished. For example, a teacher may receive 
the 2014 Teacher of the Year award. 

On the Personnel tab, click the type of personnel you want to enter information for. In the navigation 
pane, click Achievement. 

 
 Useful Information 

This window is not available in the Volunteers section.

 

 To add an achievement  

1. Locate the appropriate personnel record. 
2. In the navigation pane, click Achievement. 
3. Below the Achievements grid, click Insert. 
4. Enter any achievement information you want to include. 

 
 Useful Information 

You can set up types of achievements in the Achievement Types keyword list. On the File menu, 
click Keywords > Personnel Keywords > Achievement Types. 

5. Click Save. 

Managing Background Checks 
We partner with SecureSearch™ to provide background screening results for individuals in your parish, 
such as personnel or volunteers. 

 
 Useful Information 

To use this feature, you must create an account with SecureSearch. Complete the SecureSearch 
Agreement for Service and fax it to 1‐866‐552‐7326. 

For more information, visit www.parishdata.com/backgroundchecks. 

Once you have an account, you can manage an individual's background checks in the Safe Environment 
section where you can: 

 Request a background check for an individual 

 Receive the background check results from SecureSearch 

 Enter additional legal requirements 
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Fig. 5‐13. 

To add background check information or requirements  
1. Locate the individual's record. 
2. In the navigation pane, click Safe Environment. 
3. Under Background Check or Other Requirements, click Insert, and enter the background check or 

requirements information. 

 
 Useful Information 

These lists use entries from the Background Check and Requirement Descriptions keyword lists.

4. Click Save. 

 

You can purchase individual background checks from within your PDS program. 

To run a background check  

1. Locate the individual's record. 
2. In the navigation pane, click Safe Environment. 
3. Click Request Background Check, and log in to the service. 
4. Products and prices are listed. Select the options you want, enter the required information, and 

click Submit. 
5. Close the background check window. 
6. Click Check Results to see if your results have been received. 
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Adding Contacts 
You can add information about a personnel's contacts. This can include any family members, friends, 
doctors, and so on. 

On the Personnel tab, click the type of personnel you want to enter information for. In the navigation 
pane, click Contacts. 

 
Fig. 5‐14. 

To add a personnel contact  

1. Locate the personnel record you want to add information to. 
2. In the navigation pane, click Contacts. 
3. Click Add Contact. 
4. Enter any information you want to include. 
5. Click Save. 

 As you add contacts, a tab displays at the bottom for each contact. Click List to see all the personnel's 
contacts. 
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Entering Health and Insurance Information 
You can add health and insurance information for your personnel. On the Personnel tab, click the type of 
personnel you want to add information for. In the navigation pane, click Health/Insurance. 

 
Fig. 5‐15. 

 
 Useful Information 

This window is not available in the Volunteers section.

 

To add health and insurance information  

1. Locate the personnel record you want to add information to. 
2. In the navigation pane, click Health/Insurance. 
3. On each tab, enter the relevant information. 

 
 Useful Information 

You can set up custom benefit names that display on the Other Benefits tab. On the File menu, 
click Setup > Initial Setup. Click the Personnel tab, and enter the benefit names. Click Save/OK. 

4. When you're finished adding information, in the Tasks group, click Save. 
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Scheduling Catechists 
You can add or edit catechist schedules. On the Personnel tab, click Catechists. In the navigation pane, 
click Schedule. 

 
Fig. 5‐16. 

To add sessions to a schedule  

1. Locate the catechist you want to add or edit a schedule for. 
2. In the navigation pane, click Schedule. 
3. Click Insert, and enter the session information. 
4. Insert a new line for each session you want to add. 
5. Click Save. 

 
To delete sessions from a schedule  

1. Locate the catechist whose schedule you want to delete. 
2. In the navigation pane, click Schedule. 
3. Select the session you want to delete, and click Line Delete. 
4. Click Save. 

Entering Catechist Attendance Information 
You can track the days a catechist is absent, present, excused, unexcused, or tardy to class. You can also 
track a single attendance type, such as Absent, or you can track a combination of types. 

On the Personnel tab, click Catechists. In the navigation pane, click Attendance/History. 

 
Fig. 5‐17. 
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To insert attendance information  

1. Locate the appropriate catechist record. 
2. In the navigation pane, click Attendance/History. 
3. In the Attendance grid, click Insert. 
4. Enter any information you want to include. 
5. Click Save. 

 

Date — The catechist was present, absent, tardy, excused, or unexcused. Click the calendar icon to select 
the date. 

Type — The kind of absence, tardy, or excuse the catechist had for that day or days. You cannot add new 
types to this list. 

Days — The number of days the catechist was absent or tardy. If you're recording each day individually, 
enter 1 in the Days field. If you're recording the beginning date for a number of days absent or tardy in a 
single row, enter the total number of days absent or tardy in the Days field. For example, if the catechist is 
absent from 01/01/06 to 01/06/06, you would enter 5 in the Days field. 

 

To view filtered attendance information  
1. Locate the appropriate catechist record. 
2. In the navigation pane, click Attendance/History. 
3. Click Filter List. 
4. Make your filtering selections, and click Lookup/OK to run the filter. 

 
 Useful Information 

The lines displayed are narrowed to match your choices. Click Filter Chosen, and Clear Filter to 
restore the list. 
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Entering Catechist History Information 
You can view the catechist’s teaching history. 

 
Fig. 5‐18. 

1. Locate the appropriate catechist record. 
2. In the navigation pane, click Attendance/History. 
3. In the History grid, click Insert. 
4. Enter any information you want to include. 
5. Click Save. 

 
 Useful Information 

The End of Year – Formation Remove Advance process has an option to help you add the 
catechists’ session details at the end of the year to their Teaching History record. 

To access this process on the Information tab, click Students. In the navigation pane, click 
Processes > End of Year – Formation Remove Advance. For more details on this process, refer 
to the Processes chapter of this training guide. 

Entering Catechist Certification Information 
You can record catechist’s educational requirements pertaining to their background and training. On the 
Personnel tab, click Catechists. In the navigation pane, click Certification. 

To insert a course  

1. Locate the appropriate catechist. 
2. In the navigation pane, click Certification. 
3. Click a Level tab or the Renewal tab, and click the side tab that corresponds to the type of course 

you want to insert. 
4. Click Insert, and select the information for each column. 

 
 Useful Information 

You can set up courses and requirements on the Certification Requirements window. On the File 
menu, click Setup > Certification Requirements. See the next section for more information. 

5. Click Save. 
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To get pre‐existing requirements for a course  
1. Locate the appropriate catechist. 
2. In the navigation pane, click Certification. 
3. Click a Level tab or the Renewal tab, and click the appropriate side tab. 
4. Click Get Requirements. A confirmation dialog box displays. 
5. Click Remove Classes to have all of the existing classes removed and replaced with those set up 

on the Certification Requirements dialog. Otherwise, you can click Keep Classes or Stop. 
6. Click Save. 

 

On each Level tab, there are four side tabs. The Recap side tab contains a brief summary of certification 
information located on the Level tabs. The other side tabs are Required Courses, Elective Courses, and 
Other. These tabs display information about courses a catechist must complete in order to achieve the 
level. 

Recap tab 

 Level — Indicates Level I ‐ IV for the requirements. The Details in this Data check box is selected if 
the requirements for the certification have not been met. 

 Certified Yes/No — Yes is entered in this field if the requirements for the certification have been 
met. No is entered if the requirements have not been met. 

 Date — Enter the date (MM/DD/YYYY) the certification requirements were met, or click   to 
select the date. If the requirements have not been met, the units needed for certification are 
listed instead. The units are calculated using entries on the Level tab. 

Required Courses, Elective Courses, and Other side tabs 

 Course — The name of the required course or electives. To set up the course list, on the File 
menu, click Setup > Certification Requirements. 

 Req. Met — Indicates the certification requirement has been met. If all the check boxes are 
selected, the Recap side tab displays that the catechist is certified. 

 Date — The date (MM/DD/YYYY) the course requirement was completed, or click   to select 
the date. 

 Units — The value of the required course in the units you use, for instance 3.00 to represent 3 

hours, or click   and enter the units using the calculator. 

 Alternate Course — This information is optional. If the course was given another designation but 
is still part of the requirement, enter the name here. 

 Instructor — This information is optional. Enter the name of the person conducting the course. 

 Place — This information is optional. Enter the name of the place where the course was held. 
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Setting Catechist Certification Requirements 
With this option, you can set up your Diocesan and other requirements for catechist certification. To 
access the Certification Requirements window, on the File menu, click Setup > Certification 
Requirements. 

 
Fig. 5‐19. 

There are ten levels (I through IX and Renewal) available on the Certification Requirements window. Each 
level's tab contains these following side tabs: 

 Requirements Recap — Lists all the required courses, elective courses, other requirements, and 
total units required for certification. The Recap window provides a summary of information on 
the status of all levels of certification. If you delete a course or requirement from this list, you can 
remove the course or requirement from all windows. 

 Required Courses — Lists all the courses required for certification as defined by your 
organization. 

 Elective Course — Lists all the courses that are not necessarily required for certification as 
defined by your organization. 

 Other Requirements — Lists the other requirements needed as defined by your organization for 
certification. You can manually enter a course name and description. 

 
To insert requirements  

1. On the File menu, click Setup > Certification Requirements. 
2. Select the level you want to insert a requirement for. 
3. Click a side tab to insert either required courses, elective courses, or other requirements. 
4. Click Insert and enter the requirement information. 
5. Click Save/OK. 
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You can assign required courses, elective courses, and other requirements for a particular level. After you 
assign requirements, all catechists must complete the requirements before moving to the next level. 

To assign requirements for a certain level  

1. On the File menu, click Setup > Certification Requirements. 
2. Select a Level tab or the Renewal tab. 
3. To assign only the required courses, the elective courses, or the other requirements, click the 

corresponding side tab, and click Assign Requirements. 
4. To assign all the requirements for the level, click Requirements Recap, and click Assign Req. 

 
 Useful Information 

Requirements are also added to the Certification section of the Catechists window. 

5. Click either Remove Courses/Reqs or Keep Courses/Reqs to remove or keep the existing 
requirements on the Certification window. 

 

You can also add requirements for all requirement levels and courses to the Catechists window. 

To assign requirements for all levels  

1. On the File menu, click Setup > Certification Requirements. 
2. At the bottom of the window, click Assign All Requirements. 
3. Click either Remove Requirements or Keep Requirements to remove or keep the existing 

requirements on the Certification window. 

  

You can use a list of courses from another certification level and add them to your current level. 

To borrow a course  

1. On the File menu, click Setup > Certification Requirements. 
2. On the Elective Courses tab, click Borrow. 
3. Select the certification level you want to borrow. 
4. Click Save/OK. 
5. After the list is inserted, click Line Delete to remove items that aren't needed. 

 

Reorder — We recommend that you use Reorder to move more frequently used items to the beginning of 
the list instead of deleting the item completely. 

Print — Print a summary of the certification requirements and units for all levels, and print a certification 
worksheet for the requirements levels. Use the worksheet to record units completed or to set up courses 
and units. 
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Entering Status and Ordination Information 
In a clergy/religious record, you can enter status information as well as diaconate and priest ordination 
details. You can also record religious dates. 

On the Personnel tab, click Clergy & Religious. 

To enter status/ordination information  

1. Locate the clergy/religious record you want to add information to. 
2. In the navigation pane, click Status/Ordination. 
3. On the tabs, enter relevant dates and information. 
4. Click Save. 

Deleting a Personnel Record 
As personnel exit your parish, you may want to delete their records from your database. There may be 
times when you want to delete a personnel record, but not permanently. In that case, you can designate 
it Inactive using the check box in the upper‐right corner of the window. The individual is omitted from 
most PDS processes, but their data is not lost. 

You can delete personnel records by navigating to Personnel > All Personnel, or select the data screen for 
the type of personnel you are deleting (Clergy & Religious, Staff & Volunteers, Teachers, or Catechists). 

To permanently delete a personnel record  

1. Locate the personnel record you want to delete. 
2. In the Tasks group, click the Delete button. 
3. The Deleting Individual Information dialog box displays. If you want to print the personnel 

information, select the options you want, and click Yes. 
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6: Adding and Viewing Documents 
 

In several windows throughout the program, you can add and view additional documents that support the 
information you entered in those windows. 

 
Fig. 6‐1. 

 

 
 Useful Information 

This feature is a file browser rather than a file manager. Within the program, you can link to a document 
on your computer or from your scanner to save it as a .bmp or .jpg image. Use the appropriate file editor 
to make changes to your document before associating it with a record in your PDS program. 

Before using this feature, decide where you want to store the documents on your local PC or network.  

To set where to store your documents  

1. On the File menu, click Setup > Initial Setup. 
2. Next to Default Documents Subdirectory, click Browse to select the location of the folder where 

you want to store the documents. 
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 Useful Information 

If you run the program on a network, we recommend that you create a folder on your hard drive 
to store these files. This makes it easier to share the files with other users in your network. 

To include these files in your regular data backup, create the storage folder as a subfolder of 
your Data folder. Files stored outside of the Data folder are not included in the backup. To 
locate the Data folder's path, on the File menu, click About.  

3. Click Save/OK, then Close. 

 

After selecting a location to store the documents, you can add files from several locations in the program. 
The following file types are accepted: .doc, .jpg, .jpeg, .bmp, .emf, .wmf, .ico, .xls, .rtf, and .df. 

To add documents  

1. In a window with this feature, click Add Documents. 
2. Select whether you are linking to a Single File or Multiple Files. 

3. If you add a single file, click  and select the file you want to link to. If you add multiple files, 
you need to create a subfolder to store your documents. See the information below for more on 
these options. 

 
 Useful Information 

You can also click Scan to capture a new image using your scanner. Click Scanners in the menu 
on the Documents dialog box to select your scanner options. 

4. Click Save/OK, then Close. 

 

Scanners — Provides options for how you want to scan and name your documents. You can select one or 
more of the following options:  

 Automatically Assign Unique Filename on Scan — Automatically names the newly‐scanned 
document with a unique name. If you don't select this option, you are prompted to name the 
document. 

 Show Scanner Interface on Scan — Displays the properties of your scanner and the scanning 
progress through your scanner's interface. 

 Default File Format on Scan: BMP/JPG — Saves your document in the specified file format. 

Choose the Scanner on Scan — Select which scanner to use if you have multiple scanners. If you only 
have one scanner or always want to use the default, don't select this option. 

Image Processes — Provides options to rotate your image clockwise by 90 degrees, 180 degrees, or 270 
degrees.  

Zoom — Provides options to view your image in different modes: Full Page, Full Width, or at a certain 
percentage. 

 

Single File — Associates one file with the current record. 

Multiple Files — Copies files to a subfolder associated with the current record. When you select this 
option, a message displays prompting you to create a subfolder. 
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Fig. 6‐2. 

Click Yes to create a uniquely‐named subfolder in your default document path. Click No if you want to 
select a subfolder or return to the Documents dialog box. If you click No, a second message displays. 

 
Fig. 6‐3. 

Click Yes to select an existing subfolder to store your files in, or click No to return to the Documents dialog 
box. 

Once you have a subfolder, you can add new files and delete stored files. 

Scan — Uses a scanner connected to your computer to scan a new document into the program. Before 
scanning in a new document, select your scanner options on Scanners in the Documents dialog box. 

 
 Useful Information 

If you're using the single file option and already have a document linked to the current record, a message 
displays asking if you want to overwrite the existing file. Click Yes to discard your document and use the 
new file, or click No to return to your current document. 

 

Remove — Removes the association between the file and the record. 

If you remove a single file, you have the option to delete the original file from your computer. If you 
delete it, the file is moved to the Recycle Bin on your computer. 

If you remove multiple files, the link to the subfolder that contains the files is removed from the program. 
The subfolder and its contents are still available in the original location on your computer. 

 

Once you have linked files to records in your program, click View Documents to view the documents 
associated with the current record.   
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7: Tuition and Fees 

Fund Setup 
When you set up a fund, the first step is to define the nature of the fund. Since families and individuals 
will use this fund, it must contain activities that describe the fees you charge and the payments they 
make. 

On the Administration tab, click Fund Setup. 

 
Fig. 7‐1. 

Adding Funds 
You should add a new fund when your organization is planning to take a new collection over a long period 
of time or several short periods of time (fund periods). 

 
Fig. 7‐2. 
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To add a fund  

1. On the Administration tab, click Fund Setup. 
2. In the Tasks group on the ribbon, click Add Fund. 
3. In the Fund Identifier field, enter a one‐ or two‐digit number or letter fund ID. 
4. In the Fund Name field, enter a specific name for the fund. 
5. Select the due date information and the recurring charge due dates from the drop‐down lists. 
6. Under Fund Periods, enter the two‐digit year, starting date (MM/YYYY format), ending date 

(MM/YYYY format), and goal. 
7. To add fund activities, click Insert below the fund activities grid. 

Note:  If you haven't backed up your data today, you are prompted to do so now. 
8. Click Yes to insert predefined fund activities, or click No to create your own fund groups. 
9. If you create your own fund groups, enter the group name, activity name, and function of the 

activity. 
10. Click Save. 

About Fund Information 
This area of the Fund Setup window controls the fund number, name, and recurring charge due dates. 

 
Fig. 7‐3. 

Fund Identifier — Enter up to two numbers or letters to identify each fund you want to develop. Each 
fund identifier must be unique. 

Fund Name — Enter a unique name to identify the fund. 

Due Dates for Quarterly, Semi‐Annual, or Annual are Based on the: — The program can calculate the 
due dates based on the option you select: 

 Fund Period — The date range of the fund. For example, if the fund period is set up to run from 
July to the following June, a family’s quarterly pledges are due July 1, October 1, January 1, and 
April 1. 

 Billing Period — The tuition or pledging date range of the individual family. For example, if the 
family pledges quarterly from May to the following April, the due dates are May 1, August 1, 
November 1, and February 1. 

 Calendar Year — January to December. For example, if the family pledges quarterly from May to 
the following April, their due dates begin July 1 then follow every three months — October 1, 
January 1, and April 1. 

 

Recurring Charges are Due on the: — You can select First Day, Last Day, and 15th. The recurring charges 
are applied to a family on the first or last day of the time period selected, or on the 15th of the month if 
the family’s billing term is monthly. 

To set another monthly due date, select First Day for this field, then select the appropriate choice in the 
Due Dates for Quarterly field, and set up each family’s billing date starting on the day you want to bill 
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them. For example, to bill on the 20th of each month, set up the family for 01/20/2014 through 
12/20/2014. 

About Fund Periods 
This section identifies each fund's starting and ending dates, and goals. 

 
Fig. 7‐4. 

Each fund is like a collecting season. The fund is used for a certain time period, called a fund period. 
Instead of creating a new fund at the end of each season, you add a new fund period and prepare for the 
next season. 

Rules regarding fund periods: 

 Fund periods can't overlap within the fund. For example, you can't have a fund period from July 
2013 to June 2014 and another from January 2014 to December 2014. 

 Periods should not be less than one year. For example, from January 2014 to September 2014 
(nine months) is not advised. 

 Fund periods can range from one year to any number of years. For example, a fund period could 
stretch from January 2009 to December 2014. 

 Fund periods do not have to start at the beginning of the year. For example, most education 
programs start in May or June. A one‐year fund would go until April or May. 

 
 Useful Information 

The data from the prior period is not removed at the end of the fund period; it is stored under 
that fund period name so you can use it for reference and comparison. 

 

Goal — This is an optional field. It refers to the total amount you wish to attain within the fund period. It 
can also be used in reports to measure what has been accomplished up to a given point in the fund 
period. 

Combine — Combines one period with another. No data is lost. 

Insert — Creates new fund periods. New periods are inserted in the date range order. Remember that 
period date ranges cannot overlap. There is a special End of Year process that creates new periods and 
sets up all current families to use it. 

Delete — Deletes fund periods. You can select the periods you want to delete. We recommend that you 
back up your data before deleting fund periods. Make sure to select the correct fund period line before 
deleting. 

Add to Fams— Adds the selected fund period to all families in the program. This is useful if you are 
creating a new fund and a new period that you want available to all families. 
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About Fund Activities 
The fund activities grid displays each Group Name, Activity Name, and Function of the activity in the 
fund. You can add an unlimited number of groups to the fund, each with an unlimited number of 
activities. You can also add predefined groups and activities to your fund. 

 
Fig. 7‐5. 

Group Name — This identifies a group of activities within a fund. For example, one group might deal with 
current pledges, another with volunteer hours, another with ISF fees, and another with miscellaneous 
activities. This lets you set up a fund and keep related activities together in a logical order within the fund. 

Activity Name — This identifies the activities that are used within a group. Each activity must be unique 
within the field. For example, for the amount due for tuition, use the Tuition Due activity. For making 
tuition payments, use the Pmt/Tuition or Tuition Payment activity. 

Function of the Activity — What each activity is used for. The following items are options in the drop‐
down list for activity functions: 

 Payment (Deductible or Non‐Deductible) — Money collected that can be tax‐deductible 
payments, non‐deductible payments, initial deposits, or any other general payment. 

 Pay Down (Deductible or Non‐Deductible — A payment that reduces the rate of a pledge 
without reducing the balance. For example, someone pledges $100 a month for one year (a total 
of $1200), then makes a pay‐down of $300. The rate changes to $75 a month ($1200‐$300, 
divided by 12), but the total remains $1200. 

 Additional Gift — A payment in a pledge fund that does not count toward the pledge. This 
option is tax‐deductible. 

 Non‐Cash Contribution — A deductible payment that is not cash or check. For example, stock or 
auction items. The individual must designate a value for the item. When the item is posted, you 
can apply the value to the family’s pledge. 

 Quid Pro Quo — Used when the family receives something of value in return for their 
contribution. The activity name must include the dollar amount of the item being received. The 
program uses the dollar amount in the activity name to determine how much of the contribution 
is tax‐deductible. For example, someone pays $40 for a $20 dinner and auction. Quid Pro Quo is 
the only activity type that has restrictions on the activity name. The value of the object received 
must be part of the name, i.e. "Fall Dinner Dance $20." 

 Credits — Money that counts toward a pledge or fee that was not paid by the family. For 
example, a scholarship or volunteer credit. The credit options are non‐deductible. 

 Payment from Last Year — A total of the payments on a fund from last year. Used when the fund 
period overlaps years and the payments must be carried to the next year. Select this option for 
funds that use the Processes for Carry Forward Balances. This option is non‐deductible. 
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 Initial Payment (Deductible or Non‐Deductible) — This lets you record a pledge and a payment 
as a single entry. The pledge is attributed to the first charge activity in the group where the initial 
payment appears. 

 Charge — Money due from pledges, fees, or tuition. 

 Refund (Deductible or Non‐Deductible) — Money that has been returned to the individual. This 
type of activity is used instead of reducing the original posting. 

 Write‐Off — Indicates that the pledge is considered "uncollectible". This reduces the charge by 
the amount of the write‐off, lowering the balance. 

 Hours Pledged — Some families would rather donate time instead of money. This activity type 
tracks the amount of time the family has committed to give. If you allow this kind of donation, 
make sure you set up a separate group in the fund. Each member of the family can pledge a 
different amount of time. 

 Hours Completed — Tracks the amount of time a family has completed of their hours pledged. 

 Hours Remaining — Tracks the amount of time the family has left to donate of their hours 
pledged. 

 Balance — The difference between what has been charged and what has been paid. This is 
normally the last activity in a group that includes a charge type. 

 Group Total — The total of the activities in a group. This is normally the last activity in a group 
without a charge type. 

 Ignore — Used for marking payments that should not be included in the total amount due or 
paid. For example, a check comes back from the bank with insufficient funds. The program 
ignores the payment while still tracking the fact that it was received. Each fund should include a 
Miscellaneous Activities group with an Ignore activity type. 

Predefined Funds 
The program contains a number of predefined funds you can use as models for your fund. To see the 
predefined funds and the groups and activities they use, click Insert below the fund activities grid. 

Church Contributions — A group of basic payment activities including offering, holy days, Christmas, and 
Easter. It also includes a group of miscellaneous activities, including non‐cash contributions, quid pro quo, 
and ISF/Ignore. 

Stewardship — A combination of the Church Contributions and Pledge Drive predefined lists. 

School Tuition — School‐related groups and activities such as tuition, book fees, graduation fees, and 
registration charges. It also includes non‐deductible payment, and credit types. Fee groups that consist of 
charge, payment, refund, and balance activities are also included. 

Formation — Tuition and fee groups and activities, as well as non‐deductible payment, and credit types. 
Fee groups that consist of charge, payment, refund, and balance activities are also included. 

Pledge Drive — A group of pledge activities, including charges, several payment types, and a balance. It 
also includes a group of volunteers, service hours activities, and a group of miscellaneous activities. 

Extra Contributions — A group of common extra contributions and miscellaneous activities that are 
grouped with ISF/Ignore. 
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The Pledge Drive predefined fund looks like the following: 

 
Fig. 7‐6. 

 
 Useful Information 

For an outline of each predefined fund, see the Appendix chapter of this training guide. 

 

The Formation fund has one main charge group, Formation Tuition, and several fee groups. The fee 
groups, such as Registration fee, all have the same structure: 

 Fee Due – Charge 

 Fee Payment – Payment Non‐Deductible 

 Fee Balance – Balance 

 

You can add other activities to the fee group, such as Credits. 

Insert — Adds new groups or activities to your fund. You can modify any of these predefined funds to suit 
your organization's needs. We recommend examining these funds to get a feel for their structure before 
developing your own. 

Line Delete — Deletes activities. A dialog box displays where you can select the groups or activities you no 
longer need. When you click Delete/OK, the selected items are deleted. 

Transfer to Another Fund — Moves a group or activity from one fund to another. 

Combine — Combines duplicate groups or activities. 

Reorder — Rearranges the order of activities within a group or the order of the groups themselves. 
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Additional Fund Setup Commands 
The program commands in the Navigation and Tasks groups are similar to other areas of the program. 

 
Fig. 7‐7. 

In the navigation pane, there are some commands under Other Tasks. 

 
Fig. 7‐8. 

Print — Prints a neatly‐formatted report of the selected fund. This is preferable to a print screen if you 
have more fund periods or activities than can fit in the window without scrolling. 

Consolidate Amounts — In order to conserve storage space, you can reduce the number of financial 
entries into monthly, quarterly, or yearly totals. Click this option, select the periods you want to 
consolidate, then click Consolidate/OK. 

 
Fig. 7‐9. 
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Usage Reports — You can print reports of information based on the financial activities. Click 1‐Print 
Families to print all families who have used or are using a particular activity, such as "Christmas" or 
"Peter's Pence." Click 2‐Print Activities to print all activities along with the number of families using each 
one. 

 
Fig. 7‐10. 

About Program Access 
The Program Access area lets you control which PDS programs can access the funds that have been set up 
in the program you are using. In the navigation pane, click Program Access. 

 
Fig. 7‐11. 

For example, if a fund is added in the Fund Setup window in the Church Office program, the administrator 
of that program can restrict or allow viewing for users in Formation Office or School Office. Up to five 
licensed users for each product can access funds.    
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Exercise 
Exercise #1 

Set up a fund with the following attributes: 

Fund ID: RE 

Fund Name: Religious Education 

Due Dates: Fund Period 

Recurring Charges: First Day 

Period: RE‐14, from July 2014 to June 2015 

Goal: $20,000 

Groups/Activities: 

One Student Tuition 

One Student Tuition Due – Charge 

Pmt/One Student Tuition – Payment Non‐Deductible 

One Student Tuition Bal – Balance 

Two Students Tuition 

Two Students Tuition Due – Charge 

Pmt/Two Students Tuition – Payment Non‐Deductible 

Two Students Tuition Bal – Balance 

3 or More Students Tuition 

3 or More Students Tuition Due – Charge 

Pmt/3 or More Students Tuition – Payment Non‐Deductible 

3 or More Students Tuition Bal – Balance 

Registration Fees 

Reg Fee Due – Charge 

Pmt/Reg Fee – Payment Deductible 

Reg Fee Bal – Balance  

 

Add this fund to all families. 
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Family Fund Setup 
Each family can have a fund set up to respond to their particular needs. This means they can have special 
rates, fees, billing periods, and so on.  

On the Information tab, click Tuition & Fees. From here, you can set up each family with detailed financial 
information. 

The family name and ID display at the top; the totals for all funds, fund identifier, funds used, and fund 
name display in the middle; and other commands are located in the Tasks group and in the navigation 
pane. 

To view different information for the selected fund period, in the navigation pane, select an option under 
the Data Entry section. 

 
Fig. 7‐12. 
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Adding Family Funds 
You cannot post payments or charges to a family until the fund and fund period are added to their record. 
For example, you need to set up funds for a new family, or you may have a fund set up for an existing 
family, but you need to add the current fund period. 

 
Fig. 7‐13. 

To add a fund or fund period to a family  

1. On the Information tab, click Tuition & Fees. 
2. In the Tasks group on the ribbon, click Add Fund. 
3. Select the fund and period. 
4. Click Save. 
5. The fund is now added, and you can post payments for the family. You can also add a fund during 

most of the quick posting processes, such as Payment/Donation Entry. 

About Rates, History, and Keywords 
In the Rates/History/Keywds window, you can set up pledge terms and rates for a family for the selected 
fund period. Each family member can have a separate pledge or tuition rate. 

 
Fig. 7‐14. 
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To display the grand total of all funds for a family, click Show Totals. Once clicked, the button changes to 
Hide Totals. Click again to hide the totals. 

 
Fig. 7‐15. 

To set up a recurring charge term and rate for a family  

1. On the Information tab, click Tuition & Fees. 
2. Locate the appropriate family. 
3. In the Rates/History/Keywds window, click Funds Used and select the fund the rate will be added 

to. If the fund or fund period needs to be added to the selected family, click Add Fund in the 
Tasks group on the ribbon. 

4. In the Rates section of the Rates/History/Keywds window, click Add Rate. 
5. Select an activity name for the Recurring Act entry. The listed activities are taken from the Fund 

Setup window. 
6. For the Terms, click the drop‐down arrow to display the list of terms you can use to determine 

how often a charge occurs. 
7. Enter the Billing Period date range for the charge. It cannot exceed the range of the fund period. 

Click   to select the dates of the pledge. To select how long the pledge will last, click Thru. For 
example, two weeks, one month, or fund period, after entering the start date. 

8. Enter the recurring Rate amount of the charge, such as $10 a month. 
9. The total is automatically calculated based on the billing period and the rate. You can edit this 

field if needed. 

 
 Useful Information 

If you enter the term, billing period, and rate, the program calculates the total. If you enter the 
term, billing period, and total, the program calculates the rate. 

10. Select Associate with Member to enter the name of the family member you want to connect 
these charges with. 

11. Select Electronic Fund Transfer if the family wants to have funds automatically withdrawn from 
an account or charged to a credit card. To enter the bank and financial information for the 
transfer, click EFT Info. If you have an account with either Vanco, you can click EFT Info to enter 
data directly onto the Vanco or QuanComm websites. 

12. Click Save. 

 

Follow these same steps to add any additional rates that should be applied to the selected family. 
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If terms/rates do not apply to the fund you are viewing, click Hide Rates so more history entries display. 
The button changes to Show Rates. To redisplay terms/rates information, click the button again. 

 
Fig. 7‐16. 

This window has a place for two fund keywords and displays each posting entry in date order. To add 
postings directly to this window, click Insert. Or, use the Payment/Donation Entry process to add postings. 
To access this process, in the navigation pane, click Quick Posting, then click Payment/Donation Entry. 

To post an amount to a fund when the amount is considered uncollectible  

1. In the Rates/History/Keywds window, below the History posting grid, click Write Off. In order to 
use this command, you must first add a write‐off activity to this fund in the Fund Setup window. 

 
Fig. 7‐17. 

2. Enter the Write‐Off Amount, or use   to enter the amount. 
3. To distribute the write‐off amount, click Distribute. You can also apply a Write‐Off amount to a 

specific month by entering the amount in the Additional Write‐Off column. 
4. Once you enter the Write‐Off amount, click Save and then Close.   



7 - 14  Tuition and Fees PDS Formation Office Training Manual
 
 

About Recap and Totals 
In the Recap/Totals window, you can view a summary of the groups and activities used by a family. Below 
this information, the program displays the fund totals. In the navigation pane, click Recap/Totals. 

 
Fig. 7‐18. 

Show Recap Totals Through — Displays the totals through the date you want. This does not include 
future postings. 

Show Recap Grand Totals for All Dates — Displays the grand total, including future postings. For example, 
if you enter a charge or payment with a date sometime in the future, the total amount due, rather than 
the amount due to date, displays. 

 
 Useful Information 

You can select the default view of this window. On the File Menu, click Setup > Initial Setup. 

Make your selection and click Save/OK, then Close. 
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About Billing Address 
The Billing Address window displays the billing address information for the selected fund, if different from 
the mailing or street address. In the navigation pane, click Billing Address. 

 
Fig. 7‐19. 

Use this window to send courtesy copies to a relative or to send copies of the billing statement to a 
different address during specific times of the year. You can add an unlimited number of billing addresses. 

Other Tuition & Fees Tasks 
In the navigation pane of the Tuition & Fees window, under Other Tasks, there are two additional 
commands: View/Print and Fund Filter. 

View/Print — Displays a listing screen where you can view and print fund activities by fund, fund period, 
or all funds and periods combined. You can also select to display and print recurring charge activities. 

 
Fig. 7‐20. 

Fund Filter — Normally, when you use the navigation buttons to scroll through records, the program 
displays each record. To only display families with a specific fund or fund period, click Fund Filter, and 
make your selections. 
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Fig. 7‐21. 

The filter is applied until you go back to the Quick Fund Filter dialog box, and click Clear Filter then 
Lookup/OK. 

Exercises 
For the following exercises, use the fund created at the end of the Fund Setup section. 

Exercise #2 

Set up a family for a tuition payment of $10 each week for the entire fund period. 

 

Exercise #3 

Set up a family for a tuition payment of $50 each quarter from August 2014 to April 2015. When is their 
first payment due? 

 

Exercise #4 

Set up a family for a tuition payment of $150 monthly, for a total of $2000. What special conditions must 
be made? 

 

Exercise #5 

Set up one student of the family with a tuition payment of $20 Weekly and another student with $100 
Monthly for the entire fund period. Which student’s total will be higher? 

 

Exercise #6 

Set up a family for a tuition payment of $100 per month, with a pay‐down of $300. 
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Questions 
Answer these questions pertaining to funds. 

Q: What three activity types would you need to track a Bus Fee? 

A:                      

 

Q: Can you post to fund 1‐14 after fund 1‐15 has been created?  Why or why not? 

A:                      

 

Q: What is the difference between “Weekly” and “Weekly on Tuesday”?  How is this distinction useful? 

A:                      

 

Q: What is the difference between Fund Period, Billing Period, and Calendar Year? 

A:                      

 

Q: What are the four rules for fund periods? 

A:                      

                     

                     

                     

 

Q: What is special about Quid Pro Quo activities? 

A:                      

 

Q: What activity type would you use to post a payment that reduces the rate but not the total pledge? 

A:                      

 

Q: What activity type would you use to post stock? 

A:                      

 

Q: What section of the Tuition & Fees window would you access to see the family’s fund status through 
today? 

A:                      
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8: Quick Posting 
Quick postings are designed to help you enter new data quickly by using a wizard to enter a large amount 
of related data at one time. They produce a list of selected items for viewing and printing before the 
information is posted. 

The quick postings are located in the navigation pane of the following data windows: 

Student Posting 
On the Information tab, click Students, then in the navigation pane, click Quick Posting. 

 
Fig. 8‐1. 

Dates — Post student sacrament dates in the Students Sacraments window. 

Grade Levels — Post the school grade levels in the Students Personal window, or post the formation 
grade levels in the Students Detail window. 

Talents — Post talent keywords in the Talents section of the Students Ministries/Talents window. 

Ministries — Post ministry keywords in the Ministries section of the Students Ministries/Talents window. 

Classes or Sessions — Post student class sessions in the Students Detail window. 

Hours of Service/Retreats — Post service hours or retreats in the Students Service/Retreats window. 

Attendance — Post student attendance in the Students Attendance window. When using this process to 
post student attendance based on an entire class/session, you can also select to mark the Catechist in 
attendance.  

Student Keywords — Post general student keywords in the Keywords section of the Students Personal 
window. 

User Defined Keywords — Post the 11 user‐defined keywords in the Students Personal window. You can 
also use this quick posting to post Marital Status, Language, Ethnicity, and Location in the Students 
Personal window. 

Student Pictures — Post student picture files in the Students Personal window. 

Safe Environment ‐ Background Check — Post background check information in the Students and/or 
Parents & Guardians Safe Environment window. 

Safe Environment ‐ Legal Requirements — Post legal requirements in the Students and/or Parents & 
Guardians Safe Environment window. 
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Family Posting 
On the Information tab, click Families, then in the navigation pane, click Quick Posting. 

 
Fig. 8‐2. 

Area Posting — Post geographic areas in the Families Primary Information window. 

Family Keywords — Post general family keywords in the Families Primary Information window. 

Family Pictures — Post family picture files in the Families Primary Information window. 

Post Volunteer Areas — Post parent/guardian volunteer areas in the Parents & Guardians Volunteer/Prep 
Classes window. 

Preparation Class Attendance — Post parent/guardian preparation class information in the Parents & 
Guardians Volunteer/Prep Classes window. 
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Tuition & Fees Posting 
On the Information tab, click Tuition & Fees, then in the navigation pane, click Quick Posting. 

 
Fig. 8‐3. 

Payment/Donation Entry — Quickly post payments and donations for families and members in the 
Rates/History/Keywds Tuition & Fees window. 

Do Electronic Fund Transfer — Post entries set up as electronic fund transfers for families and members 
in the Rates/History/Keywds Tuition & Fees window. 

Check Status of Electronic Fund Transfer — Check the status of an existing Electronic Fund Transfer 
batch. 

 
 Useful Information 

Detailed information about posting the Electronic Fund Transfer entries  is found in the Formation Office 
User Guide. 

 

Post Family Fees — Post miscellaneous fees, one per selected family in the Rates/History/Keywds Tuition 
& Fees window. 

Post Student Fees — Post miscellaneous fees, one per selected student in the Rates/History/Keywds 
Tuition & Fees window. 

Pledge Card Entry — Post pledge cards or tuition commitments in the Rates/History/Keywds Tuition & 
Fees window. 

Terms and Rates Entry — Post pledge terms and billing rates in the Rates/History/Keywds Tuition & Fees 
window. 

Post Fund Keywords — Post fund keywords in the Rates/History/Keywds Tuition & Fees window. 
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Common Steps in the Quick Postings 
Each of the quick postings follows the same general steps. For this training guide, as an example, we use 
the Student Dates posting. 

Automatic vs. Individual 
In the first step of the wizard, select Automatic Updating or Individual Entry. 

 
Fig. 8‐4. 

Automatic Updating 

To assign information to a group of families or individuals that have something in common, select 
Automatic Updating, and click Next. In the Selection window, you can use any selection previously saved 
from a report, or you can enter a new selection. In this example, we want to select all students in Mrs. 
Susan Higgins' Confirmation class. After you enter your selection information, click Next. 

 
Fig. 8‐5. 
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In the next window of the wizard, select the information you want to post to the families or individuals. In 
this example, we assign the sacrament date of “Confirmation”, on May 16, performed by Fr. Brown.  

 
Fig. 8‐6. 

Individual Posting 

In the first step of the wizard, if you selected Individual Entry, you must select families or individuals one 
at a time. Then for each family or individual, you enter or select what information you want to post. In our 
example, after you select a student, click Add Student to List. After you enter all families or individuals 
you want to post for, click Next. 

 
Fig. 8‐7. 
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Review the List 
The next step of the wizard is the same for both the automatic and individual entry method. In this 
window, review the list of families and individuals and the fields you want to post. You can modify some 
information in this window. To remove a family or individual from the posting, clear the Post Information 
check box. To include a family or individual who was left out, click Add Family/Student to List; in this 
example, Add Student to List. After you review the information you want to post, click Next. 

 
Fig. 8‐8. 

Ready to Post 
In the final step of the wizard, to print a summary of the changes, select the check box. To post the 
information, click Finish. 

 
Fig. 8‐9. 
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Notes About the Quick Postings 

 Quick postings produce a list of the records you selected for posting before the data is actually 
posted. In this step of the wizard, you can edit some information, select to leave a record out of 
the posting, or add a record to the list for posting. 

 Posting does not occur as you select records. To post the information, you must click Finish in the 
last step of the wizard. 

 You can post an unlimited number of records during a quick posting. 

 Some quick postings prompt you to back up your data if you have not already done so that day. 

 To stop a posting, click Cancel at any time. 

 To return to a previous step of the wizard and adjust your selections, click Back. 

 If you navigate to another part of the program before you click Finish, the posting is cancelled. 

Quick Posting of Payments 
The most commonly used quick posting is Payment/Donation Entry. Using this, you can post to any 
activity of any fund that is set up in the Fund Setup window. 

To quickly post payments/donations  

1. On the Information tab, click Tuition & Fees. 
2. In the navigation pane, click Quick Posting. 
3. Select Payment/Donation Entry. 
4. If you have any unfinished batches (those that haven't been posted), the Quick Posting Batches 

dialog box displays. To continue with an existing batch, select the batch in the list, then click Use 
Existing Batch. To start a new batch, click Add New Batch. 

5. If you create a new batch, on the Quick Posting Options dialog box, select how you want to 
perform this posting and future postings, then click Use/OK. 
Note:  You can also click Options below the posting grid to select your posting options. 

6. Enter the payments or contributions in the posting grid. For more details, see The Posting 
Window section of this chapter. 
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List of Batches 
When you post payments, you can save a batch of postings before you're finished and before you post. 
When you select the Payment/Donation Entry quick posting, if you have any unfinished batches, the 
Quick Posting Batches window displays. At the top of this window, the batches you have entered display 
in batch number order. At the bottom, the postings that are part of the selected batch display. To add 
postings to an existing batch, click Use Existing Batch. Or, to begin a new batch of postings, click Add New 
Batch. 

 
Fig. 8‐10. 

Quick Posting Options 
The Quick Posting Options dialog box displays each time you create a new batch. Use it to select 
information that should be repeated automatically for each payment. You can automatically post check 
numbers, comments, and attendance for all payments or contributions. You can also transfer the total to 
PDS Ledger or QuickBooks. 

For each batch, determine how you want to identify each family when posting. For example, if you select 
ID Number and Name, then you can select the family to post to by either entering their ID Number or by 
entering their name. Click Use/OK to save the options you selected. 

 
Fig. 8‐11. 
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Additional Field Information 

Select How You Will Enter Postings in the Posting Window 

Determine which information you want to use to identify your families when posting. To change the 
option fields at any time during the posting, in the Posting dialog, click Options. 

 ID Number and Name— Identify the contributing family by: 
o Family ID Number 
o Member ID Number 
o Family Name 
o Member Name 

 ID Number Only — Identify the contributing family by Family ID/Env Number or Member ID/Env 
Number. 

 Name Only — Identify the family you want to post a contribution or donation for by entering 
Family Name or Member Name. 

Select the Other Options You Will Post to 

Select from the following optional selections. Clear the options you do not plan to use and PDS will 
remove them from the Quick Posting window. 

 Post Check Numbers — Select if you plan to enter check numbers, "Cash", "M.O." or any other 
description. 

 Default for Check #/Cash field — Enter a default description for each post. For example, if the 
majority of your posts are cash, enter Cash. For entries that are not cash, you can edit the default 
description when you enter the post. 

 Post Comments — Comments can be used with any financial entry but are commonly used with 
Non‐Cash and Quid Pro Quo contributions. 

 Print Receipts — Select if you plan to print receipts for every entry. This option creates a Print 
Receipt column on each ledger line when you post payments. 

Select the Items to Repeat from the Previous Entry 

These options default the value of the previous entry to the next entry to save time. You can type over the 
default value to change it. 

 Fund Number — Select if the majority of entries post to the same fund. 

 Fund Year — Select if the majority of entries post to the same fund period. 

 Date — Select if the majority of entries post to the same date, or if you intend to sort the entries 
in date order before entering them. 

 Activity — Select if the majority of entries post to the same fund activity (such as Offering, 
Donation, Pledge Payment, or Tuition). 

 Amount — Select if the majority of entries post with the same amount, or if you intend to sort 
the entries in amount order before entering them. 
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Select the Following Check Boxes if You Want to 

 Print Receipt for Every Entry — Select to print a receipt for each entry. Unlike the Print Receipts 
option, this option does not create a column in the ledger. Receipts for all entries are printed 
after posting and summary reports print. 

 Total ID Numbers — Select to display a total of ID Numbers. This is not the total number of ID 
numbers, but a total value of the ID numbers themselves. For example, if you had two families 
using ID numbers, one using "101" and the other using "102," the report would total them and 
display "203." ID Numbers that contain any characters other than numeric values, such as 
symbols or alphabetical characters are not included in the total. 

 Automatically Check for Duplicate Entries — This option is selected by default. As you post 
payment entries, if you enter two entries with the same fund, period, date, family, and amount, a 
dialog box displays warning that it could be a duplicated. Each time, you have to select to either 
keep or remove the entry. If you do not want to be prompted for each possible duplicate, clear 
this option.  

 
 Useful Information 

On the Quick Posting window, you can check for duplicates. Below the posting grid, click Check 
for Duplicates. 

Hear Vocal Confirmation of Data Entry 

 For Amount — If selected, a computer‐generated voice reads back your entries in the amount 
fields. 

 For Name or ID — If selected, a computer‐generated voice reads back your selections for the 
name or ID fields. 

 Select Voice — If you plan to use the vocal confirmation feature, select the text‐to‐voice speech 
synthesizer program you use. Windows Vista and Windows 7 come with Microsoft Anna. You 
might have other options depending on the software installed on your computer. 

 Voice Rate — Select the speed the synthesizer reads back your entries. The slowest speed is ‐10. 
Click Test to confirm the voice rate. 

Export Batch Totals 

 To PDS Ledger — Creates a batch file that contains the totals for each fund and each activity 
group. The file can be imported into the PDS Ledger program. The file name format is 
Batch###.PFB, where ### is the batch number. For example, if the batch number is 411, the file 
name will be Batch411.PFB. 

 To QuickBooks — Creates a batch file that contains the totals for each fund and each activity 
group. The file can be imported into QuickBooks®. The file name format is Batch###.IIF, where 
### is the batch number. For example, if the batch number is 411, the file name will be 
Batch411.IIF.  

 Path for Export File — Enter the path where the file should be created. To search for the path 
and filename, click Browse. 

 QuickBooks Account Names File — Enter the path where the QuickBooks .IIF file with the Chart 
of Accounts names is located. This option is only available if you select the To QuickBooks 
option. 
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Additional Options 

 Only Active Families — Include families who are active (those who have not been marked 
inactive). 

 Only Inactive Families — Include families who are inactive. 

 Both Active and Inactive — Include all families. 

The Posting Window 
The Quick Posting window for payments and donations displays each payment or contribution in a grid. 
Information for the selected family displays at the top of the window. Inactive families appear in the grid 
in red, if you selected to display them. You can resize and reorder the grid columns. Click the column 
heading you want to move, and drag and drop it in the new location. 

If the family has never used the fund you are posting to, the program may warn and ask if you want to 
continue posting the entry. To continue, click Yes, and the fund is added to the family. To add funds to 
families without displaying the confirmation message, clear the Display Message when Family does not 
have the Fund Setup option. 

 
Fig. 8‐12. 

The Posting Grid 

Enter the payments or contributions in the posting grid. 

Fund Number and Fund Year — Enter a fund number and year, which make up the fund period or fund 
identifier. These can be different for each line of posting. 

Date — Enter the date the entry should post. If no entry is made, the date defaults to today's date. The 
program recognizes "relaxed dates," which means you can enter a posting outside of the fund period's 
regular date range. For example, a Registration Fee Payment for fund 8‐14 is dated March 15, 2014. 
Reports see the posting as part of the fund period (8‐14), even though it is before the fund period begins 
(8/14 ‐ 7/15). 

Activity — This identifies the fund activity that the payment or donation will be posted to. You can only 
select from fund activity names that have been set up in the Fund Setup window for the fund being used. 
If you leave this field blank, the program defaults to the first payment type in the drop‐down list. 
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ID or Name — The column varies depending on the selection you made in the Options dialog box for 
entering families or members. Enter or select ID Number or Name. Click the drop‐down arrow in this field 
to view a list of families or members and ID numbers.  

Amount — Enter the dollar amount of the contribution, donation, or payment. Non‐cash donations 
usually do not have a dollar value entered, so enter "0" for the amount and use the comment field to 
describe the item. 

Check #/Cash — If the contribution was made with a check, enter the check number. If the contribution 
was made with cash, enter CASH, or for a money order, enter M.O. If the contribution was made with a 
credit card you can enter MC, Visa, Am EX, or other descriptions. 

Print Receipt — Select to print a receipt for the entry. Receipts are printed at the end of the posting, after 
all entries have posted and the summary report(s) have printed. 

Comment — Enter additional descriptions about the payment or contribution. This is usually used for 
Non‐Cash Contributions, but can be used for any posting. 

 
 Useful Information 

If you try to add a posting entry to a family that does not have the indicated fund period set up, the 
program offers to add the fund to the family during posting. 

 

To change the posting options set at the beginning of the wizard, click Options. This action does not close 
the posting and it does not post the items. It allows you to make changes to the settings during the 
posting. 

To print a preliminary copy of the summary report, click Print. You can then compare the totals with the 
bank deposit and see if you need to make any corrections before posting. 

Saving, Posting, and Printing 
You can save the posting batch and return to it later, or you can post the batch as soon as you finish 
making entries. You can enter an unlimited number of entries in one posting. However, we recommend 
you save your posting after every 100 entries or so. 

 To do a "quick save" of the batch internally and continue working, click Save. 

 To save the batch and exit the window, click Finish Later. Doing this does not post any items. You 
can return to the batch at a later time. To return to the batch, click Use Existing Batch. 

 To leave this batch without saving or posting any items, click Cancel. 

 When adding entries, if you post an entry to the same fund and period, for the same family, with 
the same amount as another entry, the posting displays a duplicate entry message. If you select 
Yes, the entry is kept. If you select No, the posting then knows it is a duplicate and the entry is 
removed. 

 Use Check for Duplicates to do a final check for duplicate entries before posting to family 
records. If duplicates are found, a dialog box displays. This dialog box lists the details about the 
duplicate entries, including the entry line number so you can further investigate and make the 
necessary modifications before continuing with posting the batch. 

 To post the items, click Post to Families & Members. 
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If you select Yes to print the information when posting is complete, you can print a batch summary and a 
detailed list of entries. 

 
Fig. 8‐13. 

You can print entries in the order entered, by ID number, or by name. You can also select to omit the 
summary. When you are ready, you can print the entries marked for receipts. You can change printers and 
papers. 
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Exercises 
Exercise #1 — Post geographic area "1A" to all families who live in Phoenix. 

 
Exercise #2 — Post grade "3" to all members who are eight years old. 

 
Exercise #3 — Post a $10 late fee to all families who are behind on their pledge in fund RE‐14. 

 

Questions 
Q: Are quick postings used to update existing information or add new information? 

A:                     ______________ 

 
Q: What must be set up before you can post a late fee to individual families? 

A:                     ______________ 

 
 Q: Which quick posting would you use to assign fourteen‐year‐olds to a new confirmation class? 

A:                     ______________ 

 
Q: Which quick posting would you use to record that students have completed Confirmation? 

A:                     ______________ 

 

Q: Which quick posting would you use to assess a $25 sacrament fee per student? 

A:                     ______________ 
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9: About Processes 
 

Processes help you quickly and easily modify a large amount of related data at one time. Most of the 
processes suggest running a backup beforehand. Processes are located in the navigation pane of all major 
data windows. There are also processes that affect all program data. To locate these, on the File menu, 
click System Processes. 

Formation and Student Processes 
With formation and student processes, you can update data related to many students, their 
parents/guardians, and catechists at one time. You can also make many of these changes to individual 
student records.  

If you perform these processes at different times, we recommend that you keep an activity log of the 
functions performed. This activity log helps ensure that a process isn't run more than once a year and that 
postings aren't duplicated. 

 
 Important Note 

All processes alter data. We recommend backing up your data before proceeding with any of the 
processes. 

 

To access these processes, on the Information tab, click Students > Processes. 

 
Fig. 9‐1. 
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Formation Processes 
The formation processes consist of several data maintenance utilities that are particularly helpful at the 
beginning and end of the formation year. 

 
Fig. 9‐2. 

Adding a New Year or Period 
With this process, you can select a group of classes or sessions and duplicate the information with a new 
year/period and date range. You can select which information to retain and which to leave blank for the 
new year/period. 

In the navigation pane, click Processes, and click Add New Year/Period for Classes/Sessions.  

To add a new year/period automatically  

1. Select the Automatic Updating option, and click Next. 
2. Select the classes to post the new year/period for. To filter the selection, click <Click here to add 

a new condition>. 
3. Select to include only active, only inactive classes, or all classes, and click Next. 
4. Select a new year/period and a date range for the period. 
5. Select which information you want to retain from the old year/period or select the blank 

selections to leave that data empty for the new year. When you're finished, click Next. 

 
Fig. 9‐3. 

6. To create a list of dates that the class will not meet, click Insert, then enter a date and note. Click 
Next. 
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Fig. 9‐4. 

7. Review your list of classes/sessions. If you want to exclude any records from processing, clear the 
Post New Period check box. When you're ready to post, click Next. 

8. To post, click Finish. 

 

To add a new year/period individually  

1. Select the Individual Entry method, and click Next. 
2. Select a new year/period and a date range for the period. 
3. Select which information you want to retain from the old year/period or select the blank 

selections to leave that data empty for the new year. When you're finished, click Next. 
4. To create a list of dates that the class will not meet, click Insert, then enter a date and note. Click 

Next. 
5. Select a class, click Add Class to List, and repeat this process for each class you want to include. 

When you're finished, click Next. 

 
Fig. 9‐5. 

6. Review your list of classes/sessions. If you want to exclude any records from processing, clear the 
Post New Period check box. When you're ready to post, click Next. 

7. To post, click Finish. 
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Updating Student Enrollment Information 
With this process, you can update student enrollment information for multiple student records. 

You don't have to perform all of these activities at the same time. For example, you may want to add the 
next formation year to the student's enrollment history, but you may not be ready to post class and 
session information. You should plan the sequence of events ahead of time and keep a log of processes 
you've completed. 

In the navigation pane, click Processes, and click Enrollment. 

To update the student enrollment form  

1. Select the information you want to post, and enter any additional details. For more information 
on these fields, see the Additional Field Information below. 

 
Fig. 9‐6. 

2. Click Next. 
3. Select a student, review their information in the dialog box, and click Yes ‐ Enroll Student. 
4. On each tab, enter the student's information. 

 
Fig. 9‐7. 

5. To enroll another student, click Enroll Next Student. Repeat steps 3 and 4 for each student you 
want to enroll. 
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 Useful Information 

Click Show Class Sizes to display the current number of students enrolled in each class/session. 
The current class size is recalculated after you enroll each student. 

6. When you're ready to enroll the students, click Finish. 

Additional Field Information  

Post Enrollment Information — Add enrollment records for the current year to the Enrollment/Perm Rec 
section of the Students window for a group of students. 

Automatically Activating Students — Prior to preparing your formation data for the new year, you may 
have pre‐registered students by entering family and student personal information but marked them 
inactive so they wouldn't be included in that year's formation reports. You may have temporarily 
inactivated students and families for other reasons as well. As the new formation year begins, you can 
activate these students and families so that they're included in the new formation year's reports. 

 
 Useful Information 

If an inactive student is included in your list of students to be processed but automatic activation isn't 
selected, the changes apply to the student but their inactive status doesn't change. 

 

Post Class/Session — Schedule the same class or session for a group of students during the enrollment 
process. The class/session must be defined in the Class Schedules window. You can view the updated 
information in the Details section of the Students window. 

Post Financial Information — You can post financial activity related to formation tuition and fees to the 
fund activities of families for selected students. You may want to do this to post registration and/or 
tuition fees to all enrolling students. View information on all fund activities in the family's Tuition & Fees 
window. 

Post Service/Retreat — Update service and retreat information on students' records. You can view the 
updated information in the Service/Retreats section of the Students window. 

Removing or Advancing Student, Family, Catechist, or Parent/Guardian 
Information 
With this process, you can perform a number of year‐end actions, including: 

 Updating a student's permanent record with this year's session and attendance information 

 Removing graduating and/or inactive students 

 Deleting the student's current year schedule, attendance, service, and retreat information to 
keep only current information 

 Promoting students to the next grade 

 Updating a catechist's history record with this year's session information 

 Removing inactive catechists 

 Deleting a catechist's current year schedule and attendance to keep only current information 

 Removing old parent/guardian information 
 

You don't have to perform all of these activities at the same time. For example, you may want to perform 
the grade promotion to get an accurate count of the number of students in a particular grade for the next 
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year, but you may not be ready to remove the prior year session and attendance information. You should 
plan the sequence of events ahead of time and keep a log of which processes you've worked on. 

 
 Useful Information 

Proceed through all the pages of the process even if you don't select all of the categories of records to 
update. 

 

In the navigation pane, click Processes, and click End of Year – Formation Remove/Advance. 

 
Fig. 9‐8. 

To run the Remove/Advance process  

1. Select which year or period to process. 
2. Select any options for updating students' permanent records, removing old student records, and 

doing an automatic grade promotion. 
3. Select any options for updating catechists' history and removing old catechist information. 
4. Select any options for removing old parent/guardian information. 
5. If you remove family information, select an option for keeping or deleting their records. 
6. When you're ready to being the process, click Process. 
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Promoting Students to the Next Grade Level 
With this process, you can promote a group of students from one grade level to the next. Remember that 
you can also promote students during the Formation Remove/Advance process. 

 
 Useful Information 

Before using this process, review the Grades and Degrees keyword list to ensure it contains each grade 
you plan to promote and that the list is sorted in the order the grades should be promoted. If your list is 
out of order, a message displays before you start the process. 

 

In the navigation pane, click Processes, and click Grade Promotion. 

To promote students to the next grade  

1. Select to promote only the formation grade, only the school grade, or both, and click Next. 
2. Enter the range of grade levels you want to promote. Typically, you start with the first grade level 

on your list (Pre‐School or Kindergarten) and end with the last grade level that your school 
promotes to. 

3. To change the type for graduating students, select Change the type for those currently in the 
last grade listed below from Child to Young Adult. 

 
 Useful Information 

A student's type is set in the Personal section of the Students window. This is one way to 
distinguish between students whose last grade completed is 12 and students who are currently 
in grade 12. 

4. Select to include only active, only inactive, or all students. 
5. The grades for promotion display in the grid. Make any necessary changes, and when you're 

finished, click Next. 
6. Review your list of students. If you want to exclude certain records from processing, clear the 

check box. Click Next. 
7. To post, click Promote Students. 

Registering Families and Enrolling Students Online 
With this process, you can create an online form for families to enroll their students in formation classes. 
There are two options with the registration process: 

 Create Web Registration Form — You can create a registration form for your formation’s 
website. When families complete the online form for their student, registration information is 
saved to our secure web server. 

 Check and Register Families with Students — After families complete the online registration 
form, you can use this option to create or update student records in Formation Office and 
populate the data fields for the information that the family provided.  

In the navigation pane, click Processes, and click Register Families and Enroll Students Online. 
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To create an online registration form  

1. Select Create Web Registration Form. 
2. If you use the ACS Extend Platform to maintain your parish website, select Use Our Extend 

Platform Service; otherwise, select None ‐ Use Other Service, and click Next. 
3. Read the process description, and click Next. 

 
 Useful Information 

Note that this process creates a Read Me file, as well as HTML, CSS, and JavaScript files. You 
need to copy these files and send them to your website manager. If you are the website 
manager, consult the Read Me file for comprehensive instructions. 

4. Enter the form name and brief introduction to display at the top of your web form. 
5. Select the sections you want to display on the web form, and click Next. 
6. If you selected to include student sacraments, user keywords, and/or student remarks on the 

form, select the fields to display. Click Next. 
7. Select the class information to display on the web form, and click Next. 
8. Then select which of those  you want to require the family to enter when registering, and click 

Next. 

 
 Useful Information 

An asterisk (*) displays on the form beside the required fields you select. 

9. Enter the email address of the person who should be notified after a family registers their 
student(s) online. 

 
 Useful Information 

Typically, this is the email address of the person at your formation who processes registrations.

10. Enter a message to be emailed to the family to confirm that their information was sent to your 
formation. When you're finished, click Next. 

11. Select whether to store or transfer the files. 
12. Click Finish or Transfer. 

 
To check for and process registrations  

1. Select Check and Register Families with Students, and click Next. 
2. Select the family or families you want to create or update records for. 
3. If you no longer need a family's registration, select Delete Form to delete their registration from 

the web server. 
4. Review the family and student information. Make any necessary selections or changes, and when 

you're ready to process the registrations, click Next. 
5. To post the information, click Finish. 
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Automatically Promoting a Class to the Next Class 
With this process, you can promote all the students in one class to another class. You can process multiple 
classes at once. For example, you can promote all 1st Grade Religious Education students to 2nd Grade 
Religious Education. To promote students individually to different classes, see the Class/Session quick 
posting. 

In the navigation pane, click Processes, and click Automatic Class/Session Promotion. 

To promote all students in a class/session  

1. Select the class/session to move students from, then select the new class/session to move 
students into. 

 
 Useful Information 

The classes and their year/periods must be defined in the Class Schedules window and the Class 
or Session Year/Period Keyword list. 

2. Click Insert, and repeat this for each class or session. 

 
 Useful Information 

It's important to promote all classes that use this automatic posting feature at one time. For 
example, if the 5th grade RE class is promoted to 6th grade RE, and the 6th grade RE is not 
promoted to 7th grade RE, both the newly promoted class and the original class are assigned to 
the 6th grade RE class. 

3. Select to include only active students, only inactive students, or all students. 
4. When you're ready to move the students, click Post Classes/Sessions. 

Exchanging Previous Catechists With New Catechists 
If a catechist leaves during the formation year, you can use this process to assign their sessions to another 
catechist or a new catechist. 

 
 Useful Information 

Before running this process, you must add the new catechist in the Catechists window. 

 
In the navigation pane, click Processes, and click Catechist Exchange. 

To change a catechist's assignment  

1. Select the original catechist. 
2. Select the new catechist who is replacing the original catechist. 
3. Make any additional selections to update the catechist information. 
4. When you're ready to process the changes, click Exchange/OK. 

Reassigning Class Dates and Times 
With this process, you can conveniently assign the same schedule, days, and times to a group of classes. 
For example, it can be a lot of work to open every class and make the change if you have most of the 
same classes this year that you had last year, except the days they meet change. 
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In the navigation pane, click Processes, and click Reassign Class Dates and Times. 

To reassign dates and times automatically  

1. Select the Automatic Updating method, and click Next. 
2. Make selections to filter the list of classes you want to reassign. Select to include active, inactive, 

or all classes, and click Next. 
3. Enter the new dates and times for the class(es), and click Next. 
4. If you want to exclude any classes from processing, clear the Post Information check box. When 

you're ready to update the selected records, click Next. 
5. To post, click Finish. 

 

To reassign dates and times individually  

1. Select the Individual Entry method, and click Next. 
2. Enter the new dates and times for the class(es), and click Next. 
3. Select a class, and click Add Class to List. Repeat this process for each class you want to update, 

and when you're finished, click Next. 
4. If you want to exclude any classes from processing, clear the Post Information check box. When 

you're ready to post, click Next. 
5. To post, click Finish. 

Deleting Classes or Sessions 
With this process, you can delete multiple classes or sessions at one time. In the navigation pane, click 
Processes, and click Delete Classes/Sessions. 

 
To delete classes/sessions automatically  

1. Select the Automatic Updating method, and click Next. 
2. Make selections to filter the list of classes you want to delete. 
3. Review your list of classes. If you want to exclude any classes from processing, clear the check 

box. When you're ready to delete the selected classes, click Next. 
4. To remove the records, click Finish. 

 

To delete classes/sessions individually  

1. Select the Individual Entry method, and click Next. 
2. Select a class, and click Add Class to List. Repeat this process for each class you want to delete, 

and when you're finished, click Next. 
3. Review your list of classes. If you want to exclude any classes from processing, clear the check 

box. When you're ready to delete the classes, click Next. 
4. To remove the records, click Finish. 
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Student Processes 
The student processes provide you with utilities for managing information related to the members in your 
Formation database. 

In this section, the words "student", "member", and "family member" are often used interchangeably. 
"Member" can mean a parent, guardian, catechist, or student. 

 
Fig. 9‐9. 

Activating or Inactivating Family Member Records 
With this process, you can activate or inactivate multiple records simultaneously. For example, if some 
family members visit in the summer months, you can place them on an Inactive roster for the winter 
months. 

 
 Useful Information 

The inactive flag is a shared data field. Therefore, if you're sharing data with other PDS Office programs, 
activating or inactivating these family members is also reflected in those programs. 

 

In the navigation pane, click Processes, and click Activate/Inactivate.  

To change an individual's status automatically  

1. Select the Automatic Updating method, and click Next. 
2. Select whether to make family members active or inactive, and select an option for inactive 

families. Click Next. 

 
 Useful Information 

All active members in the database must belong to active families. Therefore, when activating 
members of inactive families, this process provides an option to automatically activate the 
families at the same time. 

3. Select the type of family members to make active or inactive, and click Next. 
4. Select which family member records you want to activate or inactivate. To filter the list, click 

<Click here to add a new condition>. When you're finished, click Next. 
5. Review your list of records. If you want to exclude any records, clear the check box. When you're 

ready to update the selected records, click Next. 
6. To update the records, click Finish. 
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To change an individual's status individually  

1. Select the Individual Entry method, and click Next. 
2. Select whether to make family members active or inactive, and select an option for inactive 

families. Click Next. 

 
 Useful Information 

All active members in the database must belong to active families. Therefore, when activating 
members of inactive families, this process provides an option to automatically activate the 
families at the same time. 

3. Select the type of family members to make active or inactive, and click Next. 
4. Select a family member, and click Add Member to List. Repeat this process for each family 

member, and when you're finished, click Next. 
5. Review your list of records. If you want to exclude any records, clear the check box. When you're 

ready to update the selected records, click Next. 
6. To update the records, click Finish. 

Updating Family Member Talents 
With this process, you can update or erase talent details for multiple individuals simultaneously. You can 
view talents in the Ministries/Talents section of the Students window. 

You can run this process for any individuals in the program, not just students, and you can modify existing 
talent information. Also, since talent records are included in shared data files, updates to talent 
information initiated in this program are reflected in the other Office databases. 

 
 Useful Information 

This process doesn't post new entries to the Ministries/Talents window. To quickly post talents, go to the 
Students window, and in the navigation pane, click Quick Posting > Talents. 

 

In the navigation pane, click Processes, and click Change Talents. 

To update family member talents  

1. In the first window, make your selections, and click Next. 
2. Select the type of family members to make changes to, and click Next. 
3. Select which family members to update. To filter the selection, click <Click here to add new 

condition>. 
4. Select to include only active or inactive individuals, or all individuals, and click Next. 
5. To assign different talents to each individual, select the first option. To update your entire list of 

individuals simultaneously, select the second option, and enter the new talent status and dates. 
Click Next. 

6. Review your list of individuals. If you want to exclude any records, clear the check box. When 
you're ready to update the selected records, click Next. 

7. To update the records, click Finish. 
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Updating Family Member Ministries 
With this process, you can update or erase ministry details for multiple individuals simultaneously. You 
can view ministry changes in the Ministries/Talents section of the Students window. 

You can run this process for any individuals in the program, not just students, and you can modify existing 
ministry information. Also, since ministry records are included in shared data files, updates to ministry 
information initiated in this program are reflected in the other Office databases. 

 
 Useful Information 

This process doesn't post new entries to the Ministries/Talents window. To quickly post ministries, go to 
the Students window, and in the navigation pane, click Quick Posting > Ministries. 

 

In the navigation pane, click Processes, and click Change Ministries. 

To update family member ministries  

1. In the first window, select which ministries, status, and/or dates to update. To filter family 
members based on specific ministries, select Only include family members..., and in the 
corresponding drop‐down list, select a ministry, status, and/or date range. 

2. Click Next. 
3. Select the type of family members to include in the process, and click Next. 
4. Select the family members whose ministry you want to update. To filter the selection, click <Click 

here to add a new condition>. 
5. Select to include only active or inactive family members, or all members, and click Next. 
6. To assign different ministries to each family member, select the first option. If you want to 

update your entire list of family members simultaneously, select the second option, and enter 
the new ministry, status, and/or dates. 

7. Click Next. 
8. Review your list of records. If necessary, you can edit the columns for each family member. If you 

want to exclude any records, clear the check box. When you're ready to update the selected 
records, click Next. 

9. To update the records, click Finish. 

Updating Family Member Interactions 
With this process, you can update or erase the logged letter entry on multiple records simultaneously. 
Once processed, you can view updates in the Letters, Visits, Etc. section of an individual's window. 

 
 Useful Information 

This process modifies existing entries in the Letters, Visits, Etc. window. It does not enter new lines.

 

For example, while conducting a pledge drive, you mailed two letters—the second with a pledge card. 
Soon, you begin receiving pledge cards from the families, and you want to update their records. In this 
case, you must change the Type for the sent letters to Positive Response. This makes it possible to locate 
and follow up on those who haven't responded by a certain date. 

In the navigation pane, click Processes, and click Change Letters Etc. 
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To update interaction details 

1. In the first window, make your selections, and click Next. 
2. Select the type of members to change, and click Next. 
3. Select the family members whose interactions you want to update. To filter the selection, click 

<Click here to add a new condition>. 
4. Select to include only active or inactive family members, or all members, and click Next. 
5. To assign different interaction information to each family member, select the first option. To 

update your entire list of family members simultaneously, select the second option, enter the 
interaction details. 

6. Click Next. 
7. Review your list of family members. If you want to exclude any records from processing, clear the 

check box.  
8. To erase an interaction, in the Erase this Line column, select the check box to mark each item 

you want to erase. 
9. When you are ready to process the information selected, click Next. 
10. To post, click Finish. 

Adding Individuals From Church or School Office 
With this process, you can add records from Church or School Office to the Formation Office program 
through a shared data location. 

 
 Useful Information 

You can only use Quick Add to process members if you share data with other PDS Office programs.

 

In the navigation pane, click Processes, and click Quick Add from Shared Data File.  

To add individuals from another program automatically 

1. Select the Automatic Updating method, and select whether to include members who have been 
deleted from the programs. 

2. Click Next. 
3. Make selections to filter the list of family members you want to add. 
4. Select to include active, inactive, or all family members, and click Next. 
5. Review your list of members. If you want to exclude any records, clear the check box. When 

you're ready to add the selected records, click Next. 
6. To add the records, click Finish. 

 
To add individuals from another program individually  

1. Select the Individual Entry method, and select whether to include members who have been 
deleted from the programs. 

2. Click Next. 
3. Select a family member, verify their information, and click Add Family Member to List. Repeat 

this process for each member, and when you're finished, click Next. 
4. Review your list of members. If you want to exclude any records, clear the check box. When 

you're ready to add the selected records, click Next. 
5. To add the records, click Finish. 
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Removing Multiple Individuals 
With this process, you can delete a group of individuals from your database. 

 
 Useful Information 

You can only remove a record permanently from your shared database if another program is not using 
that record. For example, if you share data with Church Office, you may want to retain access to a 
member in Church Office but remove them from the list of current members in Formation Office. 

 

In the navigation pane, click Processes, and click Quick Delete. 

To delete a group of members automatically  

1. Select the Automatic Updating method. If you're sharing data, select whether or not to 
permanently delete the members from all programs. 

2. Click Next. 
3. Make selections to filter the list of members you want to delete. 
4. Select to include only active, only inactive, or all members, and click Next. 
5. Review your list of members. If you want to exclude any records from processing, clear the check 

box. Click Next. 
6. To remove the selected members, click Finish. 

 

To delete a group of members individually  

1. Select the Individual Entry method. If you're sharing data, select whether or not to permanently 
delete the members from all programs. 

2. Click Next. 
3. Select a member, verify their information, and click Add Member to List. Repeat this process for 

each member, and when you're finished, click Next. 
4. Review your list of members. If you want to exclude any records from processing, clear the check 

box. Click Next. 
5. To remove the selected members, click Finish. 

Deleting Family Member Remarks 
With this process, you can remove the general, confidential, or special circumstance remarks from 
multiple records simultaneously. In the navigation pane, click Processes, and click Delete Family Member 
Remarks. 

To delete family member remarks automatically  

1. Select the Automatic Updating method, and click Next. 
2. Select which remarks to delete, and click Next. 
3. Select which type of family members to delete remarks for, and click Next. 
4. Make selections to filter the list of family members whose remarks you want to delete. Select to 

include only active, only inactive, or all members, and click Next. 
5. Review your list of family members. If you want to exclude any records from processing, clear the 

check box. Click Next. 
6. To delete the remarks, click Finish. 
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To delete family member remarks individually  

1. Select the Individual Entry method, and click Next. 
2. Select which remarks to delete, and click Next. 
3. Select which type of family members to delete remarks for, and click Next. 
4. Select a family member, verify their information, and click Add Member to List. Repeat this 

process for each family member, and when you're finished, click Next. 
5. Review your list of family members. If you want to exclude any records from processing, clear the 

check box. Click Next. 
6. To delete the remarks, click Finish. 

Deleting Permanent Records 
With this process, you can erase information found on a student's permanent record. You can delete 
entries for a specific year or all permanent record entries. For example, if you want to keep only the last 
five years of a student's permanent records, you would delete records older than six years after you start 
the new school year. 

In the navigation pane, click Processes, and click Delete Permanent Record. 

To delete permanent records automatically  

1. Select the Automatic Updating method, and click Next. 
2. Make selections to filter the list of students whose permanent record information you want to 

delete. 
3. Select whether to include only active, only inactive, or all students in the list, and click Next. 
4. Select whether to delete all the entries or only the matching entries. Enter additional information 

if needed, and click Next. 
5. Review your list of records. If you want to exclude any records from processing, clear the check 

box. Click Next. 
6. To delete the information, click Finish. 

 
To delete permanent records individually  

1. Select the Individual Entry method, and click Next. 
2. Select the student whose permanent record information you want to delete, and click Add 

Student to List. Repeat this process for each student, and when you're finished, click Next. 
3. Review your list of records. If you want to exclude any records from processing, clear the check 

box. Click Next. 
4. To delete the information, click Finish. 

Moving Family Member Information to Another Field 
With this process, you can move information from one field to another for multiple records. For example, 
if someone mistakenly entered the student relationship in the type field, you can move the type field to 
the relationship field for the affected students. 

In the navigation pane, click Processes, and click Move Family Member Information. 
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To move family member information  

1. Make selections to filter the list of family members whose fields you want to move, and click 
Next. 

2. Select the type of family members you want to work with, and click Next. 
3. Select the source field you want to move. To remove the original data, select Blank out <Source 

Field>. 

 
 Useful Information 

If you don't select this, the field retains the original value, and a copy of it is placed in the 
destination field. 

4. If you move a memo field (a large text box, such as comments), select to move either the entire 
memo or a single line. 

5. Select the destination field for the data you're moving. 
6. If you move a memo field, select to either overwrite the data or append it to the end. 
7. To move the data, click Move Fields. 
8. Click Yes to confirm the move. 
9. In the Print dialog box, click Preview to view the data moved. 
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Family Processes 
With family processes, you can change information in multiple family records simultaneously. You can 
also make many of these changes to individual family records. 

 
 Important Note 

All processes alter data. We recommend backing up your data before proceeding with any of the 
processes. 

 

To access these processes, on the Information tab, click Families > Processes. 

 
Fig. 9‐10. 

Compiling Kenedy Directory Information 
With this process, you can compile your data for the annual Official Catholic Directory (the Kenedy 
Directory). In the navigation pane, click Processes, then Kenedy Directory Information. 

You have three options for compiling your data. If you compiled your results for the previous year, you 
can select option one or two to display that information for comparison as you create this year's report. 
No matter which option you select, you can manually overwrite the results. 

   



PDS Formation Office Training Manual Processes  9 - 19 
 

Which option should you select? 

If you… Select

... track all personal and sacramental data and want to
    automatically calculate your numbers for the Kenedy Directory 

Option One

... use the previous year's information as a guide, but prefer to make manual
    or estimated counts for this year's results instead of automatic calculations 

Option Two

... have never compiled your Kenedy data and don't want to automatically
    calculate your numbers for the Kenedy Directory 

Option Three

Option One ‐ Use the Data in the Program to Calculate Statistics 
Select this option for accuracy and speed. The program compiles all of the statistical data that requires 
calculation: numbers of students, teachers, registered households, baptisms, and so on. 

 
 Useful Information 

Remember that the program can't count data you don't track.

You can select this option even if you didn't use PDS to compile your Kenedy data last year, but the data 
fields that display last year’s results will be blank. 

To automatically calculate statistics  

1. Select Use the Data in the program to calculate statistics, and click Next. 
2. Select the date range and options you want to use to determine what families and members are 

included in the calculations. Click Next. 
3. Select whether to calculate registered households, individuals, and deaths. If you calculate 

individual Catholics, you must select at least one keyword that designates them as "Catholic." 
Click Next. 

4. Select who you want to include and a calculation method for each. Click Next. 
5. Select the sacraments you want to calculate as well as the keyword values for each. Click Next. 
6. Enter information for the Kenedy Directory. 

 
 Useful Information 

This information prints at the top of the final report and typically doesn't change from year to 
year. If you compiled your directory data last year, it displays in the left column. 

7. Enter or update your information for the current year, and click Next to proceed through each 
window of the process. On the final window, the report generation options display. 

8. Select whether you want to print your Kenedy data, create a file, or save the data for the 
following year. If you want to create a file, enter the path and file name. 

9. Click Finish. If you print the report, the Print List dialog box displays. 

Option Two ‐ Start with Information Used Last Year 

If you used PDS to generate your Kenedy information last year, select this option to view that data 
alongside the fields where you enter this year’s information. With this option, you must enter all 
statistical data manually. 
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To automatically enter information and manually enter statistical data  

1. Select Start with information used last year, and click Next. 
2. If necessary, update the information for the Kenedy Directory. 

 
 Useful Information 

This information prints at the top of the final report and typically doesn't change from year to 
year. If you compiled your directory data last year, it displays in the left column. 

3. Enter or update your information for the current year, and click Next to proceed through each 
window of the process. On the final window, the report generation options display. 

4. Select whether you want to print your Kenedy data, create a file, or save the data for the 
following year. If you want to create a file, enter the path and file name. 

5. Click Finish. If you print the report, the Print List dialog box displays. 

Option Three ‐ Start with a Blank Form and Enter All Information 

You can select this option if you didn't use PDS to compile your data last year and want to manually enter 
your statistical data. 

To manually enter information and statistical data  

1. Select Start with blank form and enter all information, and click Next. 
2. Enter information for the Kenedy Directory. 

 
 Useful Information 

This information prints at the top of the final report and typically doesn't change from year to 
year. 

3. Enter or update your information for the current year, and click Next to proceed through each 
window of the process. On the final window, the report generation options display. 

4. Select whether you want to print your Kenedy data, create a file, or save the data for the 
following year. If you want to create a file, enter the path and file name. 

5. Click Finish. If you print the report, the Print List dialog box displays. 

 

Calculations for the Kenedy Directory window 

Additional Field Information 

Calculations for the Kenedy Directory (visible for Option One only) 

 Calculate the Number of Individual Catholics — Calculates the number of individuals with one or 
more of the selected keywords on their record. This assumes that User Keyword 1 has been 
established as "Religion." You must select at least one option to continue. 

 Calculate Number of Deaths — Calculates the number of deaths that occurred during the period. 
Only those individuals who have a date entered for Deceased are included. 

 

 Calculate Number of Brothers — There are two ways to define a brother: 

o Calculate based on "Bro" or "Brother" in Title — The program counts members who 
are male and have "Bro.", "Bro", or "Brother" in the title of their name. 
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o Calculate based on Personnel Type — Specify the value you're using in the Personnel 
Types list to mean "brother". 

 Calculate Number of Sisters — There are two ways to define a sister: 

o Calculate based on "Sr." and "Sister" in Title — The program counts members who are 
female and have "Sr.", "Sr.", or "Sister" in the title of their name. 

o Calculate based on Personnel Type — Specify the value you're using in the Personnel 
Types list to mean "sister". 

 Calculate Lay Teachers — There are two ways to define a lay teacher: 

o Calculate based on Teachers in School Office — Select only if you share a common data 
file with PDS School Office. The program counts members who are entered as teachers 
in School Office and not designated inactive. 

o Calculate based on Personnel Type — Specify the value you're using in the Personnel 
Types list to mean "lay teacher". 

 Calculate Number of School Students — There are two ways to define a school student: 

o Calculate based on Students in School Office — Select only if you share a common data 
file with PDS School Office. The program counts members who are entered as students 
in School Office and not designated Inactive. 

o Calculated based on Member Keyword — Specify the value you're using in the Member 
Keyword list to mean "school student." 

 Calculate Number of Cat/RE Students — Calculates the number of catechetical or religious 
education students. There are two ways to define a catechetical/religious education student: 

o Calculate based on Students in Formation Office —The program counts members who 
are entered as students in Formation Office and not designated Inactive. 

o Calculate based on Member Keyword — Specify the value you're using in the Member 
Keyword list to mean "school student." 

 

 Calculate Number of Baptisms — Since sacrament names can be customized, you must select 
which sacrament name is used for "baptism." Specify the latest age that a baptized child should 
be considered an infant. The default age is 7. 
An individual is included in this category if all of the following are true: 

o They have a sacrament matching the keyword you selected for "Baptism". 
o The status for the sacrament is Approximate, Yes, or blank. 
o The sacrament place matches the place you added for your parish (in other words, the 

sacrament occurred at your parish). 
o The date for the sacrament falls within the date range specified. 

 Calculate Number of Confirmations — Since sacrament names can be customized, you must 
select which sacrament name is used for "first communion." 
An individual is included in this category if all of the following are true: 

o They have a sacrament matching the keyword you selected for "Confirmation". 
o The status for the sacrament is Approximate, Yes, or blank. 
o The sacrament place matches the place you added for your parish (in other words, the 

sacrament occurred at your parish). 
o The date for the sacrament falls within the date range specified. 
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 Calculate Number of Marriages — Since sacrament names can be customized, you must select 
which sacrament name is used for "marriage." 
An individual is included in this category if all of the following are true: 

o They have a sacrament matching the keyword you selected for "Marriage". 
o The status for the sacrament is Approximate, Yes, or blank. 
o The sacrament place matches the place you added for your parish (in other words, the 

sacrament took place at your parish). 
o The date for the sacrament falls within the date range specified. 

 
 Useful Information 

If one or both partners in a marriage don't have one of the religion keywords that mean 
"Catholic," the marriage is counted as one interfaith marriage. Marital status works similarly, but 
uses the selected marital status selections instead of religion keywords. 

Corrections and Additions Pages window 

Additional Field Information 

Information for the Kenedy Directory 

 Placement City and other parish information — The placement city can be a city or county. 
Typically, the placement city and parish address don't change from year to year. 

 Parish Personnel — You can enter up to six people this way. 

 Residency/Rectory — Enter information for the rectory unless it's the same as the parish 
address. Select Suppress from print to notify Kenedy that you don't want this information 
included in the directory. 

 School Address — If your organization is a school or has a school, enter its address information 
here. If you calculate the number of sisters, brothers, and school students, those figures also 
display in this window. Select Suppress from print to notify Kenedy that you don't want this 
information included in the directory. 

 Catechesis/Religious — Enter Formation information. If you calculate the number of catechetical 
or religious education students, that figure displays on this page. Select Suppress from print to 
notify Kenedy that you don't want this information included in the directory. 

 Additional Addresses — Enter any addresses that you haven't specified yet. Select Suppress 
from print to notify Kenedy that you don't want this information included in the directory. 

 Statistical Overview — If you select to automatically calculate statistics, the totals display. At this 
point, you can overwrite the values manually if you believe they aren't accurate. 

 Vital Statistics — These values are automatically calculated based on your previous selections 
and the information in your database. 

 
 Useful Information 

The field Received into Full Communion isn't automatically calculated. You must enter the value 
manually. 
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Generate the Report window 

Additional Field Information 

Generate the Report 

 Create a File — The data generated by the report is saved in the location you specify in the File 
Name field. The file is saved in Comma Separated Values (.csv) format which can be imported 
into a number of programs, such as spreadsheet applications. The file contains three columns: 
Category, Old Value, and New Value. Each line after the heading represents information from 
one line of the report. Although Kenedy doesn't currently accept digital files for the directory, 
this is a way for you to save a digital version of your information. 

Comparing Data with Diocese Mailing List 
With this process, you can compare your existing data for family names and addresses with similar 
information in another database, such as the one used by a newspaper or diocese. The process identifies 
families whose names and addresses match exactly, families where part of the information is different, or 
families in your internal or external data that aren't in the comparison list. 

In addition, you can: 

 Create an external mailing list. 

 Accept changes to the families' names and addresses from the external file. 

 Add new families that are in the external list but not in the data. 

 Create and print a list of the differences including changes to addresses, families who have 
moved away, and new families. 

 
In the navigation pane, click Processes, then click Compare Parish Data With Diocese Mailing List. 

To compare information  

1. Click   to locate the file to compare your data to. Select all options that apply to the file. 
2. Select any options in order to limit which parish data you want to compare. 
3. Select what you want to do with newly registered families and deleted families, and click Next. 
4. The Comparison List displays. You can customize the list with the options available at the bottom 

of the window. Select the check box beside each record you want to include in the comparison. 
5. Click Next. You can print the comparison list, make global changes to your data, and/or create a 

new file of the comparisons. 
6. To customize your new file, click File Options. The Mail List Comparison Options dialog box 

displays. Specify additional options and phrases to describe the families for the exported files, 
and click Close. 

7. Click Finish. 
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Reordering ID Numbers 
With this process, you can change the ID numbers for families or reorganize the numbers in your 
database. You can free up unused numbers by identifying the ones being used by inactive individuals – 
that way, you can reassign them. 

In the navigation pane, click Processes, and click Reorder ID Numbers. 

 
 Important Note 

If you're sharing data with Church Office, and you selected the option in Formation to use Church 
ID/envelope numbers for family IDs, you cannot run this process in Formation Office. A message displays 
indicating to ask the PDS Church operator to reorder IDs. 

 

To reorder ID numbers  

1. Select either Reorder by Family Name or Reorder by ID Number, and click Next. For more 
information, see the Additional Field Information below. 

2. Select the families and/or family members you want to reorder. Enter the starting ID number and 
the increment by which to increase the ID. For example, if you enter 10 for the new ID number 
and increase by 5, then the next ID would be 15. 

 
 Useful Information 

This process can't assign non‐numeric values, leading zeros, or decimal values to the ID number.

3. Click Next. 
4. Select which families you want to process. To add more conditions to the family selection, click 

<Click here to add new condition>. When you're finished, click Next. 
5. Review the list of records. You can edit the New ID column. If you want to exclude any records 

from processing, clear the check box. When you're ready to reorder, click Next. 
6. To reorder the ID numbers, click Finish. 

Activating or Inactivating Family Records 
With this process, you can change the Active/Inactive status of a group of families. For example, you may 
want to inactivate multiple family records after printing statements at year‐end. In the navigation pane, 
click Processes, and click Activate/Inactivate Families. 

To change family statuses automatically  

1. Select the Automatic Updating method, and click Next. 
2. Select whether to make families active or inactive, and click Next. 
3. Make selections to filter the list of families whose records you want to activate or inactivate. 

When you're finished, click Next. 
4. Review your list of families. If you want to exclude any records from processing, clear the check 

box. When you're ready to activate or inactivate the selected records, click Next. 
5. To activate or inactivate the records, click Finish. 
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To change family statuses individually  

1. Select the Individual Entry method, and click Next. 
2. Select whether to make families active or inactive, and click Next. 
3. Select a family, click Add Family to List, and repeat this process for each family. When you're 

finished, click Next. 
4. Review your list of families. If you want to exclude any records from processing, clear the check 

box. When you're ready to activate or inactivate the selected records, click Next. 
5. To activate or inactivate the records, click Finish. 

Removing Multiple Families 
With this process, you can remove multiple families from your database. There are three methods for 
doing this: 

Removal Methods  Select to… 

Use the Automatic Updating method 
to select a group of families 

Simultaneously remove a group of families based on shared 
characteristics. 

Use the Individual Entry method to 
select one family at a time 

Group families that you select one‐at‐a‐time. The group is then 
deleted simultaneously. 

Remove all family records not in use 
by any program 

View a list of families who are no longer visible in the program 
and aren't being used in any of your PDS Office programs. 

 

 
 Useful Information 

You can only remove a record permanently from your shared database if another program is not using 
that record. For example, if you share data with Church Office, you may want to retain access to a family 
in Church Office but remove them from the list of current families in Formation Office. 

 

In the navigation pane, click Processes, and click Remove Families. 

To remove families  

1. Select a removal method. For the first two methods, if you're sharing data, you must specify if 
you want the removed records to be available to other PDS programs, or whether to delete them 
permanently from your database and hard drive. If you're not sharing data, this option doesn't 
display. Click Next. 

2. If you select the automatic updating method, select which families you want to remove. To filter 
the list of family selections, click <Click here to add a new condition>. When you're finished, click 
Next. 

3. If you select the individual entry updating method, select a family, click Add Family to List, and 
repeat the process for each family. When you're finished, click Next. 

4. Review your list of families. If you want to exclude any records from processing, clear the check 
box. When you're ready to remove the selected records, click Next. 

5. To remove the records, click Finish. 
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About Creating Constant Contact Email List 
PDS partners with Constant Contact® so you can build and maintain effective email lists for your parish. To 
create and update Constant Contact email lists, in the navigation pane, click Processes, and click 
Create/Update Constant Contact Email List. 

 
 Useful Information 

You must have a Constant Contact account before you can create or update Constant Contact email lists 
within your PDS programs. To create a Constant Contact account, please visit 
www.parishdata.com/groupreach. 

To create a new Constant Contact email list  

1. Read the Introduction information. To begin the wizard, click Next. 
2. Select which information to transfer to Constant Contact, and click Next. 
3. On the Selection Information tab, make your selections, and click Next. 
4. The Transfer List window displays. If you want to exclude any records from processing, clear the 

check box. When you're ready to post, click Next. 
5. To add your Constant Contact account information to your PDS program, click Add. Enter your 

information in the Add New Account dialog box, and click Save/Close. 
6. If you want to set your new account as the default account, click Yes. 
7. Click Next. The Contact Lists Name dialog box displays, and you can view the list of contacts on 

your Constant Contact account. 
8. In the Contact Lists Name dialog box, select a contact list, and click Next. 
9. To send the selected information, click Transfer. 
10. After the data transfer, click Yes to access the Constant Contact website. If you click No, you can 

transfer another list to Constant Contact or exit the wizard. 

Deleting Family Remarks 
With this process, you can remove the general or confidential remarks from the family's Primary 
Information window for multiple family records. In the navigation pane, click Processes, and click Delete 
Family Remarks. 

 To delete family remarks automatically  

1. Select the Automatic Updating method, and click Next. 
2. Select whether to delete general remarks or confidential remarks, and click Next. 
3. Select which family records to remove remarks from. To add more conditions to the family 

selection, click <Click here to add a new condition>. 
4. Select to include only active, only inactive, or all families, and click Next. 
5. Review your list of families. If you want to exclude any records from processing, clear the check 

box. When you're ready to delete remarks from the selected records, click Next. 
6. To delete the remarks, click Finish. 

 To delete family remarks individually  

1. Select the Individual Entry method, and click Next. 
2. Select whether to delete general remarks or confidential remarks, and click Next. 
3. Select a family name, click Add Family to List, and repeat this process for each family. When 

you're finished, click Next. 
4. Review your list of families. If you want to exclude any records from processing, clear the check 

box. When you're ready to delete remarks from the selected records, click Next. 
5. To delete the remarks, click Finish. 
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Moving Family Information to another field 
This process moves family data from one field to another. In the navigation pane, click Processes, and 
click Move Family Information. 

To move family information  

1. Select the families you want to include in the process, and click Next. 
2. Under the Source section, in the Move Data From The Following Field drop‐down list, select the 

source data you want to move. 

 If you move a memo field (a large text box, such as comments), select whether you want 
to move the entire field or a specific line. 

 To remove the original data and leave the source field empty, select Blank Out <Source 
Field>. If you do not select this check box, the field retains the original value and a copy 
will be placed in the destination field. 

3. Under the Destination section, in the Move Data To The Following Field drop‐down list, select 
where you want to move the data. 

 If you move a memo field, select whether to overwrite the existing data or add it to the 
end of the existing data. 

4. Click Move Fields. 
5. Before you move the fields, the program warns you that this process cannot be reversed. To 

move the data, click Yes. To cancel, click No. 
 

6. In the Print dialog box, click Preview or Print to view the data moved. 

Updating Family Interactions 
With this process, you can update or erase the logged letter entry on multiple records simultaneously. For 
example, while conducting a pledge drive, you mailed two letters—the second with a pledge card. Soon, 
you begin receiving pledge cards from the families, and you want to update their records. In this case, you 
must change the Type for the sent letters to Positive Response. This makes it possible to locate and 
follow up on those who haven't responded by a certain date. 

 

 
 Useful Information 

This process modifies existing entries in the Letters, Visits, Etc. window. It does not enter new lines.

 

Once processed, you can view updates in the Letters, Visits, Etc. section of an individual's window. 

In the navigation pane, click Processes, and click Change Letters, Visits, Etc. 

To update interaction details  

1. Make your selections, and click Next. 

 
 Useful Information 

If you enter a description, you must enter it exactly as it displays in the Letters, Visits, Etc. 
section because it isn't a keyword field. 

2. Select which family records to change. To add more conditions to the family selection, click <Click 
here to add new condition>. 
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3. Select whether to include only active, only inactive, or all families. When you're finished, click 
Next. 

4. Select whether to assign the changes per family or to assign the changes simultaneously to all 
families. Optionally, you can enter the new date, description, type, and note. Blank fields are left 
as‐is. Click Next. 

5. Review your list of families. You can edit the Date, Description, Type, and Note columns. To 
delete entry information from the Letters, Visits, Etc. section, click Erase this Line. When you're 
ready to update the information, click Next. 

6. To update the information, click Finish. 

Tuition & Fees Processes 
With these processes, you can change fund‐related information in multiple records simultaneously. You 
can also make many of these changes to individual records. 

 
 Important Note 

All processes alter data. We recommend backing up your data before proceeding with any of the 
processes. 

 

To access these processes, on the Information tab, click Tuition & Fees, and in the navigation pane, click 
Processes. 

 
Fig. 9‐11. 
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Move Fund Entries 
This process moves fund history entries from one date to another, one activity to another, or one fund to 
another. Use this process if you make a mistake during the Payments/Donations quick posting. 

In the navigation pane, click Processes, and click Move Fund Entries. 

 
Fig. 9‐12. 

To move fund entries  

1. Under the Move Fund Entries From section, select the current posting's Fund Identifier, Date(s), 
and Activity, then indicate if the items are in a specific batch or in any batch. 

2. Under the Move Fund Entries To section, select the new posting's Fund Identifier, Date, and 
Activity. 

3. Click Next. 
4. Review the list of proposed corrections, then click Next. 
5. To move the corrected entries, click Finish. A new batch is created containing the moved items. 

Delete Batch 
Use this process to delete any quick posting batch. 

 
Fig. 9‐13. 

In the list of processes, click Delete Batch, then enter the batch number, and click Delete/OK. 
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New Year Fund Setup 
This process creates a new fund period based on the current fund period, and sets up families to use it. 
You can include or reset terms, rates, and billing periods. 

 
 Important Note 

You must back up your data before continuing with this process.

This process is commonly used at the end of the calendar year to set up new fund periods for the coming 
donation year, and also at the end of the formation or school year to set up new periods for registration 
and tuition. 

You do not need to advance funds with multiple years until the end of the fund's last year. For example, 
fund 7‐13 might have a date range of January 2013 through December 2020. You would only advance this 
fund (if necessary) at the end of 2020, not at the end of each year. 

In the navigation pane, click Processes, and click New Year Fund Setup. 

 
Fig. 9‐14. 

To create a new fund period based on the current fund period  

1. Back up your data. 
2. In the Select the Fund to Process drop‐down list, select the fund you want to advance. The 

program fills in the settings based on the prior fund period. 
3. Verify that the New Fund Identifier, Goal, Date Range, and Families to be Transferred settings 

match how you want to set up the new fund period. 
4. If the fund has a Charge type, indicate if you want to transfer or change rates, and enter the New 

Billing Period. 
5. Indicate how to handle the last fund period. 
6. After you have verified or set all options for advancing the fund, click Process. When the process 

is complete, you have the option to advance another fund. 
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Carry Forward Balances 
The Carry Forward Balances and Prepayments process helps you transfer balances, overpayments, 
prepayments, and pre‐charges from one fund period to the next. With this process, you can: 

 Carry forward balances from last year to the current fund period. 

 Carry forward overpayments from last year to the current fund period. 

 Carry forward payments made last year for the current fund period. 

 Carry forward charges assigned last year for the current fund period. 

 Process funds at the same time. 

 
 Be Careful! 

All other users must exit the program before you continue.

 

Before you begin the process, you can print a worksheet that summarizes fund activities, balances, 
prepayments, and pre‐charges. Print a worksheet for each fund you intend to process. The worksheet has 
blank lines for you to make notes. 

In the navigation pane, click Processes, and click Carry Forward Balances and Prepayments. 

To process carry forward balances  

 

1. Select the fund to carry forward. The activities defined for the selected fund display under 
Activity Details for Fund. Make the appropriate selections. 

 
Fig. 9‐15. 

2. Click Next. 
3. Select the fund period from the Transfer Amounts from Old Fund Period drop‐down list. 
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Fig. 9‐16. 

4. In the Date to Post These Entries to in the New Period field, enter a post date. This date must be 
within the date range of the new fund period. 

5. To include inactive families and to add a new fund period when a family does not have a balance 
or prepayment, select Yes for each. 

6. Click Next. 
7. If you do not want to print a summary, clear the check box. To begin processing, click Finish. 
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About System Processes 
There are a few processes, which may also impact Church Office and School Office which are system 
processes. To access these system processes, on the File menu, click System Processes. 

 
Fig. 9‐17. 

Changing Area Codes 
When an existing area code is split into one or more new area codes, a list of the phone number 
exchanges involved is published. The Change Area Code wizard checks all phone number and fax number 
fields and updates them if necessary. If your program shares common data with another PDS Office 
program, this process changes the area codes and exchanges in all programs sharing the data. 

On the File menu, click System Processes > Change Area Code Wizard. Select whether to process all area 
code exchanges at once or to process only some exchanges. 

 
 Be Careful! 

This process alters data. We recommend backing up your data before proceeding. 

 

To process all exchanges at the same time  

1. Select Yes, process all of the exchanges at once, and click Next. 
2. Enter the old area code and the new area code. Click Next. 
3. Review your selections before processing. To process the changes, click Finish. 
4. Print the reports. Click Close. 
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To process some of the exchanges and enter them manually  

1. Select No, only some of the exchanges are being changed, and click Next. 
2. Select Enter area code and exchanges manually, and click Next. 
3. Enter the old area code and the new area code. Click Next. 
4. Enter all exchanges affected by the area code change. It's not necessary to enter them in order. 
5. After you enter the exchanges, click Next. 
6. Select whether you want to save the area code information to a file. Click Next. 
7. Review your selections before processing. To process the changes, click Finish. 
8. Print the reports. Click Close. 

To process some exchanges and load from a file  

1. Select No, only some of the exchanges are being changed, and click Next. 
2. Select Load the area code and exchanges from a file. Select the file, and click Next. 
3. Review the old area code and the new area code, and edit if necessary. Click Next. 
4. Add, edit, or delete any exchanges, and when you're finished, click Next. 
5. Select whether you want to save the area code information to a file. Click Next. 
6. Review your selections before processing. To process the changes, click Finish. 
7. Print the reports. Click Close.  

Changing the Case of All Information 
With the Change Case of All Information process, you can change all the words in your data file to upper 
and lower case letters, or to all upper case letters. 

The following items do not change when you run this process: 

 State abbreviations in the City/State Names Keyword list and on all address fields are not 
changed. For example, AZ is not changed to Az. 

 The Country Code, such as USA, in the City/State Names Keyword list is not changed. 

 The AM and PM associated with the time of day is not changed. 

 The abbreviation RE for Religious Education is not changed. 

 
 Be Careful! 

This process alters data. We recommend backing up your data before proceeding. 

 

On the File menu, click System Processes > Change Case of All Information. Select whether to change the 
case to upper and lower or to all upper case, and click Yes to process. 

 
Fig. 9‐18. 
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Changing How Names Display On Mailings 
With this process, you can: 

 Remove initials in mailing names, formal salutations, and informal salutations 

 Change M/M to Mr. & Mrs. in mailing names 

 Move middle names and initials to the Middle Name/Initial field 

 
 Be Careful! 

This process alters data. We recommend backing up your data before proceeding. 

 

On the File menu, click System Processes > Change Names. Select the name change options you want, 
and click Process. 

 
Fig. 9‐19. 

Changing the Format of Addresses 
With this process, you can: 

 Add abbreviations to specific addresses 

 Remove abbreviations from certain addresses 

 Change the case of the addresses 

 
The following items do not change when you run this process: 

 State abbreviations in the City/State Names Keyword list and on all address fields. For example, 
AZ is not changed to Az. 

 The Country Code, such as USA, in the City/State Names Keyword list. 

 
 Be Careful! 

This process alters data. We recommend backing up your data before proceeding. 
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On the File menu, click System Processes > Change Addresses. Select your format and case options and 
which addresses you want to change. When you're ready, click Change Addresses. 

 
Fig. 9‐20. 

Locating and Combining Duplicate Families 
With this process, you can locate and combine duplicate families. You can build a list of families and 
return to it at a later time. 

On the File menu, click System Processes > Combine Families. 

To search for duplicates and combine families  

1. If you've never used this process before, the Build List Options window displays. Select the 
options you want to use to match duplicate families. If a list already exists in the program, 
continue to step 3. 

 
Fig. 9‐21. 

2. When you're ready, click Build List. 
3. Click a family name in the grid to view the reason it was selected as a possible duplicate. 
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 Useful Information 

To conduct additional research about a family to determine which data set contains the correct 
information, double‐click the family, then click Print Worksheet. 

4. For each family, click Review Details Before Combining Families, and look for items displayed in 
red. Under Family or Matching Family, select the check box for the data you want to keep. The 
mismatched data is deleted. 

 
Fig. 9‐22. 

5. To combine the two families with the information you selected, click Combine Families. 

 
To combine families manually  

1. If you've never used this process before, the Build List Options window displays. Select the 
options you want to use to match duplicate families. If a list already exists in the program, 
continue to step 3. 

2. When you're ready, click Build List. 
3. Click the Select Families Manually tab. In the top grid, select the family you want to combine 

with another. In the bottom grid, select the matching family you want to combine. 
4. Click View Family Details. 
5. Look for items displayed in red. Under Family or Matching Family, select the check box for the 

data you want to keep. The mismatched data is deleted. 
6. To combine the two families with the information you selected, click Combine Families. 
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Locating and Combining Duplicate Members 
With this process, you can locate and combine duplicate members. You can build a list of members and 
return to it at a later time. 

On the File menu, click System Processes > Combine Members. 

To combine members  

1. Select the family whose members you want to combine. 

 
Fig. 9‐23. 

2. For each member, select an action to take. 

 
 Useful Information 

If you need to conduct additional research about a member in order to determine which data 
set contains the correct information, click Review Details Before Combining Members, and click 
Print Worksheet. 

3. For each member you want to combine, click Review Details Before Combining Members, and 
look for items displayed in red. Under Member or Matching Member, select the check box for 
the value you want to keep. The mismatched data is deleted. 

4. To combine the two members, click Combine Members. 
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Exchanging User Keyword Positions 
With this process, you can change the positions of the user keyword drop‐down fields in the Personal 
section of the Members window. 

On the File menu, click System Processes > User Keyword Exchange. 

 
      Fig. 9‐24. 

 
 Be Careful! 

This process alters data. We recommend backing up your data before proceeding. 

 
 

 
 Useful Information 

Typical user keywords include Religion, Disability, and Occupation among others. To set up user keyword 
field names and values, on the File menu, click Keywords > Member Keywords > User Keywords. 

 

To switch user keyword positions  

1. Under Swap this Keyword, click the first keyword field you want to move. 

2. Under With this Keyword, click the keyword to swap with the first. 

3. Click Process. 
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Exercises 
Exercise #1 

Make all of the families from ID# 1 through 100 inactive. 

Exercise #2 

Promote the children in grades 1 through 12, marking those in 12th grade as Young Adult. 

Exercise #3 

For all members with the Ministry of Lector, change their status to Actively Involved. 

Questions 
Answer these questions pertaining to processes. 

Q: Which process would you use to promote the entire 3rd Grade Formation class to the 4th Grade 
Formation class? 

A:                      

 

Q: Mrs. Finch, the Confirmation catechist, retired in the middle of the year. What process would you 
use to assign her classes to Mr. Novak? 

A:                      

 

Q: Which process would you use to add 50 new students from Church Office to Formation Office? 

A:                      

 

Q: Which process would you use to set up fund 3, Tuition, for the next school year, and add that fund 
period to all the families that had it last year? 

A:                      

 

Q: Which process would you use to combine duplicate family records? 

A:                      
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10: Importing Data 
 

If you need to move your data from point A (your old program) to point B (PDS Office program), you can 
use the Import Data processes. 

 
Fig. 10‐1. 

Requirements 
To import data, your existing data must be in .csv file format. We strongly recommend that you include 
field names (headers) in the first record of your .csv file. In all of the Import Data processes, you have to 
select corresponding values for the PDS Office program fields, so if these values are labeled in a 
meaningful way, you can easily identify them. 

 Be Careful 

Make sure you understand how to use import keys before using the import processes. 
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              Fig. 10‐2. 

Understanding Import Keys 
In order to use the import processes for more than a simple “one file” family import, some understanding 
of relational database concepts is required. The import processes are intended for those who can 
comfortably manipulate data in Excel or work with tables in Access. 

 Tip 
After reviewing this section, if you don’t feel confident about how these apply to your file(s), contact the 
PDS Data Services Team (1‐800‐892‐5202 ext. 7778) for assistance. Data Services fees vary based on the 
complexity of the import and whether the data needs to be refined and/or cleaned before importing. 

 
To import a single file with clean, well‐formatted family information, the key fields discussed in this 
section are not required. Key fields are typically needed when you process multiple files or when you 
process a single file multiple times. This way, the program can understand the relationship between the 
files. 

 Useful Information 

A file can be processed multiple times if it contains information handled by different import processes. 
For example: a single file that contains both family and member details. 
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Importing Multiple Files Without Keys 
If the files you're importing don't contain the necessary keys to link the information together, someone 
will need to spend the time to add this information to the files. If you have many records, you can contact 
our Data Services team to import the data for you. Data Services is staffed by trained professionals with 
years of experience migrating data between various systems. 

Simple Family Example 
Here is a simple family example with two files: 

 FamilyBasicInfo.csv contains envelope number, name, and address information. 

 FamilyHomePhones.csv contains the primary home phone number for each family. 

FamilyBasicInfo.csv 

 
Fig. 10‐3. 

FamilyHomePhones.csv 

 
Fig. 10‐4. 

Matching the Data 

Notice how every row in the FamilyHomePhones file contains a FamKey field that corresponds to the 
matching family (with the same FamKey) in the FamilyBasicInfo file. Both of your files must contain a 
column that has a unique identifier like FamKey. This identifier allows the phone number from the second 
file to be matched to the appropriate family in the first file. This is a much more reliable method than 
trying to match rows based on name. For example, there may be multiple families with the same name in 
your file, or the names might not be entered exactly the same in both files. 

Identifying the Import Key 

When you process the first file, identify the identifier column as the "Import Key". This stores the Import 
Key as a hidden field in the database that's used when you process the second file. When processing the 
second file, you are updating existing family records rather than creating new families. In the Import 
Family Information process, check the Advanced Options dialog box to enable the features for updating 
existing records. 
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Simple Member Example 
This is similar to the simple family example where phone numbers from one file were matched to families 
from another. However, while each family usually has only one home phone number, there are typically 
several members in each family. There are several rows in the file with duplicate FamKey numbers. 

MemberBasicInfo.csv 

  
Fig. 10‐5.  

Using Member Keys 

Notice how all of the members in the Abel family have the same FamKey. When you load the member 
data from the file, you can do the following: 

 Set the Family Key to indicate which family the member belongs to. 

 Use the Member Key so future imports can be linked to the correct member (such as sacraments 
or ministry information). 

Primary and Foreign Keys 

The names of the key fields in a set of related files have specific names: 

 Primary Key – Uniquely identifies a row in a table. Once you use a primary key in a table, it 
should not display again in that file. Other files reference the primary key. 

 Foreign Key – Establishes a link to another row in a different table. Foreign keys in a related table 
reference the primary key in a main table. 

In the simple family and member examples, the FamKey field is the primary key in the FamilyBasicInfo.csv 
file. In the FamilyHomePhones.csv and MemberBasicInfo.csv files, FamKey is the foreign key. 
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Import Results 
The image below displays what the Family Primary Information window looks like after running the 
following processes using the example files: 

 Import Family Information – FamilyBasicInfo.csv 

 Import Family Information – FamilyHomePhones.csv 

 Import Member Information – MemberBasicInfo.csv 

 
Fig. 10‐6. 
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Member Sacrament Example 
This example shows how information from the MemberBaptisms.csv file relates to the 
MemberBasicInfo.csv file. 

 
Fig. 10‐7. 

Notice how the MemKey in this file matches up with the MemKey from the basic member file. The first 
row references MemKey 64423 which corresponds to Bessie Abel. 
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Data Relationship Diagram 
The following diagram shows how the identifier fields, FamKey and MemKey, link the files. 

 
Fig. 10‐8. 

Ready to Import? 
After reviewing this section, do you feel confident about how the import concepts apply to your own 
file(s)? 

Yes – I'm Ready to Import 

If you feel confident with the concepts discussed in this section, you can continue with the import 
processes. 

Maybe – With Assistance 

Contact the PDS Technical Support Team for assistance importing your information. You should have well‐
formatted .csv file(s) with a header record and clean data. Import keys are required if you need to run 
multiple import processes (family, member, sacrament, etc). You can only import to the fields available in 
the import processes. 

No – I Want Someone Else To Do This For Me 

If you don’t feel confident with the concepts discussed in this section, contact the PDS Data Services Team 
at 1‐800‐892‐5202 ext. 7778, and we will import the data for you. Fees apply. 

Importing Family Information 
You can use the Import Family Information process to import existing family data from a .csv file into your 
PDS Office program. On the File menu, click Import Data > Import Family Information. 
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Fig. 10‐9. 

Before You Begin 

Before you import family information, make sure your file contains a value that differentiates records 
from one another. We call this a "family key." For example, if your previous program assigned a number 
to each family, that value can be used as the family key. If you're also going to import member 
information, the family key must be the value that links the member record to its family record in your 
PDS Office program. 

How This Process Works 

Once you identify the .csv file, you will match the values in that file with your PDS Office program fields. 
There are a few required fields, but other than that, you only have to enter information for the data you 
want to import into your program. 

No data is imported until you click Begin Import on the final tab. Your selections are automatically saved 
on each tab, so you can come back to this process at another time if needed. 

To import family data  

1. On the File menu, click Import Data > Import Family Information. 
2. The backup dialog box displays if you haven't performed a daily backup. To make a backup, click 

Yes. 

 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

3. The Import Family Information dialog box displays. On the File Information tab, click Browse to 
locate the .csv file. After you select a file and click Open, your data displays in the window. 
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 Useful Information 

We strongly recommend that you include field names/headers so it's easier to select the 
corresponding value from the drop‐down lists on other tabs. 

4. On each tab, select the appropriate values from the drop‐down lists. For example, if the first 
column of your table is labeled "Fam Number" and you want that value to be the family key, then 
in the Family Key drop‐down list, select Fam Number. For more information about fields on 
these tabs, refer to the Additional Field Information sections below. 

 Useful Information 

If you have existing information in PDS and want to update or override that information with the 
data in your .csv file, select Advanced Options and adjust the settings on the Key/ID Number and 
Keywords/Remarks tabs. 

 

5. On the final tab, before you import your data, click Pre‐Import Data Check. This creates a file 
called "PreImportFamReport.txt" in your program's data folder. 

6. Scroll through the items you're going to import to see if you need to make any adjustments. 
7. When you're ready to import the data into your PDS Office program, click Begin Import. 
8. Once the import is complete, a summary displays. This creates a file named 

"FamImportReport.txt" in your program's data folder. 
9. When you're done, click Finish. 

Additional Field Information  
Additional field information is listed in the tabs below. Most fields are self‐explanatory, so not all fields 
are documented. 

Key/ID Number 

Family Key — This value differentiates family records from one another. For example, if your previous 
program had a field called "Family Number" that assigned a number to each family, select that value here. 
This value must be unique to each family. If you're also going to import member data using the Import 
Member Information process, the family key must be the value that links the member record to the family 
record. You can select the same value for the Family Key and ID Number fields. 

ID Number — This value represents the family's ID number. If any family records don't have an ID 
number, enter the starting number in the Start New ID Numbers with field. IDs are assigned to those 
records starting with this value. 

Family is Active/Inactive — Only Yes/No or True/False values in the file are recognized. You must select 
either Yes or True means Active or Yes or True means Inactive. 
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Advanced Options  

 Useful Information 

If you don't currently have any data in your PDS Office program, you don't need to use Advanced Options.

 

When selected, the following advanced options display in the window: 

 Add new records — Imports all data as new records. If you have no existing data in your PDS 
Office program, select this option. 

 Update current data ONLY ‐ do not add new families — If you have data into your PDS Office 
program and only want to update that existing data, select this option. 

 Useful Information 

If your import file contains records that already exist into your PDS Office program and you don't 
select this option, duplicate records are created. 

 Update current data and ADD new family record if Family Key not found — If you have data in 
your PDS Office program and your import file contains updated information as well as new 
information, select this option. A new record is added if the family/member key isn't found. 

If your import file contains information that you want to add to the existing data in your PDS Office 
program, you must match the values in the file with the record in PDS. 

Select an option to indicate what value you want matched with existing PDS records: 

 Use the PDS Fam ID Number to match families — Match the value you selected as the Family 
Key with the PDS family ID Number. 

 Use the Family Import Key to match families — Match family records using the value you 
selected as the Family Key. 

 Use the PDS Family Unique ID Number (exported from PDS) to match families — Match families 
using the unique, internal number Fam Unique ID assigned to each family by the program. 

Name/Details 

Alternately, Create Family Records Based on this Field — Select if you have a single field containing the 
entire family name rather than separate fields for each part of the family name. 

 Useful Information 

If there's more than one name per line, the names must be separated by "&", "/", or "and." If your family 
name field is formatted differently, the data won't import correctly. 

In Addition to Creating a Family Record, Create Member Record(s) — Creates member records based on 
the Family Name selections. 

 Tip 

Don't select this option if you have a separate import file for member data. Instead, use the Importing 
Member Information process. 

Family Status and Registration Date — Only dates formatted as MM/DD/YYYY in your file are recognized. 
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Address 

Address found in separate fields — Select if your import file has separate values for Street Number, 
Street Name, and Street Direction. 

 City or City, State — If your file has a single value for both the city and state, select that value in 
this drop‐down list. Otherwise, select the city, then select the state in the State drop‐down list. 

 Street Zip and Street Zip Plus 4 — If your file has a single value for the ZIP code (either the five‐
digit or the nine‐digit format), select that value in the Street Zip drop‐down list. If you have a 
separate value for the last four digits, select that value in the Street Zip Plus 4 drop‐down list. 

 Send No Mail — If your file has a value indicating that the family doesn't want to receive mail, 
select that value. Only Yes/No or True/False values in the file are recognized. 

Phone/Email 

Additional Field Information  

Default Area Code — Enter a default area code for any imported records that don't contain the area code 
information. 

Phone 1, Phone 2, and Phone 3 — Each Phone section represents a type of phone number. For example, 
Phone 1 can represent a family's home phone number, Phone 2 can represent a cell phone number, and 
Phone 3 can represent a fax number. 

Unlisted — Only Yes/No or True/False values in the file are recognized. 

Description — Select a value from either the first Description drop‐down list or the second one based on 
the following: 

 Assign Import File Phone Desc — If your import file has separate columns for each type of phone 
number, select the value from the first Description drop‐down list. For example, if you want the 
Phone 1 section to represent the family's home phone, from the first drop‐down list, select the 
value that corresponds to home phone number. 

 Assign PDS Phone Desc — If you have Phone Description keywords set up in your PDS Office 
program (under General Keywords), select the value from the second Description drop‐down list. 

Email Over Mail — If your import file has a value indicating that the family prefers to receive emails over 
letters, select that value. Only Yes/No or True/False values in the file are recognized. 

Keywords/Remarks 

Family Keywords — If you have a family keyword field with a Yes/No or True/False value, you must enter 
a corresponding description. For example, if "Yes" describes a school family, then enter "School Family" in 
the Description field. This way, a keyword of "School Family: Yes" or "School Family: No" imports into 
your PDS Office program. The Description field is limited to 12 characters. 

Family Pictures — Make sure that the picture file is in the appropriate folder in order for it to display in 
your PDS Office program. We recommend that you store picture files in a shared folder, such as 
X:\PDSOffice\Pictures. 

Advanced Options  

 
 Useful Information 

If you don't currently have any data in your PDS Office program, you don't need to use Advanced 
Options. 
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When selected, the following advanced options display in the window: 

 Add to existing remarks — Keeps any existing remarks, and adds any remarks from your import 
file. 

 Replace current remarks with this content — Removes any existing remarks, and adds the 
remarks from your import file. 

 Replace current remarks OR delete current remarks — If your import file contains remarks, they 
replace the existing remarks in the program. If your file doesn't contain remarks, the existing 
remarks in the program are deleted. 

Importing Member Information 
You can use the Import Member Information process to import existing member data from a .csv file into 
your PDS Office program. On the File menu, click Import Data > Import Member Information. 

 
Fig. 10‐10. 

Before You Begin 

To use this process, you must first import your family data. For more information, see Importing Family 
Information. 

After you import family data, you can import member data. When you imported your family information, 
you assigned a value to the Family Key field. This value represents the field in your previous program that 
differentiated between family records. For example, if your previous program had a field called "Family 
Number" that assigned a unique number to each family record, this is the value you selected as the family 
key. 

Each member record must contain the same Family Key value. This links the member information with 
the appropriate family record that you've already imported to your PDS Office program. Each record must 
also have a unique member key value that represents the field in your previous program that identified 
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each member record. For example, if your previous program had a field called "Member ID" that assigned 
a unique number to each member record, this is the value you should select as the member key. 

How This Process Works 

Once you identify the .csv file, you will match the values in that file with your PDS Office program fields. 
There are a few required fields, but other than that, you only have to enter information for the data you 
want to import into your program. 

No data is imported until you click Begin Import on the final tab. Your selections are automatically saved 
on each tab, so you can come back to this process at another time if needed. 

 To import member data  

1. On the File menu, click Import Data > Import Member Information. 
2. The backup dialog box displays if you haven't performed a daily backup. To make a backup, click 

Yes. 

 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

3. The Import Member Information dialog box displays. On the File Information tab, click Browse to 
locate the .csv file. After you select a file and click Open, your data displays in the window. 

 Useful Information 

We strongly recommend that you include field names/headers so it's easier to select the 
corresponding value from the drop‐down lists on other tabs. 

4. On each tab, select the appropriate values from the drop‐down lists. For example, if the first 
column of your table is labeled "Member ID" and you want that value to be the member key, 
then in the Member Key drop‐down list, select Member ID. For more information about the 
fields on these tabs, refer to the Additional Field Information sections below. 

 Useful Information 

If you have existing information in PDS and want to update or override that information with the 
data in your .csv file, select Advanced Options and adjust the settings on the Key/ID Number and 
Keywords/Remarks tabs. 

5. On the final tab, before you import the data, click Pre‐Import Data Check. This creates a file 
called "PreImportMemReport.txt" in your program's data folder. 

6. Scroll through the items you're going to import to see if you need to make any adjustments. 
7. When you're ready to import the data into your PDS Office program, click Begin Import. 
8. Once the import is complete, a summary displays. This creates a file named 

"MemImportReport.txt" in your program's data folder. 
9. When you're done, click Finish. 
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Additional Field Information  
Additional field information is listed in the tabs below. Most fields are self‐explanatory, so not all fields 
are documented. 

Key/ID Number 

Family Key — This value connects the member to a family record. This value should be the same Family 
Key value you selected in the Import Family Information process. 

Member Key — This value differentiates member records from one another. For example, if your 
previous program had a field called "Member ID" that assigned a number to each member, select that 
value here. This value must be unique to each member. If your import file doesn't have this information, 
you must create a separate field in the file and assign a unique value to each record. 

Member ID Num — If your import file has a value that represents a unique member number, select that 
value here. This number cannot be the same as the Family ID Number. 

Member is Active/Inactive — Only Yes/No or True/False values in your file are recognized. You must 
select either Yes or True means Active or Yes or True means Inactive. 

Advanced Options  

 Tip 

If you don't have any data in your PDS Office program, you do not need to use Advanced Options.

 

When selected, the following advanced options display in the window: 

 Add New Records — Imports all data as new records. If you have no existing data in your PDS 
Office program, select this option. 

 Update Current Data ONLY ‐ Do not add new members — If you have data in your PDS Office 
program and only want to update that existing data, select this option. 

 Useful Information 

If your import file contains records that already exist in your program and you don't select this 
option, duplicate records are created. 

 Update Current Data and ADD New Member record if Member Key not found — If you have 
data in your PDS Office program and your import file contains updated information as well as 
new information, select this option. A new record is added if the family/member key isn't found. 

If your import file contains information that you want to add to existing data in your PDS Office program, 
you must match the values in the file with the record in PDS. 

Select an option to indicate what value you want matched with existing PDS family records: 

 Use the Family Import Key to match members to families — Match members to family records 
using the value you selected as the Family Key. 

 Use the Family ID Number to match members to families — During the Import Family 
Information process, if you selected Use the PDS Fam ID Number to match families, select this 
option when importing member data. 
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Select an option to indicate which value you want matched with existing PDS member records: 

 Use the Member Import Key to update members — Update member records using the value 
you selected as the Member Key. 

 Use Member ID number to update members — Update member records using the value you 
selected as the Member ID Number. 

 Use the PDS Member Unique ID Number (exported from PDS) to update — Update member 
records using the unique, internal number Mem Unique ID assigned to each member by the 
program. 

Name/Details 

Birth Date and Deceased Date — Only dates formatted as MM/DD/YYYY in your file are recognized. 

User Keywords 

If your previous program contained user‐defined keyword lists, you can import them. The first three 
keywords are already defined in PDS Office programs. Select the corresponding value for Religion, Special 
Needs, and Occupation in the drop‐down lists. 

Screen Labels and Data — Under Screen Labels, enter the keyword list name that exists in your program. 
For example, if your previous program had keywords for school district, in one of the keyword fields, 
enter "School District". Then, in the Data drop‐down list, select the corresponding value from your file. 

Phone/Email 

Default Area Code — Enter a default area code for any imported records that don't contain the area code 
information. 

Phone 1, Phone 2, and Phone 3 — Each Phone section represents a type of phone number. For example, 
Phone 1 can represent a member's home phone number, Phone 2 can represent a cell phone number, 
and Phone 3 can represent a fax number. 

Unlisted — Only Yes/No or True/False values in your file are recognized. 

Description — Select a value from either the first Description drop‐down list or the second one based on 
the following: 

 From Import File — If your import file has separate columns for each type of phone number, 
select the value from the first Description drop‐down list. For example, if you want the Phone 1 
section to represent the member's home phone, from the first drop‐down list, select the value 
that corresponds to home phone number. 

 From PDS List — If you have Phone Description keywords set up in your PDS Office program 
(under General Keywords), select the value from the second Description drop‐down list. 

Email 1, Email 2, and Email 3 — Each Email section represents a type of email address. For example, Email 
1 can represent a member's business email, Email 2 can represent a personal email, and so on. 

Type — If your import file has separate values for each type of email address, select the value from the 
first Type drop‐down list. Otherwise, if you have Email Description Names keywords set up in your PDS 
Office program (under General Keywords), select the value from the second Type drop‐down list. 
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Keywords/Remarks 

Member Keywords — If you have a member keyword field with a Yes/No or True/False value, you must 
enter a corresponding description. For example, if "Yes" describes a school member, then enter "School 
Member" in the Description field. This way, a keyword of "School Member: Yes" or "School Member: No" 
imports into your PDS Office program. The Description field is limited to 31 characters. 

Member Pictures — Make sure that the picture file is in the appropriate folder in order for it to display in 
your PDS Office program. We recommend that you store picture files in a shared folder, such as 
X:\PDSOffice\Pictures. 

 
Advanced Options  

 Tip 

If you don't have any data in your PDS Office program, you do not need to use Advanced Options.

 

When selected, the following advanced options display in the window: 

 Add to existing Remarks — Keeps any existing remarks, and adds any remarks from your import 
file. 

 Replace current remarks with this content — Removes any existing remarks, and adds the 
remarks from your import file. 

 Replace current remarks OR delete current remarks — If your import file contains remarks, they 
replace the existing remarks in the program. If your file doesn't contain remarks, the existing 
remarks in the program are deleted. 
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Importing Fund Information 
You can use the Import Fund Information process to import existing fund data from a .csv file into your 
PDS Office program. On the File menu, click Import Data > Import Fund Information. 

 
Fig. 10‐11. 

Before You Begin 

 Be Careful 

You must set up the fund, fund periods, and fund activities in your PDS Office program before importing 
this information. If the fund isn't set up, the information won't import into the program. 

To use this process, you must first import your family and member data. For more information, 
see Importing Family Information and Importing Member Information. 

Before you import fund information, make sure your file contains a value that connects the fund 
information to the family or member. This is the value you selected during the Family and Member Import 
processes for the Family/Member Key or ID Number fields. 

 Useful Information 

When importing pledge information, only the total pledge (mapped to an activity with a Charge function) 
is imported. To import terms and rates, use the Import Pledge Information process. 
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We recommend that you import the records in each .csv file to a single fund. However, if this isn't 
possible, you can run the process multiple times using the same .csv file, but select a different fund each 
time you run the process. If you run the process multiple times, the records that don't match the activities 
in the selected fund are not posted. This information is recorded in the Pre‐Import and Import logs. 

 Be Careful 

Never run the import process more than once for the same fund. Otherwise, duplicate records are posted. 

 

How This Process Works 

Once you identify the .csv file, you will match the values in that file with your PDS Office program fields. 
There are a few required fields, but other than that, you only have to enter information for the data you 
want to import into your program. 

No data is imported until you click Begin Import on the final tab. Your selections are automatically saved 
on each tab, so you can come back to this process at another time if needed. 

To import fund data  

1. On the File menu, click Import Data > Import Fund Information. 
2. The backup dialog box displays if you haven't performed a daily backup. To make a backup, click 

Yes. 

 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

3. The Create Fund Records dialog box displays. On the File Information tab, click Browse to locate 
the .csv file. After you select a file and click Open, your data displays in the window. 

 Useful Information 

We strongly recommend that you include field names/headers so it's easier to select the 
corresponding value from the drop‐down lists on other tabs. 

4. On each tab, select the appropriate values from the drop‐down lists. For more information about 
the fields on these tabs, refer to the Additional Field Information sections below. 

5. On the final tab, before you import the data, click Pre‐Import Data Check. This creates a file 
called "PreImportContribErrors.csv" in your program's data folder. 

6. Scroll through the items you're going to import to see if you need to make any adjustments. 
7. When you're ready to import the data into your PDS Office program, click Begin Import. 
8. Once the import is complete, a summary displays. This creates a file named "ContribErrors.csv" in 

your program's data folder. 
9. When you're done, click Finish. 
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Additional Field Information  
Additional field information is listed in the tabs below. Most fields are self‐explanatory, so not all fields 
are documented. 

Key/ID Number 

Use this Key from Import File — This value connects the contribution to the family or member. For 
Where is the Import Key in PDS?, select an option to match this key to the corresponding value in your 
program: 

 Family/Member ID Number — Match contributions to family or member records using the PDS 
Family or Member ID Number. 

 Family 2nd ID Number — If you have 2nd ID numbers set up in your PDS Office program, match 
contributions to family records using this value. 

 Family Unique Identifier — Match contributions to family records using the unique, internal 
number Fam Unique ID assigned to each family by the program. If you select this option, you 
must use an export report with the Family Unique ID field as your import file. 

 Family Key — Match contributions to family records using the value you selected as the Family 
Key. 

 Member Unique Identifier — Match contributions to member records using the unique, internal 
number Mem Unique ID assigned to each member by the program. If you select this option, you 
must use an export report with the Member Unique ID field as your import file. 

 Member Key — Match contributions to member records using the value you selected as the 
Member Key. 

Assign contribution to member — If you selected to match the key to the PDS Member Key or to the 
Member Unique Identifier, you can associate the contribution to a specific family member. 

Contribution Details 

Transaction Date — Only dates formatted as MM/DD/YYYY in your file are recognized. 

Activity Name — The selected fund's activity name must already be set up in your PDS Office program in 
order for this information to import correctly. 

Batch — You can select whether to import the batch number from your file or to automatically assign the 
next available batch number in the program. 
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Importing Sacrament Information 
You can use the Import Sacrament Information process to import existing sacrament data from a .csv file 
into your PDS Office program. On the File menu, click Import Data > Import Sacrament Information. 

 
Fig. 10‐12. 

Before You Begin 

In order to use this process, you must first import your family and member data. For more information, 
see Importing Family Information and Importing Member Information. 

Before you import sacrament information, make sure your file contains a value that connects the 
sacrament information to the member. This is the value you selected during the Member Import process 
for the Member Key field. 

You can import sacrament information from more than one .csv file. 

How This Process Works 

Once you identify the .csv file, you will match the values in that file with your PDS Office program fields. 
There are a few required fields, but other than that, you only have to enter information for the data you 
want to import into your program. 

No data is imported until you click Begin Import on the final tab. Your selections are automatically saved 
on each tab, so you can come back to this process at another time if needed. 

To import sacrament data  

1. On the File menu, click Import Data > Import Sacrament Information. 
2. The backup dialog box displays if you haven't performed a daily backup. To make a backup, click 

Yes. 
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 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

3. The Add Sacramental Date Info dialog box displays. On the File Information tab, click Browse to 
locate the .csv file. After you select a file and click Open, your data displays in the window. 

 Useful Information 

We strongly recommend that you include field names/headers so it's easier to select the 
corresponding value from the drop‐down lists on other tabs. 

4. On the Keys/Birth Info tab, select the corresponding values. For more information about the tabs 
in this window, see the Additional Field Information sections below. 

5. Each Sac tab represents a different sacrament. On each tab, select a sacrament and its 
appropriate values. 

6. On the final tab, before you import the data, click Pre‐Import Data Check. This creates a file 
called "PreImportSacImportReport.txt" in your program's data folder. 

7. Scroll through the items you're going to import to see if you need to make any adjustments. 
8. When you're ready to import the data into your PDS Office program, click Begin Import. 
9. Once the import is complete, a summary displays. This creates a file named 

"SacImportReport.txt" in your program's data folder. 
10. When you're done, click Finish. 

Additional Field Information  
Additional field information is listed in the tabs below. Most fields are self‐explanatory, so not all fields 
are documented. 

Keys/Birth Info 

Use this Key from Import File — This value connects the sacrament information to the student. For 
Where is the Import Key in PDS?, select an option to match this key to the corresponding value in your 
program: 

 Student ID Number — Match sacraments to student records using the PDS Student ID Number. 

 Student Key — Match sacraments to student records using the value you selected as the Student 
Key. 

 Student Unique Identifier — Match sacraments to student records using the unique, internal 
number Student Unique ID assigned to each student by the program. If you select this option, 
you must use an export report with the Student Unique ID field as your import file. 

Default Area Code — Enter a default area code for any imported records that don't contain the area code 
information. 

Birth Information — Select Overwrite if already present if you're updating the existing sacramental 
records in your PDS Office program. Any existing data is removed. 

Sacrament Information — If you select to overwrite sacrament information if it is already present in your 
PDS Office program, any existing data is removed. 

   



10 - 22  Importing Data PDS Formation Office Training Manual
 

Sac tabs 
On each Sac tab, select a sacrament and enter information about it. 

Sacrament — The items in this drop‐down list are from your Sacrament Date Names keyword list. To add 
or edit keywords, on the File menu, click Keywords > Student/Parent/Guardian Keywords > Sacrament 
Date Names. 

Prof. of Faith, Verified, and Cert. on File — For these fields, only Yes/No or True/False values in your file 
are recognized. The Prof. of Faith field only displays if you select Baptism as the sacrament. 

Date/Date of Prof — Only dates formatted as MM/DD/YYYY in your file are recognized. The Date of Prof 
field only displays if you select Baptism as the sacrament. 

Extra Info — This value represents the sacramental name. For Baptism, this is the baptismal name, for 
Confirmation, this is the confirmation name, and for Marriage, this is the spouse's name. 

Importing Member Ministry Information 
You can use the Import Member Ministry Information process to import existing member ministry data 
from a .csv file into your PDS Office program. On the File menu, click Import Data > Import Member 
Ministry Information. 

 
Fig. 10‐13. 

Before You Begin 

In order to use this process, you must first import your member data. For more information, see 
Importing Member Information. 

After you import member data, you can import member ministry data. When you imported your member 
information, you assigned a value to the Member Key field. This value represents the field in your 
previous program that differentiated between member records. For example, if your previous program 
had a field called "Member Number" that assigned a unique number to each member record, this is the 
value you selected as the Member Key. 
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Each member ministry record must contain the same Member Key value. This links the member ministry 
information with the appropriate member record that you've already imported to your PDS Office 
program. Each record must also have a unique Member Key value that represents the field in your 
previous program that identified each member record. For example, if your previous program had a field 
called "Member ID" that assigned a unique number to each member record, this is the value you should 
select as the member key. 

How This Process Works 

Once you identify the .csv file, you will match the values in that file with your PDS Office program fields. 
There are a few required fields, but other than that, you only have to enter information for the data you 
want to import into your program. 

No data is imported until you click Begin Import on the final tab. Your selections are automatically saved 
on each tab, so you can come back to this process at another time if needed. 

To import ministry data  

1. On the File menu, click Import Data > Import Member Ministry Information. 
2. The backup dialog box displays if you haven't performed a daily backup. To make a backup, click 

Yes. 

 
 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

3. The Import Ministry Information dialog box displays. On the File Information tab, click Browse to 
locate the .csv file. After you select a file and click Open, your data displays in the window. 

 Useful Information 

We strongly recommend that you include field names/headers so it's easier to select the 
corresponding value from the drop‐down lists on other tabs.  

4. On the Keys/Ministry Data tab, select the appropriate values. For more information about the 
fields on this tab, refer to the Additional Field Information section below. 

5. On the final tab, before you import the data, click Pre‐Import Data Check. This creates a file 
called "PreImportMemReport.txt" in your program's data folder. 

6. Scroll through the items you're going to import to see if you need to make any adjustments. 
7. When you're ready to import the data into your PDS Office program, click Begin Import. 
8. Once the import is complete, a summary displays. This creates a file named 

"MemImportReport.txt" in your program's data folder. 
9. When you're done, click Finish. 
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Additional Field Information  
Additional field information is listed in the tabs below. Most fields are self‐explanatory, so not all fields 
are documented. 

Keys/Ministry Data 

Member Key — This value connects the ministry information to the member. For Where is the Import 
Key in PDS?, select an option to match this key to the corresponding value in your program: 

 Member ID Number — Match ministries to member records using the PDS Member ID Number. 

 Member Key — Match ministries to member records using the value you selected as the 
Member Key. 

 Member Unique Identifier — Match ministries to member records using the unique, internal 
number Mem Unique ID assigned to each member by the program. If you select this option, you 
must use an export report with the Member Unique ID field as your import file. 

Start Date and End Date — Only dates formatted as MM/DD/YYYY in your file are recognized. 

Importing Pledge Information 
You can use the Import Pledge Information process to import existing pledge data (including terms and 
rates) from a .csv file into your PDS Office program. On the File menu, click Import Data > Import Pledge 
Information. 

 
Fig. 10‐14. 

Before You Begin 

 Be Careful 

You must set up the associated fund, fund periods, and fund activities in your PDS Office program before 
importing pledge information. If funds aren't set up, the pledges won't import into the program. 

 



PDS Formation Office Training Manual Importing Data  10 - 25 
 

To use this process, you must first import your family and member data. For more information, see 
Importing Family Information and Importing Member Information. 

Before you import pledge information, make sure your file contains a value that connects the pledge 
information to the family or member. This is the value you selected during the Family and Member Import 
processes for the Family/Member Key or ID Number fields. 

We recommend that you import the records in each .csv file to a single fund. However, if this isn't 
possible, you can run the process multiple times using the same .csv file, but select a different fund each 
time you run the process. If you run the process multiple times, the records that don't match the activities 
in the selected fund are not posted. This information is recorded in the Pre‐Import and Import logs. 

 Be Careful 

Never run the import process more than once for the same fund. Otherwise, duplicate records are posted. 

 

How This Process Works 

Once you identify the .csv file, you will match the values in that file with your PDS Office program fields. 
There are a few required fields, but other than that, you only have to enter information for the data you 
want to import into your program. 

No data is imported until you click Begin Import on the final tab. Your selections are automatically saved 
on each tab, so you can come back to this process at another time if needed. 

To import pledge data  

1. On the File menu, click Import Data > Import Pledge Information. 
2. The backup dialog box displays if you haven't performed a daily backup. To make a backup, click 

Yes. 

 
 Important Note 

This process alters data. We recommend backing up your data before proceeding. 

3. The Create Pledge Records dialog box displays. On the File Info tab, click Browse to locate the 
.csv file. After you select a file and click Open, your data displays in the window. 

 Useful Information 

We strongly recommend that you include file names/headers so it's easier to select the 
corresponding value from the drop‐down lists on other tabs. 

4. On each tab, select the appropriate values from the drop‐down lists. For more information about 
the fields on these tabs, refer to the Additional Field Information sections below. 

5. On the final tab, before you import the data, click Pre‐Import Data Check. This creates a file 
called "PreImportPledgeReport.txt" in your program's data folder. 

6. Scroll through the items you're going to import to see if you need to make any adjustments. 
7. When you're ready to import the data into your PDS Office program, click Begin Import. 
8. Once the import is complete, a summary displays. This creates a file named 

"PledgeImportReport.txt" in your program's data folder. 
9. When you're done, click Finish. 
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Additional Field Information  
Additional field information is listed in the tabs below. Most fields are self‐explanatory, so not all fields 
are documented. 

Key/ID Number 

Use this Key from Import File — This value connects the pledge information to the family or member. For 
Where is the Import Key in PDS?, select an option to match this key to the corresponding value in your 
program: 

 Family/Member ID Number — Match pledges to family or member records using the PDS Family 
or Member ID Number. 

 Family 2nd ID Number — If you have 2nd ID numbers set up in your PDS Office program, match 
pledges to family records using this value. 

 Family Unique Identifier — Match pledges to family records using the unique, internal number 
Fam Unique ID assigned to each family by the program. If you select this option, you must use an 
export report with the Family Unique ID field as your import file. 

 Family Key — Match pledges to family records using the value you selected as the Family Key. 

 Member Unique Identifier — Match pledges to member records using the unique, internal 
number Mem Unique ID assigned to each member by the program. If you select this option, you 
must use an export report with the Member Unique ID field as your import file. 

 Member Key — Match pledges to member records using the value you selected as the Member 
Key. 

Assign Pledge to Member— If you selected to match the key to the PDS Member Key or to the Member 
Unique Identifier, you can associate the pledge to a specific family member. 

Fund Number to Post Pledges — The fund must already be set up in your PDS Office program in order for 
this information to import correctly. 

Pledge Details 

Begin Date and End Date — Only dates formatted as MM/DD/YYYY in your file are recognized. 

Batch — You can select whether to import the batch number from your file or to automatically assign the 
next available batch number in the program. 

Batch Date — You can select whether to import the batch date from your file or to assign the batch date. 
If you select to assign a batch date, it defaults to today's date, but you can change it. 

Creating an Export File 
If you want to use the Family/Member/Student Unique ID options in any of the import processes, you 
must first create an export report with one or more of these fields. You can then use this export report as 
your import file during the import processes. 

To create an export report with Family and/or Member Unique IDs  

1. On the Report tab, click All Reports, and click Add. 
2. Click Export to create an export report. 
3. In the List of Fields to Print window, select the fields you want to include, and click the right 

arrow to add them to your export:  

 If you want to include families, select Fam > Fam ‐ Detail > Unique ID. 
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 If you want to include members, select Mem > Mem ‐ Detail > Unique ID. 

4. Select and add any additional fields you want to include in the export. 
5. Click Save/Ok. 
6. Click Next, and select the export options you want. 

 Useful Information 

The Import processes require a CSV file format. 

7. Click Next, and select who you want to include. 
8. When you're ready, click Build. 

To create an export report with Student Unique IDs  

1. On the Report tab, click Student Reports, and click Add. 
2. Click Export to create an export report. 
3. In the List of Fields to Print window, select Student > Student ‐ Detail > Unique ID, and click the 

right arrow to add it to your export. 
4. If you want to include families, select and add Fam > Fam ‐ Detail > Unique ID. 
5. Select and add any additional fields you want to include in the export. 
6. Click Save/Ok. 
7. Click Next, and select the export options you want. 

 Useful Information 

The Import processes require a CSV file format. 

8. Click Next, and select who you want to include. 
9. When you're ready, click Build. 

 

After you create the report, you can use the Unique ID options during any of the import processes. When 
you run the import processes, make sure to use the location where this report is saved for the import file 
path on the File Information tab. 

   



10 - 28  Importing Data PDS Formation Office Training Manual
 

(This page was intentionally left blank.) 
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11: Reports 
 

You can access reports from different locations in the program. In the navigation pane of the major 
program areas, you'll see the link to Reports. The program displays the available reports for the area of 
the program you are currently in. To see all available reports, select All Reports. 

 
Fig. 11‐1. 
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All reports can also be easily accessed from the Reports tab on the ribbon. 

 
Fig. 11‐2. 

In the Select Report window, you begin the process of selecting and printing reports. Below is a brief 
outline of the report process. 

1. Select the report — In the first window, there is a list of all available reports. To expand report 
sections, click the triangles. Or, to view a list of all available reports, click Open All. To select a 
report, click it and click Next. 

2. Review the report overview — In the Overview window, the program recaps the report settings. 
If everything looks okay, you can proceed straight to Preview Report or Print Report. If you want 
to change report settings and/or use the selection options, click Next and proceed through the 
report wizard. 

3. Select the printer — In the Select Printer window, select which printer to use, the paper style, 
and orientation. 

4. Select the report layout — In the Layout window, select layout options, such as the type of print 
(normal print, compressed print, etc.), the margin settings, and the various parts of a letter, label, 
envelope, etc. These options depend on the type of report you're printing. 

 Useful Information 
Some reports are called "Easy Reports." You create Easy Reports when you add new reports or 
make copies of existing ones. You can modify the content of these reports. When a report is 
modifiable, a button displays in this window. 

5. Select the program data you want to print and the order to print it — In the Selection window, 
enter the criteria you want the program to use to determine which records print. This is called 
the "Selection Information". 

6. Preview and print the report. 
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Following are some sample windows in the report wizard. To return to previous windows and make 
changes, click Back. 

Selecting the Report 
First, you must select WHICH report you want to print. 

 
Fig. 11‐3. 

 Useful Information 
If you're an administrator, you can set report and report selection access for each user under 
Administration > Users & Passwords. 

 

To expand a section of reports, click the corresponding triangle. To view all available reports, click Open 
All. To collapse all reports to just the basic categories, click Close All. 

To add a user‐defined report, click Add. To make a modifiable copy of a pre‐defined report, select the 
report, then click Copy. To remove a report you copied or added, select the report, then click Delete. 

When adding a new report or making a copy of an existing report, you have ownership of that report and 
can specify if only you and the administrator have access, if you want to share it but not allow anyone to 
modify it, or if everyone should have access to print and modify the report. 

If other users have created reports and those reports were set so you can print and/or modify them, in 
the Select Report window, all reports that you have access to will display by default. However, if you want 
to filter the list of reports so that only reports you created are available, select Show Only My Reports. 

To view a sample of the selected report, click the thumbnail picture. This image is typically a one‐page 
example that uses sample data and default settings. 
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Copied or added reports have two additional buttons: Adv. Script and Save as Custom Report. To view 
the UDR, INI, and Pascal files associated with a user‐defined report, click Adv. Script. To save your user‐
defined reports to a disk, click Save as Custom Report. 

Once you have selected your report, click Next to continue. 

Reviewing the Overview 
In the Overview window, you can view the basic settings for the selected report. 

 
Fig. 11‐4. 

To jump directly to any of these settings, click the links in the middle of the window. Then to return, click 
Back to Overview. Most report settings are retained from the last time you ran the selected report. If 
everything looks okay in this window, you can proceed directly to Preview Report or Print Report. 

To change the name or description of this report, click Edit. You can only rename reports you have added 
or copied, so you cannot edit a predefined report name. You can always edit the report description. 

To print all of the settings in this window, click Print Detailed Overview. This makes a handy cover page 
for some reports. 

To review and change all report settings in typical wizard fashion, click the Back and Next buttons. 

   



PDS Formation Office Reports  11 - 5 
 

Selecting the Printer 
Next, you must indicate WHERE the report will print. In the Select Printer window, you can select the 
printer to use, the paper size, and the paper source. You can also switch the page orientation from 
portrait to landscape mode, which is helpful if you have a report with many columns. 

 
Fig. 11‐5. 

To change the printer‐driver controlled properties of the selected printer, click Properties. The options 
available in the Size and Source drop‐down lists depend on the selected printer. For example, an Inkjet 
printer may only have one or two tray sources, whereas a Xerox copier may have multiple tray sources, 
such as tray 1, tray 2, tray 3, High Capacity tray, Bypass tray, etc. 

Once you have made your selections, click Next to continue. 

Selecting the Report Layout 
The third step is to indicate HOW the report will print. 

The Layout window controls the report layout. Each type of report has different layout features. For 
example, a listing report has options for the page settings, margin settings, and fields to print. A letter 
report has options for letterhead, margins, inside address and closing settings, and the text of the letter 
itself. 

 
Fig. 11‐6. 

Once you have made your style selections, click Next. Remember, you can preview before you print the 
report. If you want to change the style, you can click Back to return to this window. 
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About Styles 
Report settings are controlled by styles. A style is a named collection of related formatting elements. To 
add new styles or modify existing styles, in the report layout window, click Edit Style. For example, the 
left, right, top, and bottom margin settings are part of a margin style. A margin style called "Letter" might 
have a ½‐inch top and bottom margin, and a 1‐inch left and right margin. To utilize the largest possible 
print area, select the special margin style called Smallest Margins. You can have an unlimited number of 
styles for each report type. 

 
Fig. 11‐7. 

Text of a Letter 
If you are printing a letter report, you can modify the text of the letter. In the report layout window, click 
Modify the Body of the Letter. 

You can modify the text of a predefined letter; however, it is not recommended. Instead, create a copy 
and modify it to ensure that future upgrades do not overwrite your changes. If you do make changes to a 
predefined letter and you want the original letter back, click Reload Default Text. 

 
Fig. 11‐8. 

The letter editor is similar to other word processors. You can change fonts, insert tabs, images, and 
bulleted lists; center, left or right justify text; and perform spell‐check.  
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Inserting Fields  
You can insert fields, lists, and other elements into your letters, labels, envelope, and form reports. When 
you insert field names or list names into a report, they are framed or bracketed by < and >. For example, 
<Fam Name> prints the name of the family, <Fam Address Block> prints the family's complete address, 
and <Fam Phone List> prints a list of the family's phone numbers. 

To insert data fields into your reports, in the text editor, position your cursor where you want to insert a 
field, and click Insert Field. 

 
Fig. 11‐9. 

On the left side of the Fields dialog box are categories of available fields. Click the triangle to display the 
list of fields within that category. If you are unsure which fields to insert, you can right‐click a field to 
display pop‐up help with a brief description of that field. Or you can select the field to display the 
description information and some additional options for how to print the inserted field (e.g. you may 
want the field to print in all upper case). 

Some special fields are available only in letters and print your organization’s information as it is entered in 
the License Information dialog box. To add or update the appropriate values for your parish, on the File 
menu, click Setup > License Information. 

By inserting these fields, you don't have to type your contact information in your reports. Also, if your 
contact information changes, you can edit the information in the License Information dialog box instead 
of changing the information on all of your letters. 
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Indenting Fields 
Be careful when indenting fields that may contain multiple lines of text. The following are ways to indent 
text so that it displays further right than the normal left hand margin: 

 Extra spaces 

 Tabs 

 Paragraph indents 

Let's demonstrate why using spaces and tabs do not work well for some situations. Look at the example 
labels below. In editor, we have turned on the formatting so we can see the spaces, tabs, and paragraph 
marks (which are usually invisible). To do this, click View > Show Formatting Marks. 

Example 1 ‐ No indenting 

 
Fig. 11‐10. 

Notice how the text is right up to the edge of the label. There is not much room for error here if the 
printer skews the page. 

 
Fig. 11‐11. 
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Example 2 ‐ Indenting with extra spaces 

 
Fig. 11‐12. 

The mailing name and the first line of the address seem to indent okay, but the Address Block is a multi‐
line field that may contain two or three lines of text. Using the editor, you can only enter extra spaces on 
the first line. When the program adds the additional lines of the address, they will not be indented, which 
does not look nice when printed. 

 
Fig. 11‐13. 

Example 3 ‐ Indenting with tabs 

 
Fig. 11‐14. 
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This presents the same issue as adding extra spaces. 

 
Fig. 11‐15. 

Example 4 ‐ Using paragraph indents 

 
Fig. 11‐16. 

In this example, we added a blank line at the top to move the text down from the margin. Then, we 
inserted paragraph indents by selecting all fields and dragging the paragraph indent control away from 
the left margin (it is easiest to drag the bottom of the rectangle). Now, we have perfect indents. 

 
Fig. 11‐17. 

Manually indenting (using spaces or tabs) affects all multi‐line fields, not just the Address Block. The same 
issue applies to the Remarks field. Any field where you can enter multiple lines of text is affected when 
you manually indent. When you want to indent fields, make sure you use paragraph indents (example 4 
above) instead of extra spaces or tabs. 
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Multiple Languages 
You can set up the text of so that information prints in different languages. All it takes is the use of the 
proper inserted characters and typing the text in the language you want to use. 

The program does not translate letters into different languages, but you can enter different versions of 
the letter in the same report so that the correct letter will print for each family. In other words, when you 
send letters to multiple families, you can have the program print a letter in English, Spanish, or other 
languages for the appropriate families by running just one report. 

Keep the following requirements in mind when you use this feature: 

 If you are sending letters to families, you must select the Language of each family on the head of 
household member’s Personal window. 

 If you are sending letters to individuals, you must select the Language you intend to use in the 
letter in the individual's Personal window. 

 If you use the concept of main language/secondary language (e.g. English/Spanish, 
Spanish/English), make sure the language you want to use in the letters is listed first. 

 You must spell the name of the language exactly the same in each combination. For example, 
"English/Spanish" and "English/German", NOT "Eng./Span." and "English/Ger". 

To set up multiple language letters, type the letter in both languages, and enter <Language: name> at the 
beginning of that part of the letter. You can also use Insert Other and select Language/End ‐ Spanish 
Sample to quickly enter the full language command. 

 
Fig. 11‐18. 

 
Fig. 11‐19. 
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The first introduction tells the program to print what follows if the Language field equals Spanish: 

<Language: Spanish> Esta es una cara de muestra escrita en Espanol. 

If the Language field equals English, print the following: 

<Language: English> This is a sample letter written in English. <End> 

<End> tells the program to continue to the next family. 

You can use multiple languages in Closing and Inside Address/Salutation styles. For example: 

In Closing Style: 

<Language: Spanish> Sinceramente, Sr. Robert Jones Administrador de Oficinas 

<Language: English> Sincerely, Mr. Robert Jones Office Administrator 

<End> 

In Inside Address Style: 

<Fam Mailing Name> <Fam Address Block> 

<Language: Spanish> Estimados <Fam Formal Sal>, 

<Language: Hawaiian> Aloha <Fam Formal Sal>, 

<Language: German> Gutentag <Fam Formal Sal>, 

<Language: English> Dear <Fam Formal Sal>, 

<End> 

You can also use <Language: Other> to print a section for any languages other than those with a specific 
<Language: name> command. For example: 

<Language: Spanish> Gracias! 

<Language: Other> Thank You! 

<End> 

If the language has different phrases or words depending on gender, as in Spanish, you can specify the 
gender in parentheses. In Spanish, "Estimado" means "Dear". 

<Language: Spanish (Male)> Estimado <Mem Mailing Name>, 

<Language: Spanish (Female)> Estimada <Mem Mailing Name>, 
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Selecting the Funds to Print 
In financial reports, you must select WHICH funds to print and WHICH date range to print for the funds. 
You can select anything from a single day to the full date range of the fund. You can run most financial 
reports for more than one fund at a time. 

 
Fig. 11‐20. 

You can select to print pledge or tuition overpayments as Zero or as the Actual Amount Overpaid. For 
example, if tuition is $1,000 for the year, and the family paid $1,200, you can select for the report to show 
the balance as $0, or as negative $200 which is the actual amount. 

You can select how each group of activities in each fund prints: 

 Use in Monthly Breakdown and Recap — Prints how much was given or due each month. 

 Group Totals Only ‐ No Itemization — Prints the total for the group without breaking down the 
details of the activities. 

 Itemize Each Activity in the Group — Prints the totals for each activity in the group. 

 Don't Include Group in the Report — Select this option if you do not want to print the group or 
include its activities in the totals. 

 Include Group in Report — Select this option to include the totals from this group in the fund 
total. 
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Selecting the Information to Print 
The next step is to indicate WHICH data you want to print. 

When you print reports, you must sift through all of the program data and find records that meet certain 
conditions. For example, if you want to send a letter to specific individuals, you must define a "selection" 
for those individuals. 

In this window, you select which records you want to print. You can select them based on conditions or 
criteria, or you can select individual records from a list. 

 
Fig. 11‐21. 

Use the tabs to select either by checklist or criteria conditions. If you create a set of selection criteria that 
you will use over and over again, you can save the selection under List of Selections. 

To create a new report selection  

1. In the List of Selections pane, click Add. 

2. Give the new selection a Name and Description. 

3. In the Sort Order drop‐down list, select how you want to sort the report information. 

 Useful Information 
The right side of the window controls how the report is sorted and what information is printed. 
Different reports have different options. 

4. Specify, on the various tabs, any other criteria to be used. Different reports have different tabs. 

5. Click Save. 

When adding a report selection, you have ownership of that selection, and you can set selection access as 
one of the following: 

 Public – Other users can view and modify your report/selection. 

 Shared – Other users can view but not modify your report/selection. 

 Private – Only the owner can view and modify the report/selection. 
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To designate access to your report selections  

1. Select the report you want. 

2. In the Selection window, add your own report selection or copy existing selection. 

3. On the Selection Information tab, select an owner and the selection access option you want. 

To use a one‐time selection without saving it, in the List of Selections, use Simple Selection ‐ Never 
Saved. This item always appears first in the list. If you entered some selections and then decide you want 
to save them, click Save, and enter a name and description. 

Family or Individual Selections 
The Family Selections tab is used to select families to include in a report. It is available with family and 
financial reports, but not student, parent, class schedule, or personnel reports. Other types of reports will 
have selection tabs that can be used to select the students, parents/guardians, class schedules, or 
personnel in specific ways. 

 
Fig. 11‐22. 

 Include All Families — Run the report for all families in the data. 

 Include Families with ID/Envelope Numbers — Run the report for specific IDs or a range of IDs. 
Use a colon (:) to indicate a range. Separate ranges with commas. For example, "1, 5:10, 100:999, 
1500". 

 Include ANY of the following families — Include specific families. Select the families in the list. 
To quickly clear your selections, click Clear All. 

 At the top of the tab, click a letter to jump to that place in the list. 

 Quick Lookup — Click to quickly locate a specific record in the list. 
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Additional Selections 
Use the Additional Selections tab to create a specific set of criteria for a report. The fields and values 
available depend on the type of report you run. You can use the selections on this tab to filter your list of 
report criteria to a very specific level, for example: 

 All families living in a specific city, as shown in Fig. 11‐23. 

 Any members with a specific keyword, such as grade, talent, or ministry. 

 All families who have given over $1000.  

 All students in a certain class/session. 

 
Fig. 11‐23. 

When you click the small oval icon  , two options display: 

 Add Condition — Add a new field, relation, or value condition line. 

 Add Sub‐section — Add a new set of criteria to be considered as a group. Condition statements 
within the subsection will be evaluated, in order, before condition statements outside of the 
subsection. 

As conditions are added, a numbered button displays beside the statement. When you click this button, 
the following options display: 

 Delete Current Row — Remove the highlighted condition line. 

 Enable/Disable Row — Condition lines can be turned on and off without being deleted, which 
allows you to test conditions and combinations more quickly. Disabled rows are not considered 
when the report prints. Disabled rows are gray. 

 
Fig. 11‐24. 
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Each condition line relates to others of the same level in one of three ways: 

 All — Only items that are true for each condition in that section or subsection print on the 
report. This is the same as a logical AND. 

 Any — Items that are true for any of the conditions in that section or subsection are printed. This 
is the same as a logical OR. 

 None— If none of the conditions are true in that section or subsection, then the family/individual 
is printed. This is the same as a logical NOR. 

In the figure above (Fig. 11‐24), lines 1 and 2 fall under the All condition of the top line. Lines 2.1 and 2.2 
fall under the Any condition of the sub‐section. 

Condition Lines 

Each numbered line is a separate condition that is decided when the report prints. The lines have the 
general format of Field – Relationship – Value. 

<Click here to add new condition> — Click to add a new condition line with the same level as the one 
above it. 

 Field — Click the field hyperlink to view a list of fields pertaining to the type of report you selected. Click 
the triangle next to a group to see the fields within it. The fields you select determine the list of values you 
can select from. 

When creating a member report, if you click the first field, then expand the Mem list and select Is a 
Parent, your values would be limited to Yes or No. If, on the other hand you select Ethnicity, the list of 
possible values is much greater. The condition statement Mem.Is Parent is equal to Yes produces a list of 
all members who are parents. When building conditions, right‐click on the field name to view a pop‐up 
containing more detail about the field. 

Relationship — This is a logical (mathematical) operator, such as =, <, or >. 

 Is equal to — Field = Value. Example: Fam City is equal to Phoenix, AZ. 

 Is not equal to — Field ≠ Value. Example: Fam City is not equal to Phoenix, AZ. This relaƟonship is 
useful when you want everything other than a specific value. 

 Is less than — Field < Value. Example: Fam ID Number is less than 3000. 

 Is less than or equal to — Field ≤ Value. Example: Fam ID Number is less than or equal to 3000. 

 Greater than — Field > Value. Example: Fam ID Number is greater than 3000. 

 Greater than or equal to — Field ≥ Value. Example: Fam ID Number is greater than or equal to 
3000. 

 Is in list — The field is within a list of values. Each value must be in quotation marks and 
separated by commas. Example: Fam City is in list "Phoenix, AZ", "Glendale, AZ". 

 Is not in this list — The field is not within a list of values. Each value must be in quotation marks 
and separated by commas. Example: Fam City is not in this list "Florence, SC". 

 Starts with — The field has the same beginning character or characters as the value in question. 
Example: Fam Name starts with A. 

 Does not start with — The field has a different beginning character or characters than the value 
in question. Example: Fam Zip does not start with 85. 

 Contains — The field includes the value. Example: Fam E‐Mail contains "hotmail". This returns a 
list of all family email addresses that include the word "hotmail." 
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 Is not between — The field falls outside of two values. Example: Fam ID Number is not between 
300 and 800. 

 Is between — The field falls between two values. Example: Fam ID Number is between 300 and 
800. 

 Is ever equal to — The value in the field is equal to at least one of the fields entered. You could, 
for example, enter three conditions: Ministry is ever equal to Choir, Ministry is ever equal to 
Hospitality, and Ministry is ever equal to Baby Sitting. When you run the report, if Ministry is ever 
equal to Choir, Hospitality, or Baby Sitting, the member’s name is included in the report. 

 Is never equal to — The value in the field is not equal to one at least one of multiple fields 
entered. You could, for example, enter two conditions: Sac. Confirmation is never equal to Yes, 
and Sac. Confirmation is never equal to Approximate. When you run the report, if Sac. 
Confirmation is never equal to Yes or Approximate, the member’s name is included in the report. 

Value — This is a variable, or the value you use to test the field. Do not use dollar signs, commas, 
asterisks, or question marks. Examples could include: "Phoenix" or "Glendale". 

 If the relationship is "Is in list" or "Is not in list", enter the value in quotes and separate items 
with a comma. 

 If the field is a keyword or table field, such as "City", or a program‐controlled list, such as "Month 
of Birth", click the Value hyperlink to select a variable.  

To add report criteria 

1. In the Selection Information window, click the Additional Selections tab. 

2. To select a conditional relation, click the All hyperlink in the Choose records where All of the 
conditions in the following subsection are true statement. Insert conditions and subsections, if 
any. 

3. To add a new condition, click <Click here to add new condition>, or click   beside Choose 
records where All of the conditions in the following subsection are true. Then, select Add 
Condition or Add Subsection. 

4. To delete a condition or subsection, click the numbered oval   beside the condition statement, 
and then click Delete Current Row. 

5. When you're finished entering conditions, click Preview. 

6. If you plan to use this report criteria in the future, click Save to keep your selections. 

Clear Additional Selections — Click to remove all condition lines. 

Exclude rather than include selected records — Select this option to change the main condition phrase at 
the top of this window from Choose records... to Exclude records.... The program will then exclude all 
items that match the conditions given and print the rest. 

Use Optimizer — In most cases, to improve the speed that PDS searches for records matching the 
conditions you set, select Use Optimizer. 
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Selection Examples 
Here are some examples of additional selection that you can use to print particular types of reports. 

Example 1 

Select families who registered between May 1 and August 31. There are two ways you can do this: 

 
Fig. 11‐25. 

 
Fig. 11‐26. 

Example 2 

Select families with a Family Keyword Description of Jr. High/High School Fund Raiser or Picnic Planning 
Family. There are two ways you can do this: 

 
Fig. 11‐27. 

 
Fig. 11‐28. 

Example 3 

Print families whose ZIP code starts with "85." 

 
Fig. 11‐29. 
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Comparing Selection Abilities 
When is it better to use the family or individual selection tabs versus the Additional Selections tab? 

Use the family or individual selections tabs to specifically select a family or individual. When you use these 
tabs, reports run much faster because the program does not have to search the entire database to find 
the information you want to print. When possible, use these tabs. 

Use the Additional Selections tab to select families or individuals based on something other than their 
name or ID. Additional selections are more powerful and flexible; however, reports run slower because 
the program must search every record to find those that match the conditions. 

Previewing the Report 
Once you have selected the information to include in the report and the order you want it to print, click 
Preview. The Preview window displays how the report will look. 

 
Fig. 11‐30. 

In this window, "what you see is what you get." Examine the report for the following: 

 Margins — Are they set the way you intended? Sometimes, if you select Smallest Margins, the 
report prints very close to the edge of the page. You probably would not want this for a letter. 

 Styles — Make sure other styles, such as fonts, letterheads, closings, page numbers, and dates, 
are the way you intended. 

 Selections — If you used selections, make sure the report includes the information you intended. 
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To return to windows to make changes, click Back. To view the report better, click Zoom In, Zoom Out, 
Full Width, or Full Page. If your report is multiple pages, click Prior Page, Next Page, First Page, or Last 
Page. To go to a specific page of the report, in the Go to page field, enter the page number. 

When you are ready to print the report, click Print. 

Printing the Report 
When you're ready to print your report, you can click Print Report in any step within the report wizard. 

 
Fig. 11‐31. 

In this window, select to print all or only selected pages, and enter the number of copies. Once you have 
made your selections, click OK to send the document to the selected printer. 

Print to File 
You can send any report to a file so you have an electronic copy that you can save, forward, archive, etc. 
In the Print dialog box, select Print to File. 

In the Type drop‐down list, select the file type, and in the Where field, enter the location where you want 

to create the file. To select the location, click  . To open the file once it is created, select View the 
file. To open the folder of where the file is located once the file has been created, select Open Folder. To 
see more file options, select Show advanced dialog. Once you have made your selections, click OK to 
send the document to the selected file. 

 
Fig. 11‐32. 
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Sending Letters by Email 
You can send letters or statements by email instead of regular mail. 

Email addresses can be entered in multiple windows throughout the program. You can enter email 
addresses for your reference without sending letters and statements to them. However, to mark an email 
address so that email is sent instead of regular mail, enter the information in at least one of the following 
areas: 

 Family Primary Information — Enter the family's email address(es) in the Emails section in the 
Primary Information section of the Families window. Select Pref. if they prefer to receive email 
over regular mail. 

 
  Fig. 11‐33. 

 Members Information — Enter Individuals email address(es) in the Emails section on the 
Communication section of the Students, Parents & Guardians, and Personnel windows. Select 
Pref. if they prefer to receive email over regular mail. 

 Billing Address — You can send financial statements to people other than the family by adding 
contacts in the Billing Address section of the Tuition & Fees window. Enter the individuals email 
address in the Email section, select Send Email Over Mail, and indicate when to send statements 
to which address. 

 
  Fig. 11‐34. 

To send correspondence by email  

1. For each family, enter the email address in one of the locations listed above, and select Pref. or 
Send Email Over Mail. 

2. Select a report to print. 

3. When selecting the families or individuals to include, on the Selection Information tab, select 
Email the Letter if, and select either Preferred is Checked or Has an Email Addr. To send the 
letter/statement to all email addresses associated with the individual or family, select Send to 
Multiple Emails. 

    
 Fig. 11‐35. 
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 Useful Information 
If you select Has an Email Addr, the program sends the email even if Pref. is not selected in the 
Families window. 

If you're running a student or parent/guardian report, you can also select to send the letter to 
the family's email or only to the family’s email. 

4. Click Preview. The program builds a list of those who should receive regular mail and those who 
should receive email. 

5. When the build is complete, click OK to display the first letter or statement to be printed. Review 
the first few records for accuracy before you continue. 

 Useful Information 
This is only a preview, and the actual output may differ. Email previews don't display. 

6. Click Next, or close the preview window. The Sending the Email dialog box displays. 

7. Complete the information on the Email Message tab and the Email Server Setup tab. For more 
information on these tabs, see Sending the Emails section of this chapter. 

8. To begin transmitting your email messages, click Start Email. If there's an error connecting or 
trouble with any single transmission, you can print the record and create a letter or statement 
for regular mail. 

 Useful Information 
When printing mailing labels or envelopes to match a letter or statement, exclude those letters 
or statements that were sent by email. To do this, on the Selection Information tab for the label 
report, select Skip the Label/Envelope if Email. 
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Email Message 
The Email Message tab contains message information. 

 
Fig. 11‐36. 

From — Defaults to the name of your organization in the License window. You can edit this field. 

From Email Address — Defaults to your email address if you entered it in the License window. This is the 
email address that your recipients see when they receive the email. 

Reply Email Address — Defaults to your email address if you entered it in the License window. This is the 
email address that any recipient replies are sent to. This can be the same as the From Email Address, or it 
could go to the secretary's email, for example. 

Subject Line — Defaults to "Letter from <your organization name>." You can edit this field. 

Other File Attachments — Click Add File, and browse to the location of any file you want to send with the 
email. Click Clear Files to remove the attached files. 

Type of Email — You can send three types of email. Select an option based on your preferences. 

 Email as images — Send the text as an HTML email. This works with most email programs and 
keeps most of the format of the printed letters or statements. It doesn't require the recipient to 
have Adobe® Reader to view the image. 

 Email as Text — Send the text of the letter without using an attachment. The formatting of this 
email doesn't look exactly like the letters or statements you send out in the mail. Most notably, it 
doesn't include pictures or bitmaps, which means digital letterheads, logos, and signatures don't 
display. While this option can be received by most email programs, it produces a visually‐simple 
email. 

 Email with a PDF image of the document as an attachment — Send a brief note in an email with 
an attachment that can be viewed and printed with Adobe® Reader. This produces an email 
attachment that looks exactly like the letters or statements you printed. However, the recipient 
must have Adobe® Reader to view it. 
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o If you select to email the statement or letter as an attachment, click the Attachment 
Resolution drop‐down list to select the resolution. The resolution only affects images 
contained within the PDF. With a higher resolution, the images are clearer. However, 
the file size increases and takes more time and bandwidth to email. 

o The Email Body field defaults to a message with your organization name and explains 
that the attachment should be viewed with Adobe® Reader. It also includes a link to 
download the reader if the person does not already have it. You can edit this message. 

Preview — View the letter to be emailed. The email itself might look different depending on your email 
format settings. 

Start Email — Email the letters to all the selected families or individuals. 

Email Server Setup 
The Email Server Setup tab contains technical information for connecting to your email server. Obtain the 
required settings from your system administrator or Internet provider. 

   
Fig. 11‐37. 

Email Server (SMTP) — SMTP stands for Simple Mail Transfer Protocol. Obtain these settings from your 
Internet provider's website or system administrator. 

Email Server Port — The default setting is 25. However, you can obtain this setting from your Internet 
provider or system administrator. 

Server Requires Authentication — Select if your server requires authentication. Enter your email account 
name and password. Select Use TLS (Gmail) or Use SSL (AT&T) if either of those is your email server. 

Server Limits Emails — Some servers restrict the number or size of incoming and outgoing email 
messages. If your server does this, select this check box and enter the values. 
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If an Error Occurs, Delay 30 Seconds and Retry Once — Resend the emails after a 30‐second delay in the 
event of an email server error. 

Disconnect and Reconnect After Every Email — Select if you want your server to disconnect and 
reconnect after sending each email. 

Preview — View the letter to be emailed. The email itself might look different depending on your email 
format settings. 

Start Email — Email the letters to all the selected families or members. 

Logging Letters 
In the Letters, Visits, Etc. section of a family or individual's record, you can track correspondence. After 
you print a letter report, the program offers to log the letter correspondence in the Letters, Visits. Etc. 
section of the family or individual records. 

 
Fig. 11‐38. 

Enter a description of the letter and select one of the log options. The options in the drop‐down lists are 
keywords from the Letter Types keyword list. You can also enter an optional note. 

To automatically log the history of the letter correspondence, click Log the Letters/Labels. If you do not 
want to keep a record of this letter correspondence, click Don't Log the Letters/Labels. 

Creating a Custom Report 
The Select Report window has three command buttons labeled Add, Delete, and Copy. 

Before adding a new report or modifying an existing report, preview the existing reports to determine if 
there's one similar to what you need. It's much easier to modify an existing report than it is to create a 
new one.  

If you locate a report that's similar to what you need, click Copy to duplicate the original report and place 
it in the Easy Report sub‐list. The report name is preceded by "(COPY)," and then you can edit the report 
name. 



PDS Formation Office Reports  11 - 27 
 

 
Fig. 11‐39. 

To copy a report  

1. On the Reports tab, click the button related to the type of report you want. Click the triangle 
next to each group of reports to expand it and see the individual reports. 

 Useful Information 
You can also click Reports in the navigation pane of any major program area to access the list of 
reports related to the data in the current window. 

2. Select a report, and click Copy. The report is added to the appropriate Easy Reports section. 

3. Click Next. Edit the name and description to describe the purpose of the report. 

4. Select a report owner, and designate report access. 

5. Click Next and follow the report wizard to define and customize the report. 
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If you can't locate a report similar to what you need, click Add to create a new report and place it in the 
Easy Report sub‐list. The report name is preceded by "New <type> Report". Example: New List Report.  

 
Fig. 11‐40. 

To add an Easy Report  

 Useful Information 
We recommend outlining the information you want on the new report and making notes about the 
formatting of the new report before adding it. This gives you something to work from when adding your 
new report. Select a major category where the report will reside. 

1. On the Reports tab, click the button related to the type of report you want. Click the triangle next 
to each group of reports to expand it and see the individual reports.  

 Useful Information 
You can also click Reports in the navigation pane of any major program area to access the list of 
reports related to the data in the current window. 

2. Under the appropriate reports section, click any report name, then click Add. The Add Report 
dialog box displays. 

3. On the Simple Reports tab, click the type of report you want to create. The new report is added 
to Easy Reports section within the report group you selected. 

4. For some reports (list and export reports, for example), the List of Fields to Print dialog box 
displays. Define which fields you want to include in your report. For other reports (letter, label, 
and envelope, for example), the Editing window displays, and you can define the content of your 
correspondence. 

5. Edit the name and description of the report. Select a report owner, and designate report access. 

6. Save your changes, and follow the remainder of the report wizard to define your report. 
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 Useful Information 
The Add Report dialog box also includes the Advanced Reports tab and the buttons Report, 
Letter, or Label. This requires that you use the Advanced Report Writer to create a report. 

We don't provide support for the Advanced Report Writer; however, for an electronic copy of the 
ARW user guide, on the File menu, click User Guides > Advanced Report Guide. 

 

You can save Easy Reports to a reusable storage device or hard drive to protect your information against 
loss. You can also install your Easy Reports on other computers in your office or share them with other 
organizations using PDS.  

To save an Easy Report  

1. Add or modify a report. For more information on creating easy reports, see Creating a Custom 
Report. 

2. In the Select Report window, select the report that you created. 

3. Click Save as Custom Report. 

4. In the Save Custom Report Files dialog box, find the location where you want to save the report. 
Enter a file name, and click Save. 

 

Five file types can be associated with an Easy Report, but some only exist with certain types of reports. 
You can create files with the following extensions: .udr, .cr, .rtf, .ini, and .rtm.  

 The .cr file is only saved as a custom report. The .cr file is the primary file and the only file that 
displays. 

 The .ini file contains settings from the last time you ran the report. It doesn't exist until you run 
the report again. 

 The .udr file contains default information. 

 The .rtf file is only used when you use the letter editor or label. 

 The .rtm file only exists for Advanced Reports.  

 

You can install Easy Reports written by other PDS users in your organization. 

To install an Easy Report  

1. In the Select Report window, click Add. 

2. In the Add Report dialog box, click Custom Report. The Browse dialog box displays. 

3. In the Look In drop‐down list, select the appropriate storage drive. A list of custom reports 
displays. 

4. Select the file name you want to add, and click Open. The report is added in its proper category. 
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Reordering User‐Defined Reports 
After you create several Easy Reports, you can reorder them in the Select Report window. You can also 
create new subgroups to use for further organization of your reports.  

 
Fig. 11‐41. 

In the Select Report window, click Reorder User Reports. 

 
Fig. 11‐42. 

This dialog box only displays user‐defined reports created in the selected report category. Use the arrows 
to move the selected report up or down in the list, or click and drag a report with your mouse. 

To add a section to organize the reports in this list, click Add a Section Name. In the Current Section 
Name field, enter the name of the new section. Use the arrows to move the section up or down in the list. 
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In the example below, a new section was created entitled "My Correspondence" and the arrows were 
used to move three reports into the new section. 

 
Fig. 11‐43. 

The next example displays the list in the Select Report window after the reports are reordered. Keep in 
mind that each time you create a new report, it is added to the bottom of the last section. You may want 
to reorder each new report after it is created. 

 
Fig. 11‐44.  
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Modifying the List of Fields to Print 
To create a new list report, in the Select Report window, select the report category where you want to 
add the report, then click Add > List. The List of Fields to Print dialog box displays. 

 
Fig. 11‐45. 

Or, if you have a list report that you like and want to modify it, select the report and click Copy. In the 
Overview window, click one of the layout links or click Next until you reach the Layout window. In the 
Layout window, click Modify the List of Fields to Print. 

Select the fields as you would in a listing screen. Each selected field begins a new column. 

   
Fig. 11‐46. 

In the Position drop‐down list, select where you want to place the field. Choices are New Column, Same 
Column but on a New Line, or Same Column and on the Same Line. 
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In the example below, the family's Name will print in the same column, but on a new line as their ID 
Number, and it will be indented three spaces. 

   
Fig. 11‐47. 

In the example below, the Family Status will be in the same column as the keyword description but will be 
on a new line, and will display a label on the left. 

   
Fig. 11‐48. 

To place a line between this field and the one above it, select Draw a line above this field. 

Setting the Label Layout 
The Label Style section contains multiple label formats, including some manufactured by Avery®. You can 
select a label style from the Style Name drop‐down list. Label layout and the text of the label are the 
formatting elements that make up your label design. To add new labels or modify existing ones, click Edit 
Style. 

 
Fig. 11‐49. 
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Fig. 11‐50. 

In the Edit Label Style dialog box, you can set all parameters required to print a sheet of labels, such as the 
margins, height and width of the labels, space between each row and column, and the number of 
columns. Once you have made your selections, click Save then Close. 

In the Label Layout window, in the Copies field, enter the number of labels to print per individual. You can 
reuse partially printed sheets of labels by entering the number of labels to skip. 

 
 Important Note 

Only do this if you are printing to an ink‐jet printer. We do not recommend running partially printed 
sheets of labels through a laser print because the label could peel off inside the printer. 

 

To modify the layout of the address information, click Modify the Layout of the Address Information. 

 
Fig. 11‐51. 

This is the same editor you use to create letters. In this editor, you can select the font, enter text, insert 
fields, etc. When you set up or modify the layout of address information, be careful when you indent 
fields that may contain multiple lines of text, such as the Address Block. See Indenting Fields. 
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Setting the Envelope Layout 
The formatting elements that make up your envelope design are the envelope layout, return address 
style, and text of the envelope. Before you set the layout design for your envelopes, make sure you select 
the appropriate printing options for envelopes. 

 
Fig. 11‐52. 

In the Select Printer window, indicate the paper size, source, and orientation for the envelopes you are 
printing. In the Size drop‐down list, select the envelope size. A common envelope size is #10 envelope 9.5 
x 4.13 in. Select the source, and select Landscape for the envelope orientation. 

Once you have selected the appropriate printing options, in the Envelope Layout window, you can set the 
envelope style, return address style, and text of the envelope. To add new envelope styles or modify 
existing ones, under Envelope Style, click Edit Style. 

 
Fig. 11‐53. 

In the Edit Envelope Style dialog box, you can set the envelope dimensions and margins. Once you have 
made your selections, click Save then Close. 
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To add new return address styles or modify existing ones, under Return Address Style, click Edit Style. 

 
Fig. 11‐54. 

In the Edit Return Address Style dialog box, you can modify the return address text. Click Edit Layout. This 
is the same editor you use to create letters. In this editor, you can select the font, enter text, insert fields, 
etc. 

 
Fig. 11‐55. 
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Defining Forms 
Creating a form report is similar to creating a label report, except that a form takes up an entire page per 
family or member. This is useful for creating information forms for the family or individual to fill out and 
send back to the organization. 

To add a form, in the Select Report window, click Add > Form. 

 
Fig. 11‐56. 

A new form is added and the New Form editor displays. In this editor, you can enter text and insert fields, 
which gives you the ability to print data that the family or individual has provided so they can verify it. 

 
Fig. 11‐57. 
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Exporting Data 
One of the most common custom reports is an export report. Export reports are similar to list reports, but 
the data is sent to a file rather than a printer. You can export information to a word processor, a 
spreadsheet, Microsoft® Outlook®, or another program. 

To define an export report  

1. In the Select Report window, select the report category where you want to add the export. 

2. Click Add > Export. The List of Fields to Print dialog box displays. 

3. To select data fields to include in the report, click Modify the List of Fields to Export. In the 
dialog box, under Fields Available to Print, select the field names you want to include. Click the 
right arrow button to move the fields to Fields you want to print. Click Save/OK. 

4. In the Overview window, click Edit to enter the report's name and description. If you have access 
to designate reports, you can select a report owner and report access. Click Next. 

5. In the Export Properties window, click the File Format drop‐down list to select one of the 
following file formats: 

 Comma Separated Values (CSV) — Creates a text file with data items separated by 
commas. This format includes headings. 

 XML — Creates an Extensible Markup Language file that is useful for sharing data on the 
web. 

 Line/Form Delimited — Creates a file with a line feed at the end of each field and a 
form feed at the end of each record. 

 Line/Form Delimited With Headings — Creates a file with column headings, a line feed 
at the end of each field, and a form feed at the end of each record. 

 Tab Delimited — Creates a text file with data items separated by tabs. 

 Tab Delimited With Headings — Creates a text file with column headings and data 
items separated by tabs. 

 Fixed Width — Creates a file that always prints the same number of characters for a 
field. For example, if you print ID (10 characters), Name (100 characters), and ZIP Code 
(15 characters) in a Fixed Width format, the file will always contain exactly 10 characters 
for the ID, 100 characters for the Name, and 15 characters for the ZIP Code. If a field 
contains more characters than these, it will be clipped. If the information in the field is 
shorter than the character length, the length is filled with spaces. 

 CSV Without Headings — Creates a text file with data items separated by commas but 
without headings. 

6. In the Filename field, enter the name of the file you're creating. To open the browse dialog box, 

click  . 

7. To alter the list of selected fields, click Modify the List of Fields to Export. 

8. Click Next. 

9. Make any additional selections you want. Click Build to export the data to a file. 
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Questions 
Q: What are the six steps to running a report?  

A:                     ______________ 

                    ______________ 

                    ______________ 

                    ______________ 

                    ______________ 

                    ______________ 

 

Q: What are the six types of reports? 

A:                     ______________ 

                    ______________ 

 

Q: How do you access reports? 

A:                     ______________ 

                    ______________ 

 

Q: Your neighbor church has created a wonderful family listing report. How would they save the report? 
How would you install it? 

A:                     ______________ 

                    ______________ 

                    ______________ 

 
 
Q: What is a style? How many styles can you create? 

A:                     ______________ 

                    ______________ 

 
 
Q: What are Smallest Margins? 

A:                     ______________ 

 
 
Q: What is Simple Selection ‐ Never Saved? 

A:                     ______________ 
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12: Keywords 
 

Keywords represent data that is used many times in the program. Keywords are saved in list groups and 
simplify data entry, eliminating the possibility of spelling errors and inconsistent usage. You have control 
over each keyword list, and can add or delete terms as needed. Similar terms in the 
list can be combined. Examples of keywords include city/state names, phone descriptions, sacrament date 
names, etc. 

Maintaining Keywords 
To access keyword groups, on the File menu, click Keywords. 

 
Fig. 12‐1. 
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If you select any keyword list menu items, a keyword maintenance dialog box displays. 

 
Fig. 12‐2. 

You can also access the maintenance dialog box from wherever the keywords display in the program. At 

the end of a keyword field, click  , then Manage. The keyword maintenance dialog box displays. 

 
Fig. 12‐3. 

If you need to correct a keyword entry, just click the entry and enter the correct text. 

Keyword Commands 
Each keyword list has four major commands at the bottom of the dialog box that make it easy to 
maintain. 

Insert — Adds a new keyword to the list. 

Delete — Removes a keyword from the list. This removes the keyword from all records currently using it. 

Combine — Overwrites a keyword with another. For example, if you have "New York City" and "NYC" as 
city/state keywords, you can combine these entries. All records using those keywords are changed to the 
keyword you choose to keep. 

Print — Prints a list of the keywords. 

Use the two additional commands, Save/OK and Cancel, to save or cancel changes to the keyword list. 

 If you make a change to a keyword that is used by a record, all occurrences of the keyword reflect the 
change. For example, you have phone description keywords of Home, Office, and Cell. If you change 
Office to Work, any record with the phone description of Office is changed to Work.  
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Deleting Keywords 
To delete keywords, click Delete. In the dialog box that displays, select the entries you want to delete, 
then click Delete/OK. This removes the entries from the keyword list and from all records using the 
selected keywords. This may also affect other PDS Office programs if you share information between 
programs. 

 
Fig. 12‐4. 

 Useful Information 
This command requires exclusive access to the database. Only one user can be logged in to the program 
to perform this action. If your database includes multiple PDS Office programs, all users must be logged 
out of those programs, too. 

Combining Keywords 
To combine two entries, click Combine. In the list on the left, select the entry you want to remove, and in 
the list on the right, select the entry you want to keep, then click Add to List of Changes Below. Repeat 
this process to combine multiple keywords at one time. Once you finish adding keyword changes to the 
List of changes to be made section, click Combine/OK. 

   
Fig. 12‐5. 
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Keyword Lists 
The following sections describe the keyword selections on the menu. 

General Keywords — Relate to contact information are common among most of the PDS Office programs. 

Family / Fund Keywords — Used for family and fund information. 

Student / Parent / Guardian Keywords — Used for individual records. 

User Keywords — This is the last item for student/parent/guardian keywords. This list contains 11 
keywords you can define. These keywords display in the member's Personal window. 

Personnel Keywords — Used for personnel records. 

General Keywords 
The General Keywords category contains keyword lists for data you may enter for family, student, 
parent/guardian or personnel records. To access general keyword lists, on the File menu, select Keywords 
> General Keywords. 

 
Fig. 12‐6. 
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Attendance Reasons  

This keyword list contains reasons for why an individual could not attend a class. This information is 
maintained on the Information > Students > Attendance window and the Personnel > Catechists > 
Attendance/History window. 

 
Fig. 12‐7. 

Background Check Descriptions 

This keyword list contains various types of background checks conducted for employees and volunteer 
members. On the individuals Safe Environment window, you can record the description of the background 
check, date, result, and important notes. 

 
Fig. 12‐8. 
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City/State Names  

This keyword list contains the city/state, country code, and default city/state names used in the database.  
You can include cities in different countries using their appropriate postal code format. 

 
Fig. 12‐9. 

You can add other cities or states to this keyword list.  

Default City/State — The city and state entered in the License Information window displays here when 
you install the program. When you press Enter or Tab in a City/State field, the default city/state is 
entered. If you do not want a default city/state, leave this field blank. Default values can be overwritten 
when entering information. 

Country Code — Determines the format of the zip/postal code: 

 USA — Up to five digits. 

 Canada — Six characters in the following format: Letter‐Number‐Letter‐(space)‐Number‐Letter‐
Number. 

 Other — Up to ten characters. 

Area Code — If the majority of area codes in the city are the same, enter a default area code here. This 
area code is automatically entered in phone number fields when this city keyword is selected. You can 
overwrite the default, if necessary. 

Zip/Postal Code — If the city's ZIP/postal codes begin with the same three or five digits, enter a default 
ZIP/postal code here. These digits are automatically entered in ZIP/postal fields when this city keyword is 
selected. Then, you only have to enter the remaining digits of the postal code. You can overwrite the 
default, if necessary. 
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Class or Session Year/Period 

This is a list of session periods that will enable you to set up a session for the current period and also a 
session for the next period. This is helpful when enrolling pre‐registering students for next year in the 
current year. 

 
Fig. 12‐10. 

Email Description Names  

This keyword list contains location descriptions for the various types of email addresses used by families 
and individuals. 

 
Fig. 12‐11. 
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Ethnicity Names 

This keyword list contains the descriptive names for race, origin, or culture.  

 
Fig. 12‐12. 

Grades and Degrees 

This keyword list contains grade levels and degrees. Examples include. To arrange the grades in the proper 
order, click Reorder. 

 
Fig. 12‐13. 
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Language Names 

This keyword list contains various languages spoken by family members. If there are multiple languages 
spoken, put the primary language first followed by a slash, such as "English/Spanish". 

 
Fig. 12‐14. 

Letter Types 

This keyword list contains the types of letters sent to families, individuals, or other contacts you may call 
or visit. 

 
Fig. 12‐15. 
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Marital Status Names 

This keyword list contains terms that describe the marriage status for each member in the family.  

 
Fig. 12‐16. 

Phone Description Names  

This keyword list contains types of phone numbers that people use. 

 
Fig. 12‐17. 
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Relationship Names 

This keyword list contains typical relationship descriptions and the default member type associated with 
the relationship. 

 
Fig. 12‐18. 

Room Numbers/Names 

This is a list of room numbers and names associated with class sessions. 

 
Fig. 12‐19. 
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Time Periods 

This is a list of class session times. 

 
Fig. 12‐20. 

Family/Fund Keywords 
The Family/Fund Keywords category contains keyword lists for data you may use when entering families 
and funds. 

Family User is a customizable field that displays below the City/State field on the Families Primary 
Information window. 

To access family/fund keyword lists, on the File menu, select Keywords > Family/Fund Keywords. 

 
Fig. 12‐21. 
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Family Keyword Names  

This keyword list contains family descriptions or terms used to enter information that is not covered by 
other family fields. 

 Useful Information 
In a shared database, each Office program can have its own list of family keywords, but if you want to, 
you can share the Church Office family keywords with the other programs. To do this, you must indicate 
you want to share family keywords in the Initial Setup window of each program. 

 

 
Fig. 12‐22. 

Family Status Names  

This keyword list contains descriptions for the nature of the relationship of the family members in a 
particular household. This information is named Status throughout the program. 

 
Fig. 12‐23. 
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Family User 

This keyword field is customizable and displays below the City/State field on the Families Primary 
Information window. This keyword field is commonly used to maintain the name of the church the family 
attends. 

 
Fig. 12‐24. 

Fund Keywords  

This keyword list contains terms used in the Fund window to describe an attribute of a particular family 
with regard to the funds. 

 
Fig. 12‐25. 
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Student / Parent / Guardian Keywords 
The Student/Parent/Guardian Keywords category contains keyword lists for data you might enter in 
student or parent/guardian records. To access student/parent/guardian keyword lists, on the File menu, 
click Keywords > Student/Parent/Guardian Keywords. 

 
Fig. 12‐26. 

Celebrant Names 

This keyword list contains the names of those who celebrate Mass or perform other services. 

 
Fig. 12‐27. 
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Ministry Names 

This keyword list contains types of ministries. To move a keyword from the Ministry Names list to the 
Talent Names list, select the keyword and click Move to Talent List. 

 
Fig. 12‐28. 

Preparation Class Names 

This is a list of class names that parents take in conjunction with their students’ sacrament classes. 

 
Fig. 12‐29. 
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Sacrament Date Names 

This keyword list contains sacrament names. 

 
Fig. 12‐30. 

Service/Retreat Names 

This is a list of service or retreat names that students might attend. 

 
Fig. 12‐31. 
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Sponsor/Witness Types 

This keyword list contains types of sponsors and witnesses for various sacraments. 

 
Fig. 12‐32. 

Student / P/G Keywords 

This list is used to describe various aspects pertaining to individuals. It can be used for many different 
purposes.  

 Useful Information 
This list is separate for each PDS Office program. However, the other common member keyword lists are 
shared and can be modified by anyone with access privileges. 

 

 
Fig. 12‐33. 
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Talent/Ministry Status Names 

This keyword list contains names that describe the status of a person’s involvement in a talent or ministry. 
The status can also identify needs, the willingness to volunteer, or the need for a reply. To default each 
status to Involved when printing reports, enter Yes in the Currently Involved column. This reduces data 
entry work. 

 
Fig. 12‐34. 

Talent Names 

This keyword list contains talents or services that a member is willing to provide. Record the status of that 
talent or service using terms from the Talent/Ministry Status Names list. To move a keyword from the 
Talent Names list to the Ministry Names list, select the keyword and click Move to Ministry List. 

 
Fig. 12‐35. 
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Volunteer Areas 

This is a list of Formation‐related areas that a parent/guardian might volunteer. 

 
Fig. 12‐36. 

User Keywords 

There are numerous User Keyword fields. You can assign the name of the keyword, such as "Occupation" 
or "District", and set up the options in the keyword list. For example, under Occupation, you can enter 
"Accountant", "Secretary", "Doctor", and so on. 

 
Fig. 12‐37. 

By default, the first three User Keyword names are set up. These can be changed even if you transferred 
data from an earlier version of PDS. In order for user keywords to display on the Personal windows, you 
must assign a name to the keyword. 
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To indicate what programs can view the user keyword, select the appropriate Use For check boxes. 

 
Fig. 12‐38. 

Select the Show On check boxes to indicate whether this user keyword will appear on student records, 
parent records, or both. 

Personnel Keywords 

The Personnel Keywords category contains keyword lists for data you would enter in personnel records. 

To access personnel keyword lists, on the File menu, select Keywords > Personnel Keywords. 

 
Fig. 12‐39. 

   



12 - 22  Keywords PDS Formation Office
 
 

Achievement Types  

This keyword list contains types of achievements, certificates, honors or awards. 

 
Fig. 12‐40. 

Catechist Positions 

This is a list of positions a catechist could hold. For each class within the catechists List of Sessions, you 
can define the position they hold. For example, someone could be a “catechist” for one class and a 
“catechist’s aide” for another class in the List of Sessions on the Catechist Schedule window. 

 
Fig. 12‐41. 
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Clergy Keywords  

This keyword list contains clergy descriptions or terms used to enter information that is not covered by 
other clergy fields. 

 
Fig. 12‐42. 

Department Types  

This keyword list contains types of departments used for personnel assignments. 

 
Fig. 12‐43. 
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Education Types  

This keyword list contains types of education used for Education/Credentials personnel information.  

 
Fig. 12‐44. 

Personnel Keywords  

This keyword list contains personnel descriptions or terms used to enter information that is not covered 
by other personnel fields. 

 
Fig. 12‐45. 
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Personnel Types  

This keyword list contains types of personnel. 

   
Fig. 12‐46. 

Personnel Positions 

This keyword list contains names that describe the positions used for personnel assignments. 

 
Fig. 12‐47. 
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Requirement Descriptions 

This keyword list contains requirements that members must meet before they can do volunteer work or 
become employed by your organization. Enter a description of the requirements in this keyword list.  

 
Fig. 12‐48. 

Exercises 
Exercise #1: Make a new User Keyword. 

1. Create a user keyword called Ice Cream, with entries of Chocolate, Strawberry, and Vanilla.  

2. Go to a student record and select Strawberry as the Ice Cream preference. 

3. Return to the keyword maintenance dialog box and change Strawberry to Cherry.  

4. Return to that student record to see the change. 

Exercise #2: Combine two keyword entries. 

1. Add an entry called Black Cherry to the Ice Cream user keyword. 

2. Go to a student record and select Black Cherry as the Ice Cream preference. 

3. Combine the keyword entries of Black Cherry and Cherry, with Cherry being the remaining 
keyword. 

4. Return to that student record to see the change. 

Exercise #3: Delete a keyword entry. 

Delete the entry Cherry in the Ice Cream keyword. 
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Questions 
Answer these questions pertaining to keywords. 

Q: How many User Keywords are available?  What windows do they appear on? 

A:                      

 

Q: How many entries can you have in each keyword list? 

A:                      

 

Q: What are the four commands available in every keyword list? 

A:                      

 

Q: What is the extra command on the Grade keyword list? 

A:                      
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13: Listing Screens 
 

Each major section of the program has a listing screen, including the Families, Students, Tuition & Fees, 
Parents & Guardians, Class Schedules, and all Personnel windows. 

In each of these windows, in the navigation pane, click Listing Screen. In these listing screens, you can 
view and print a list of records. To display the list in a larger window, click Zoom. 

 
Fig. 13‐1. 

Using the Listing Screen 

 To quickly jump to records beginning with a certain letter, click the rolodex tabs at the top of the 
window. 

 To locate a certain record, use the Navigation tools. You can look up a particular family, 
individual, or fund. 

 Select whether you want to display active, inactive, or all records. 

 Inactive records display in red in this window, but do not print in reports unless you select to 
include them.  

 In the grid, rows display in alternating colors so you can more easily view information when 
scrolling horizontally. 

 Each row displays one item, such as information on a single family. If there is more than one sub‐
item, the second item displays in another row. For example, if there are multiple phone 
numbers, each number displays in a new row. 

 When the first column is a solid color, it is "locked" and remains visible when you scroll 
horizontally. To lock or unlock the first column, click Customize View. 
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 When the list is wider than the window size, a horizontal scroll bar displays at the bottom of the 
list. When the list is longer than the window size, a vertical scroll bar displays to the right of the 
list. 

 You can change the width of any column. Position your mouse pointer on the divider line to the 
right of the column header you want to resize. When the mouse pointer changes to a two‐

headed arrow  , drag the divider line to the left or right. The width of a column cannot be 
smaller than the heading name. 

 An ellipsis (…) is used at the end of an entry to signify you are seeing incomplete information. 
When you hover over a field that has an ellipsis, the complete information displays. The 
information displays for a few seconds or until you move off of the field. This is a quick way to 
view the complete information without resizing the column. 

 To reorder columns, click a heading name and drag it to the desired location. 

Customizing the Listing Screen 
All listing screens have a default view. However, you can customize the list to display the columns you 
want to see in the order you want to see them. If user names are required to enter the program, each 
user's customized view is saved. 

To change settings, click Customize View. Use the options described below to make changes. To return to 
the default settings, in the Customize Listing Screen dialog box, click Default Values. 

 
Fig. 13‐2. 
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Grid Properties 

 Number of lines per row — Increase this number to enlarge the height of each row in the grid. 
As you increase the number of lines in each row, you decrease the number of rows that are 
visible at one time. The default is 1.00. 

 Font size of the grid — To use a larger font, increase the number. To make the font smaller, 
decrease the number. Increasing the size reduces the number of rows you see at one time. The 
default value is 8 pt. 

 Lock the first column — By default, this option is selected and the first column is locked. This 
keeps the column in sight when you scroll to the right of a list. To unlock the column, clear this 
option. 

Fields 
You can use the drag‐and‐drop method or use the arrow buttons to move selected fields between the two 
lists. 

 Fields available to view — Contains the fields you can add in the listing grid. To add a field to 
display in the listing window, click a field name, then click the right arrow to move it to the Fields 
you want to view list.  

 Fields you want to view — Contains the fields currently displayed in the listing grid. To display 
the width and heading name below the list, click the field. Column headings display in the listing 
grid in the same order they are displayed in this text box. To reorder the list, click the field name 
and drag‐and‐drop it to your preferred location in the list. Or, click the field name and use the up 
and down arrows to reorder the list. For more information, see the following topic of Quick Tips 
for Reordering a List. 

Width — Displays the width of the selected item in the Fields you want to view list. The default value or 
the resized value for the field width displays. An ellipsis (…) is used at the end of an entry in the grid to 
signify you are seeing incomplete information. 

Heading — Displays the column heading name. A column can never be sized smaller than its heading 
name. The smaller the columns, the more information you can see on the screen at one time. You can 
also drag‐and‐drop some headings to reorder the columns. 
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Quick Tips for Reordering a List 
Fields you want to view — The defaults in this list vary depending on the listing screen you are viewing. 
When you select an item in this list, its Width and Heading display below the list. The order of this list is 
the same order the columns display (from left to right) in the listing screen.  

 
Fig. 13‐3. 

To reorder this list, click a field name, then drag it to the desired place in the list. You can also click a 
column heading in the listing screen and drag it to the desired place. 

Another way to reorder the list is to select the field you want to move, then click   or   to move it up 
or down in the list. 

In the listing screen, to print the list of items in the window, click Print List. If you want to reorder the list, 
in the Navigation tools, select an option in the Order by drop‐down list. You can order different listing 
screens in different ways, depending on the type of information in the list. 
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About Easy Lists 
Easy lists take the regular listing screens a step further. They make it easy to view and print information 
on 11 different topics, such as attendance, birthdays, ministries, talents, and sacraments. In the 
navigation pane of the Students window, click Easy Lists. 

 
Fig. 13‐4. 

Select a List 
Select the list you want to display. Options for the list display on the right. Options vary from list to list. 
After you make your selections, click Apply/OK. The Easy List window is now a listing screen. If you want 
to reset columns to the original view, click Select a List, then click Default Columns. 

  
Fig. 13‐5. 
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Customize View — Change columns, headings, widths, fonts, etc. For more information, see the 
Customizing the Listing Screen section of this chapter. 

Select a List — Select different options for the current easy list or select a different easy list. 

Zoom — Enlarge the list in a new window to view more lines and columns at once. 

Print List — Print the list as it displays in the program. 

Easy Letter — Create and print a letter to those in the list. 

Exercises 
Exercise #1 

Get a list of children and young adults who have different last names than their parents. Customize the 
view to show their grade and address. 

 

Exercise #2 

Get a list of single female parents, between the ages of 25 and 50, with children. Send a letter to them 
regarding a new ‘Mommy and Me’ group. 

 

Exercise #3 

Get a list of students who are in the 1st Grade Formation class. 

 

Exercise #4 

Get a list of parents who have volunteered to be part of the car pool. 

 Questions 
Answer these questions about viewing listings and Easy Lists. 

Q: Which main which main program section includes financial fields as part of its listing screen's 
Customize View options? 

A:                      

 

Q: The width of a column cannot be smaller than what? How could you make it smaller? 

A:                      

 

Q: Which command button would you use to get the original columns back in an Easy List? 

A:                      



PDS Formation Office CASS & EZ Mail  14 - 1 
 

14: CASS and EZ Mail 
 

Having your addresses certified by CASS™ (Coding Accuracy Support System) qualifies your organization 
for reduced postal rates on your mailings. The U.S. Postal Service® uses standardized and correct mailing 
addresses from the National Address Database for large quantities of mail. PDS is authorized to provide 
CASS certification service to our program users.  

The EZ‐Mail™ features in the program help you prepare First‐Class and Standard bulk mailings. To use EZ‐
Mail, you must first CASS‐certify your addresses. 

Checking Addresses for Common Errors Before CASS 
Your addresses must meet the USPS regulations for your mailings to qualify for these postal discounts: 

 Carrier Route Rates – Addresses must be matched with CASS‐certified software that supplies 
eLOT at least 90 days in advance. 

 Bulk Mail – Carrier route sorting must meet the reformed postal sorting requirements for eLOT. 
eLOT identifies the order in which a postal carrier can deliver the mail. The data required for 
eLOT is included in CASS It!. 

 Automation Rate Mailings – Addresses must be matched using CASS‐certified software at least 
six months before mailing. 
 

 Useful Information 
To use the service, you must purchase a registration code and a monthly subscription by calling 800‐892‐
5202. 

For more information on this feature, visit http://www.parishdata.com/cass_it. 

 

To check addresses for errors  

1. On the File menu, click Bulk Mail/CASS > Check Addresses for Common Errors. 

2. To begin, click Next. 

3. Select an option for checking the addresses. If you want to select certain families, select the last 
option, and add conditions to filter the list. 

4. Select to include only active, only inactive, or all families, and click Next. 

5. If errors are found, the addresses that need to be corrected will display. Print the list to use as a 
reference when you make your corrections. 

6. Click Finish. 
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Verifying Bulk Mailing Addresses Using CASS It! Certification 
To verify bulk mailing addresses using CASS It! 

 
 Be Careful 

This process alters data. We recommend backing up your data before proceeding. 

1. On the File menu, click Bulk Mail/CASS > CASS It! Certification. 

2. The CASS It! Process checks for available options, once verification is complete, click Next. 

3. Select an option for checking the addresses. If you want to select certain families, select the last 
option, and add conditions to filter the list. 

4. Select to include only active, only inactive, or all families, and click Next. 

5. Select any additional options you want to perform. For more information on these options, see 
the Additional Field Information below. 

6. Click Begin CASS. 

7. If any addresses fail to be certified, they display in the summary. Print the list to use as a 
reference when you make your corrections. 

8. Click USPS Form 3553 to save or print the form with your information. 

9. Click Finish. 

Additional Field Information  
NCOA ‐ Optional ‐ Extra Fees Apply — Update an address change to ensure that you're compliant with 
the USPS. If you want to report an NCOA change without changing the address in PDS, also select Report 
NCOA Changes Instead of Making the Change. NCOA processing is an add‐on feature to CASS It and 
includes additional fees to your monthly subscription. For more information, contact a PDS solutions 
consultant at 1‐800‐892‐5202. 

Geocode Addresses ‐ Optional — If you have Geocoding, select this to update the longitude and latitude 
to reflect the new address. Use this data with your choice of third‐party mapping software. Geocoding is 
an add‐on feature to CASS It and includes additional fees to your monthly subscription. For more 
information, contact a PDS solutions consultant at 1‐800‐892‐5202. 

Perform Zip+4 and Delivery Point Encoding — Update ZIP Codes with the additional four‐digit suffix, and 
add the delivery point encoding. 

Perform Street Address Standardization — Remove punctuation from addresses and shorten the 
direction indicators and street names. 

Generate the Previous Certification File — If you don't want to run CASS It or NCOA processes, you can 
load the file that was created the last time you ran the process. You can then view a summary and print 
the forms. 
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Using EZ‐Mail 
EZ‐Mail simplifies bulk mailing for you by properly sorting the mail and printing the forms required by the 
USPS. Refer to the tabs below for more information about each of the EZ‐Mail steps, in order. 

 

To use EZ‐Mail  

1. On the File menu, click Bulk Mail/CASS > EZ‐Mail. 

2. If there is a new set of postal forms, a dialog box displays. Click Yes to download them. 

3. On each tab, enter or select the required information. See the following information for more 
details on the fields within these tabs. 

4. When you're finished, click Save/OK > Close. 

Potential Savings Using EZ‐Mail 
On this tab, you can estimate the potential cost of a mailing and your savings by using bulk mail. Enter the 
number of mailing pieces, and your costs are automatically calculated. 

Step 1 ‐ Mailing Specifications 
This tab is the starting point for each mailing. Once you complete the information in this window, you 
don't need to edit it unless the next mailing contains different specifications or a date change. 

Additional Field Information  

ZIP code of the post office receiving the bulk mailing — Enter the ZIP Code of the post office that handles 
your mailing, typically the office where you obtained your mailing permit. It could also be a Sectional 
Center Facility or a Bulk Mail Center that serves your post office. Only make changes to the city if your 
post office requests that you print a different city on the tray labels. 

Date of the Mailing — Enter the date you plan to send the mailing. This date prints on all forms and helps 
track the date of the last CASS certification. 

Merge SCF into One Tray — Postal regulations suggest separating mail trays for each SCF even if there's 
only one mail piece per tray. 

Number of Mail Pieces That Fit in a 2‐Inch Package — Place a rubber band around a 2‐inch stack of 
mailing envelopes, and count the number of envelopes. 

Weight of a Single Piece — The weight of a single piece is difficult to determine unless you have special 
weighing equipment that can measure in fractions of ounces, up to three decimal places. If you don't have 
the equipment, you can estimate by weighing ten pieces and dividing the total weight by ten. We 
recommend that you ask your local post office to weigh samples of various types of mailings. 

Postage Already on Each Piece — If you use a postage meter or precanceled stamps, enter the amount of 
postage that's on each piece of mail. 
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Step 2 ‐ Build the EZ‐Mail List 
Before you print labels, envelopes, or letters, the program builds a list of families or individuals sorted in 
the order required by the post office. To use this list when you run a report, select to sort your report in 
EZ‐Mail order. 

 
Fig. 14‐1. 

To build the special mailing list, indicate if the mailing will be sent to families, families based on financial 
selections, students, catechists, or parents/guardians. 

 

 
 Important Note 

This step does not produce labels or envelopes; it just identifies who you want to include in the EZ‐Mail 
list. 

Additional Field Information  

Build a List of Family Addresses — You can select names and addresses entered in the Families window. 

Build a List of Family Addresses Based on Financial Selections — You can select names and addresses 
entered in the Families window. 

Build a List of Student Addresses — You can select names from the Students window and addresses 
entered in the Family window. 

Build a List of Catechist Addresses — You can select names and addresses from the Catechists window. 

Build a List of Parent/Guardian Addresses — You can select names from the Parents & Guardians window 
and addresses entered in the Families window. 
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Step 3 ‐ Print the Qualification Report 
This document satisfies the post office requirement for standardized documentation. Present this report 
to the post office with your mailing. 

The report contains the following information: 

 EZ‐Mail List — Lists each tray by number and gives specific information about the tray and pieces 
of mail. 

 Tray Number  — Identifies one of the trays used in this mailing. Tray numbers begin at 1 and are 
numbered sequentially. There is also a tray 0 for any uncertified pieces in the mailing, which 
must be sent at the First‐class rate. 

 Tray Size— Indicates the size of the tray required by this group of mailing pieces. Trays can be 1 
foot long or 2 feet long. 

 Tray LVL— Identifies the type of mail to place in each tray. 

 Tray Zip— Identifies the ZIP Code common to all pieces in the tray. This can be a partial ZIP Code 
if the tray sorts by the first three digits. 

 Group Dest— Lists all the individual carrier routes and ZIP Codes if there are multiple routes and 
ZIP Codes in a tray. 

 Rates — Total number of pieces in each tray that print under the appropriate Rate column. 

 Running Total — The last column in the report that displays a running total of pieces in the trays. 

 Totals — Displays the total number of pieces in each Rate column and then a grand total of all 
pieces in the Running Total column. 

 Auto Rate Summary — Displays the total number of pieces for each Rate category in your 
mailing and the total number of pieces in the mailing. 

 ECR Rate Summary— If you use carrier route trays, these trays are treated by the post office as a 
separate mailing. This is a summary of the total number of pieces for that mailing. 

Step 4 ‐ Print the Tray Labels 
Mail trays used for mail in the same area of distribution are labeled with a special barcode. We 
recommend printing them with a laser or ink jet printer. 

Labels must be 2 inches high by 3.5 inches wide. The labels must be placed on the correct trays to speed 
up the mail sorting process. 

Step 5: Print the Postage Statement 
Enter information here to complete the proper form required by the post office for your mailing. The form 
you file depends on the class of mail you send and the permit you use. 

Additional Field Information 

Sequencing Date — Projected date of the mailing. 

Permit Holder — The permit holder’s information and the CAPS Customer Reference ID number. 

Print the Postage Statement – Prints your statement. Before you print, make sure the information on the 
rest of the tab is correct. 
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Step 6 ‐ How to Print the Mailing 
This tab explains that you need to use the program’s Reports feature to print your labels, envelopes, 
letters, and lists.  

To print your bulk mailing  

1. Click Close to exit the EZ‐Mail process. 

2. On the ribbon, click Reports. 

3. Locate the report relevant to the mailing list you selected in Step 2: Build the EZ Mail List. 

4. Select the printer. 

5. Set the layout. 

6. In the Sort Order drop‐down list, select EZ‐Mail. 

 
Fig. 14‐2. 

 
 Important Note 

Under Sortation, in the Sort Order drop‐down list, you must select EZ‐Mail. The mailings are 
printed in sorted order beginning with the pieces that do not qualify for bulk mail rates. Then, if 
needed, you can make selections that limits who receives the mailing. 

7. On the EZ‐Mail Selections tab, enter any additional selections you want. In the example below, it 
will print labels beginning with the 17th piece in the 2nd tray, and end with the 10th piece in the 
8th tray. This is useful if your print sequence is interrupted and you need to begin printing at a 
specific point. 

 
Fig. 14‐3. 
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Step 7: Packaging, Traying, and Mailing 
This is not a step performed by the EZ‐Mail program. You must organize the necessary elements before 
taking the mail to the post office. 

Before you actually print, make sure you have everything required for the mailing. For example, you could 
print the complete mailing and realize you do not have the correct permit, or you could be in the middle 
of the mailing and run out of labels. Make sure you have the following: 

 Necessary permits 

 CASS‐certified data 

 Trays 

 Tray labels 

 Address labels (if used on envelopes) 

 Envelopes (if printing directly on envelopes) 

All of these items are important in order for you to complete your bulk mailing. Your local post office can 
provide you with rubber bands and trays free of charge. Tray labels are produced by the EZ‐Mail program. 
If you are going to affix address labels to each mailing piece, make sure you have an adequate supply of 
labels on hand that conform to postal regulations. 

 
 Useful Information 

Your printer is also an important component of this process. If the quality of the printed barcode is not 
clear enough for the postal barcode sorters to read, your mailing could be rejected. Check with the post 
office about testing the barcodes your printer produces. 
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Up to this point, the EZ‐Mail program has done its job and prepared an ordered list of mail pieces which 
await further attention. It is important during the packaging and traying process that this order is not 
altered. For example, you may separate a stack of labels so volunteers can help put labels on envelopes. If 
the stacks get out of order, your mailing could be rejected. So, it is important to make sure that the 
mailing pieces are kept in the order they were printed. 

Since each segment of the mailing is identified, it is very easy to package and tray the entire mailing. The 
program prints a label or page between the groups for each tray. 

Below are some suggested steps you can use to complete the packaging and traying process:  

1. Put the tray labels on the proper tray — One tray label prints for each tray that your mailing 
requires. Each label identifies which size of tray it should be placed on. A tray number further 
identifies each tray label. 

2. Order trays by number — Once all of the labels are placed on trays of the proper size, place the 
trays in numerical order by the tray number. You are now ready to begin filling the trays. 

3. Separate mailing by tray — Look for the tray identification label or page that separates mail for 
each tray. Place all labels that print before this label in tray 1, and place those that print after this 
label up to the next separator in tray 2, etc. Trays can be 1 foot or 2 feet long. "One‐foot" trays 
are actually 10.25 inches, and "two‐foot" trays are 21 inches. The post office considers a tray to 
be full if it is three‐quarters full when tilted at a 45 degree angle. Each tray must have a label on 
it. 

4. Stuff envelopes/affix labels — Put the labels on the envelopes in the order printed, or put the 
addressed letters in envelopes in the order printed, then put them into the proper trays. If you 
are printing package and endorsement fields, the tray and piece numbers print on the label, 
envelope, or letter. The tray number indicates which tray you should put the piece in. The piece 
number indicates the order of the piece within the tray. 

 
 Useful Information 

Labels that do not print a tray or piece number are regular mail pieces, which do not qualify for 
bulk mailing. Do not put them in any of the trays. Keep them separate from your bulk mailing. 
To mail these pieces, you must put full postage on them and send them via regular mail. 

5. Verify labels are straight, not skewed — Make sure you place labels on the envelopes properly. 
If they are on an angle, the scanner may not be able to read them, and they could be rejected. 

6. Get forms ready — Gather together all of the postal forms that are required for your mailing, 
and make sure all information is completely filled out. 

7. Deliver the mailing — Take the trays and the forms to the post office. 
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Post Office Information 
You can set up or modify postal rates and specifications on this tab. Default values are provided. However, 
if the postal system changes the values, you must update these values. 

 
 Useful Information 

The PDS program updates modify this information as the post office adjusts rates. You only need to 
modify them manually if you produce a bulk mailing after the new rates take effect but before the next 
scheduled program update from PDS. 

 

Additional Field Information  

Mailing Size — The minimum number of pieces that qualify for a discount rate under the mailing class 
displayed. 

Carrier Route Group — To qualify for a discount rate for carrier route sort, 10 or more pieces must be 
bundled together in each carrier route group or bundle. 

5‐Digit Tray — A minimum of 150 pieces constitutes a full tray of 5‐digit presorted mailing pieces. 

3‐Digit Tray — Contains envelopes that aren't 5‐digit sorted. Enter the number of pieces remaining to 
make a full tray of 3‐digit/scheme presorted mailing pieces. 

AADC Tray — The minimum number of pieces that constitute a full tray of AADC mailing pieces. 

Rates — Displays the rates for each piece of mail for First‐class, Standard‐class, Carrier Route, 5‐digit, 3‐
digit, and AADC mail. 

Rates for Carrier Route — The rate for a single piece of Carrier Route sorted mail. 

Address Change Notification 
For presorted First‐class mail, the post office requires that the addresses you use are correct through 
CASS certification, and that the person you address the mailing to resides at that address. The United 
States Postal Service® offers, for a fee, the Address Change Service (ACS). As a participant, you're notified 
if an addressee moves, and the new address is sent to you. 

To use the service, you must obtain a participation code and print the phrases "Address Service 
Requested" or "Change Service Requested" on mailings. For other requirements and details of 
participation, visit https://www.usps.com/business/move‐update.htm.. 

 Useful Information 
When using the Address Change Service, you must manually update your existing data in PDS. If you 
manually change an individual’s address information, the address is no longer considered CASS–certified, 
so you must have your addresses CASS‐certified again. 
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Exercises 
Exercise #1 — In step 1 of the EZ‐Mail feature, enter the following mailing specifications: 

 ZIP Code of the post office receiving the bulk mailing — Enter the ZIP Code of your post office. If 
you are unsure of your post office's ZIP Code, enter yours. 

 Mailing Class — Standard‐class ‐ Non Profit 

 Your Permit Number for this Class — 1234 

 Date of the Mailing — 1 week from today 

 Try to Use Carrier Route Trays — Yes 

 Merge SCF into One Tray — Yes 

 Number of Mail Pieces That Fit in a 2‐inch Package — 60 

 Weight of a Single Piece — 0.401 

 Postage Payment Method — Permit Imprint 

 Postage Already on Each Piece — $0.00 

 Type of Discount — DSCF 

 
Exercise #2 — Build an EZ‐Mail list of student addresses. Then, in the Select Report window, under 
Label/Envelope Reports in Upper Case, run the Student Mailing Label ‐ Barcode at Bottom report. Make 
sure you change the sort order to EZ‐Mail. 
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15: Additional Features 
 

This chapter discusses features that are common to all of the PDS programs. 

Using the Keyboard 

Navigation 
The ribbon provides a standard method to navigate the program using the keyboard. Press and release 
the Alt key on the keyboard. A series of keyboard navigation hints display. Press the letter corresponding 
to the window you want to view, such as R for Reports (shown below). 

 
Fig. 15‐1. 

A second set of keyboard navigation hints display for the selected page. Press the letter corresponding to 
the item you want to view. Use the arrow keys to navigate the drop‐down lists and menu items. Press 
Enter to select a highlighted menu item. 

Keyboard Shortcuts 
You can use shortcut keys to quickly navigate through your PDS program. You can perform actions in the 
program using the following key combinations. 

Key Combinations  Action

Ctrl + C  Copies selected text.

Ctrl + K  Opens the calculator.

Ctrl + P  Prints the current window.

Ctrl + V  Pastes copied or cut text.

Ctrl + X  Cuts selected text.

Ctrl + Y  Opens the Year at a Glance calendar.

Ctrl + Z  Undo the last edit.

Alt + down arrow Opens a drop‐down list.

Alt + F4  Closes the active window.

Alt + N  Move to the next record.

Alt + P  Move to the previous record.

Alt + Q  Displays the Quick Lookup dialog box.

Alt + S  Saves the edits and selections.
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You can navigate the program using the following keyboard shortcuts. 

Navigation Keys  Moves Insertion Point Ctrl + Key Moves 

Left arrow  Left one character or unit Left one word or larger unit 

Right arrow  Right one character or unit Right one word or larger unit 

Up arrow  Up one line or unit Up one larger unit 

Down arrow  Down one line or unit Down one larger unit 

Home  Beginning of line Beginning of data 

End  End of line End of data

Tab  Next field ‐‐‐

Shift + Tab  Reverse tab order ‐‐‐

PgUp  Up one window at a time ‐‐‐

PgDn  Down one window at a time ‐‐‐

 

In any full date field (mm/dd/yyyy), you can use the following key commands. 

Key Command  Action

T  Inserts today's date

‐ (dash) or _ (underscore)  Go back one day

+ (plus) or = (equal sign)  Go forward one day

Quick Access Toolbar 
The Quick Access toolbar contains buttons for some common tasks and features. To view a button 
description, place your cursor over the button. By default, all available buttons display, but you can hide 

any or all of them. To display or hide quick access buttons, click   and make your selections. 

 
Fig. 15‐2. 
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Back & Forward 
When you open Formation Office, the program keeps a record of the different windows you visited, up 
until you exit the program. 

These navigation buttons allow you to move either back one window at a time, forward one window at a 
time, or you can use the Back drop‐down list to easily revisit a previously viewed window. 

 
Fig. 15‐3. 

Undo, Cut, Copy, & Paste 
The Quick Access toolbar includes dedicated shortcuts for the most common editing commands. You can: 

 Click the Undo icon or press Ctrl + Z 

 Click the Cut icon or press Ctrl + X 

 Click the Copy icon or press Ctrl + C 

 Click the Paste icon or press Ctrl + V.  

 
Fig. 15‐4. 

Spell Check 
To double‐check the spelling, use the integrated Spell Check feature. Place the cursor inside the item you 
want to check, then click the Spell Check icon in the Quick Access toolbar.  

 
Fig. 15‐5. 
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Insert Symbol 
You may need to insert characters from languages other than English. Right‐click any text field, select 
Insert Symbol, then select the special character.  

 
Fig. 15‐6. 

Special Tools You Can Use Anywhere 
These items can be used from almost any location in the program.  

Print Screen  
On the Quick Access toolbar, click the Print icon or press Ctrl + P. 

 
Fig. 15‐7. 

Select the printer, paper size, orientation, and margin style. Then click Print.  

 
Fig. 15‐8. 
 
The settings in this dialog box are saved with each user and recalled the next time a Print Screen is 
requested.  
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Printer — Displays the list of available printers installed in your Windows® operating system. To add or 
remove a printer, refer to your Microsoft® Windows® Help or your printer manual for instructions. Click 
Properties to view the controls for items such as the number of copies and print quality. These items are 
specific to the printer.  

Paper — Select the Size and Source. These options depend on the capabilities of the selected printer.  

Orientation — Select how the image should print on the page. If the printer selected is not capable of 
printing in Landscape mode (horizontally), it does not display as an option. The sample on the right of the 
dialog box displays the orientation selection.  

Margin Style ‐ Style Name (40 char) — Set the margins for the page. To use the lowest settings available 
for the selected printer, select Smallest Margins. The margin dimensions display under the selected style. 
The size takes into account the printable area the selected printer is capable of printing. To insert a new 
style or modify or delete an existing style, click Edit Style.  

Calculator 
On the Quick Access toolbar, click the Calculator icon or press Ctrl + K. 

 
Fig. 15‐9. 

You can use this feature to total amounts without going to your desktop calculator. You can also use it as 
a means to insert a total from the tape into any Amount field. It also provides an easy way to enter 
numbers with the mouse. You can also click the calculator icon that displays after you click in an Amount 
field.  

 
Fig. 15‐10. 

Click an amount field to display the calculator icon. Click the calculator icon, then click numbers and 
function buttons to “key” them in. You can also use the keyboard to enter amounts. Click Apply/OK or 
Enter to place the total in an Amount field. Click Cancel to close the calculator.  

Click Tape to use the following options:  

 Visible — Switch between displaying and not displaying the tape. 
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 Clear — Erase all calculations and commands. You can also click Clear Tape, which is visible when 
the tape is visible. 

 Print — Print a report of what is on the tape. 

 Copy to the Clipboard — Send what is on the tape to the clipboard. 

Calendar  
To view a year‐at‐a‐glance calendar, on the Quick Access toolbar, click the Calendar icon or press Ctrl + Y.  

 
Fig. 15‐11. 

This is similar to the calendar icon that displays when you click in a date field, but it is not associated with 
any field in the program. The year‐at‐a‐glance calendar displays in a new window. Below is a sample 
calendar.  

 
Fig. 15‐12. 

 Weekends are shaded light green. 

 Navigation arrows are on each side of the year. Click   to view next year's calendar, or click   to 
view the previous year. Each click moves ahead or back one year. 

 Click Close to exit the calendar. 

 Useful Information 

Click the calendar icon when in a date field, then double‐click the date you want to insert in the date field. 
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Program Information 

Screen Information  
In the Screen Information dialog box, you can adjust the settings for screen colors and resolution. On the 
Quick Access toolbar, click the Screen Configuration icon.  

 
Fig. 15‐13. 

 
Fig. 15‐14. 

Special Effects  

 Fade Text on Screens that are Not Active — When selected, inactive windows located behind 
active windows appear faded. 

 Animate Hover Over Tabs and Buttons — When selected, if you hover over a tab or button, a 
description displays. 

 Use New Method to do Screen Maximize — If you are an OnDemand user, select this option to 
maximize your screen and still view OnDemand messages. 

 Sound When Messages Pop Up — Pop‐up messages display for specific activities such as 
entering a duplicate ID, selecting the Inactive check box, or displaying error messages. To select a 
sound, click the Sound when Messages Pop Up drop‐down list, and select an option. To preview 
the sound, click Test. 
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Color/Background  

You can select one of the preexisting color schemes from the Color Scheme drop‐down list, or you can 
create your own. 

 Useful Information 

Select the Few Colors color scheme if your computer has 256 colors available. 

 

To set up your own color scheme  

1. In the Screen Information dialog box, click Adjust Colors. 

2. In the Color Adjustment dialog box, click Add New Color Scheme. 

3. In the left pane of the window, you can change the colors for various parts of your program 
windows. A preview of your changes displays in the right pane. 

4. When you're finished, click Save/OK to apply your new color scheme. 

Screen Size  

Set the screen size depending on your Windows screen resolution settings. 

 Adjust for Non‐standard DPI — Adjusts the height of the program to make the windows fit on 
your screen. For this change to take effect, you must exit and restart the program. 

 Useful Information 

Select this option if you're having trouble viewing the entire program on your monitor. 

 Set to Minimum Size — Reduces the screen resolution to 640 x 510, or the minimum size your 
monitor allows. 

 Set to Maximum Size — Enlarges the screen resolution to the maximum size your monitor 
allows. 

 Set to 800 x 600 — Sets the program window size to 800 pixels by 600 pixels, suitable for many 
smaller monitors. 

 Set to 1024 x 750 — Sets the program window size to 1024 pixels by 750 pixels, suitable for 
many larger monitors. 

 Default/10% Larger/20% Larger Font — Sets the size of the text used in windows throughout the 
program. Select larger fonts for easier readability. 
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Configure the Home Screen 

The Home window displays each time you start the program. From here, you can use the ribbon, tabs, 
navigation panes, and Quick Access toolbar to navigate through the program. 

From any program window, you can access the Home window by clicking   on the Quick Access toolbar. 

 
Fig. 15‐15. 

You can customize your Home window by: 

 Adding a photo background 

 Displaying or hiding the Getting Started Checklist button 

 Moving and resizing items in the window 

 Change the Name of the Program. For example, instead of "PDS Formation Office," you can 
display "Parish Management" or "Mary's Formation Office." 

To customize your Home window  

1. On the Quick Access toolbar, click  . The Screen Information dialog box displays. 

2. Under the Configure Home Screen section, make your selections. 

 Useful Information 

You may want to change the program name to customize your program or to indicate which 
organization you are working with if you have multiple locations. 

3. Click Save/OK. 
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General Information 
The dashboard is a customizable, statistics‐at‐a‐glance feature that lets you readily track the data that 
most interests you.  

On the Information tab, click Dashboard. The General Information section always displays in the upper 
left corner of this window. This data is continually updated. The dates in the General Information section 
update when you first run the program or when you run a fix or backup.  

 
Fig. 15‐16. 

View Log of User Activity  
The User Log records the date, time, and user name associated with activities performed or entries made 
in the program. To view the User Log, on the Administration tab, click View User Log.  

 
Fig. 15‐17. 

   



PDS Formation Office Additional Features  15 - 11 
 

   
Fig. 15‐18. 

Each entry displays the following:  

 The Date & Time of the activity. 

 The User Name associated with who performed the activity. If user names are not required to 
use the program, “PDS User” displays here. 

 The Activity Performed and if it was completed or cancelled. 

 The Program Name and Sub‐Group columns are helpful in situations where you have multiple 
programs connected to the same database. Depending on your resolution, you may have to scroll 
to the right to view these columns.  

To select a viewing order, click Order by. By default, Logged is selected. This is the order that users enter 
the program. It is different from Date & Time if you are on a network and clock settings on all computers 
do not match. You can also order by Date & Time, User Name, and Activity Performed.  

On the Initial Setup dialog box (found on the File menu under Setup), there is an option to Ask for Reason 
of Significant Changes. If this option is selected, when you make a change, the program keeps a log of 
those important changes.  

With this option enabled on the View User Log of Activity dialog box, you can filter the list to: 

 View all Logged Items 

 View only Changed Items 

 View only Deleted Items 

To print the entire log, click Log Report. The report will be sorted by the Order by selection and print 
items based on your filtered selection. 
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List of Users Currently in Program  
The List of Users Currently in Program displays who is in the program. This list is helpful if you are 
attempting to run a process such as a backup that requires other users to exit the program. Names are 
recorded only if they are required when entering the program. To access this list, on the Quick Access 
toolbar, click the Who is Running icon. 

 
Fig. 15‐19. 

 
Fig. 15‐20. 

Favorites  
Access a list of your favorite locations in the program. On the Quick Access toolbar, click the Favorites 
icon. Click Add Favorite to add the current program location to your list of favorite places. Click any entry 
to jump straight to the specified window. If you have set up users and passwords, the program maintains 
a separate list of favorite locations for each user.  

 
Fig. 15‐21. 

Within the Favorites list, you can right‐click favorite items to organize this list: 

 Delete This Item – Remove the selected item from the list. 

 Move This Item Up – Move the selected item up in the list. 

 Move This Item Down – Move the selected item down in the list. 

 Rename This Item – Rename the selected item from the list.    
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Help  
Display the online Help for the program. There are several ways to access Help: 

 On the far right of the ribbon, click the Help icon  . 

 On the File menu, click User Guide > User Guide. 

 On any data window, press the F1 key on your keyboard to access information about that section 
of the User Guide. 

 
Fig. 15‐22. 

Users & Passwords 
Requiring a user name or both a user name and password to access the program is an optional feature. 
However, we strongly recommend you use this feature.  

If the program is not set up to ask for a name or a name and password, anyone can enter the program, 
look at your data, and make changes to it.  

There are several key advantages of requiring user names:  

 Restricting who can enter your program. 

 Logging the user name with the processes performed so you can determine which changes each 
user made. 

 Each user can define preferences for entering names in the program. 

 The administrator to see who is currently using the program. To access this list, click   on the 
toolbar. 
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Requiring passwords along with user names:  

 Further restricts who can access your program data. A user name may not provide enough 
security to prevent someone from entering the program. 

 Allows you to set which users have access to perform specific processes. 

On the Administration tab, click Users & Passwords.  

 
Fig. 15‐23. 

Adding a User 
To create a new user, click Add User. Enter information about the user as described below.  

User Name — Enter the name of the user. This is what they will type when entering the program. This 
does not have to be the user’s full name or real name. For example, Suzanne might want her user name to 
be “Susie Q” or “Sue”. The user name is not case‐sensitive. 

Password — If you require users to have a password to enter the program, enter it here. The program 
never displays the real password, but displays X’s instead. Passwords are case‐sensitive. 

Security Adm — At least one person must be a security administrator. This person must have all access to 
all parts of the program, including the User/Password information. This person is responsible for creating 
and maintaining all user accounts and changing or resetting other users’ forgotten passwords. For this 
reason, you should also have a second or backup administrator. 

Phone Number — Enter a telephone number where this user can be reached outside of the office. Select 
Unlisted if this number should not be shared with others. 
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Copying Existing Users 
If you have several users with similar roles, you can use the Copy Existing User command in the 
navigation pane. Select the user with the most similar role, and click Copy User. This creates a "Copy of 
<User Name>" record for you to rename. The Access and Privileges settings are initially the same as the 
selected user, but can be modified without affecting the original record.  

 
Fig. 15‐24. 

About User Preferences 
Each user can select a preferred method for entering names in the program. Remember, when set to All 
Access or View Only Access, a user can change their user preferences. Otherwise, the security 
administrator must set up and maintain each user's preferences.  

Enter the name parts on separate lines — This is the default option when the program is installed. When 
you begin entering a name, this option automatically displays the name breakdown window so you can 
enter the parts of the name: Last Name, First Name, Title, and Suffix. As parts of a name are entered on 
separate lines, the name formats for the Name, Mailing Name, Formal Salutation, and Informal 
Salutation are built.  

Enter entire name on a single line ‐ automatically display dialog — When you begin entering a name, this 
option automatically displays the name breakdown window. In the Name field, enter the last name, first 
name, title, and suffix. As you enter the entire name on the single line, the Mailing Name, Salutation, and 
the parts of the name (Last Name, First Name, Title, and Suffix), are filled in automatically. You can edit 
the name fields at any time. 

Enter entire name on a single line ‐ do not automatically display dialog — This option does not 
automatically display the dialog box. Names are entered in the appropriate window. To verify the Name, 

Mailing Name, Formal Salutation, and Informal Salutation formats are correct, you must click   after 
the Name field to go to the name breakdown window. 
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About Access and Privileges 
In this window, indicate which parts of the program the user can access. There are three levels of access: 
No Access, View Only Access, and All Access.  

Security administrators must have all access to at least the User Names section. Other users can have any 
combination of access that the security administrator sees fit.  

You cannot have higher access to a detail category than you have to a general category. For example, you 
cannot have All Access to the Confidential Student Remarks option if you have View Only access to the 
Students section.  

 
Fig. 15‐25. 

Individual Fund Access 
In the navigation pane of the Users & Passwords window, click Individual Fund Access to set the user's 
access to funds. Security administrators should have all access to all funds. 

 
Fig. 15‐26. 
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Selecting a Security Method 
You can select the security method option you prefer. This is what users are asked for before entering the 
program. The first time you access the Users and Passwords window, you must select a security method. 
In the navigation pane, click Set Security Method, and select one of the following methods:  

 
Fig. 15‐27. 

 Useful Information 

Changes to the security method do not take effect until you exit the program and restart it. 

 

None. The user is not asked for anything — Users do not enter a user name or password to access the 
program.  

The user is asked for a name — Users must enter a name but not a password. The name must be set up 
under Users & Passwords.  

The user is asked for both a name and a password — Users must enter a name and a password. If the 
security method is set for both a name and password, then each user is required to have a user name set 
up under Users & Passwords.  

The user name is detected by Windows authentication – The PDS user name must match that used to log 
in to Windows®. On startup, if an active PDS user name matches somebody who is logged into Windows®, 
then the user can access PDS without additional prompting. 

 Useful Information 

Only select this option if your network is secure, you trust the Windows® login process, the computers are 
in reasonably secure locations, and you don't share passwords with others. 

 

The user name is detected by OnDemand authentication – The PDS user name must match that used to 
log in to OnDemand. On startup, if an active PDS user name matches somebody who is logged into 
OnDemand, then the user can access PDS without additional prompting.  
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About Setup Options 
There are additional configuration options that you should set up before using the program. Family and 
student ID numbers can be assigned manually, automatically, or left blank. Configuration options are 
located on the File menu, under Setup > ID Number Options. 

 
Fig. 15‐28. 

The Initial Setup Window 
In the Initial Setup window, you can specify various program options and preferences, such as the default 
picture location, the organization's Federal ID for end‐of‐year tax statements, etc. 

 
Fig. 15‐29. 
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To specify program options and set the default picture directory  

1. On the File menu, click Setup > Initial Setup. 

2. If you plan to attach digital images of families or members, you need to specify the Default 
Picture Subdirectory. In order for the images to be included in automatic data backups, set the 
default location to the Pictures folder inside the PDS Formation data folder. For example, 
X:\PDSForm\Data\Pictures. This increases the size of your backup. If you set the default location 
outside the PDS Data folder, you must remember to manually back up the digital images. To 
specify the default location, click Browse. Navigate to the picture subdirectory and click OK. 

3. Enter the Federal ID# for Statements. This field is optional. 

4. Use the drop‐down list to specify when the program should automatically check for updates. 

5. Enter the path where you store documents that are associated with families and members. 

6. On the Program Options tab, under Program Options, select one or more of the options. Under 
Sharing Data Options, select one or more of the options. Under Fund Recap Defaults, select one 
of the options to specify how fund totals are reported in the Recap section of the Tuition & Fees 
window. Under Family Information, enter the appropriate text. 

7. On the Students Options tab, for Sacrament Sponsor Format, select how you want the sponsor 
name to print on sacrament certificates. Under Student Information, enter the terms you want 
to display in the User Defined Remarks section of the Students Detail window. Under Attendance 
Totals, select how to consider excused absences, unexcused absences, and tardies when totaling 
absences. 

8. On the Personnel tab, under Other Benefits, enter the terms you want to use for benefits that 
display on the Other Benefits tab, found on the Health/Insurance Personnel window. Under 
Sharing Personnel Data Options, select whether or not to share certain personnel data from 
Formation with the Church or School Office programs. 

9. Click Save/OK > Close. 
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Program Options 

Weekly is Weekly on Sunday — When selected, the program will calculate recurring terms and rates 
based on the number of Sundays in the recurring period. In the Tuition & Fees window, when you set up a 
recurring charge and select the terms, by default, the Weekly option looks at the selected starting date 
and calculates the amount based on the number of times that day of the week falls within the recurring 
period. If the starting date is on a Wednesday and you select Weekly, the recurring charge will apply every 
week on Wednesday, which may affect how the amount is calculated. For example, there can be 53 
Wednesdays in a year, but only 52 Sundays. 

Warn if Change ID or Name — When selected, you will receive a warning when you change a family or 
member name or ID number. 

Save Order when Exit Program — When selected, users can save the navigation order set in the main 
data entry windows. 

Processes Should Affect Family Date Changed — When selected, this option alters the Screen Changed 
date on the family record every time a process is run. 

Ask for Reason on Significant Changes — When selected, the program will automatically log occurrences 
of important changes to family information and the reasons for the changes. Changes to the following 
family information apply: 

 Family Name 

 Street Address 

 City/State 

 ZIP/Postal 

 Deleting email address 

 Information to be synched with the diocese 

 Family status (active or inactive) 

 Deleting a family 

 Deleting a student, or parent/guardian 

If changes are made in another PDS program  that is synched with the current PDS program, those 
changes display in red. When you make a change to specified family information and click Save, a dialog 
box displays the change. 

 
Fig. 15‐30. 

 General Reason for Change — Select a general reason for change from the drop‐down list. 

 More Info. for the Change — Enter more information about the change. 

 Original Value — This field contains the information as it appeared in the program before the 
change. 
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 New Value — This field contains the information as it appears in the program after the change. 

You can view logged changes and reasons from three separate locations within the program: 

 The Reason for Changes link in the navigation pane of the Families window. 

 The View Log of User Activity dialog box. 

Default to Student Personal Window — If selected, when you click Students on the Information tab, the 
Personal window displays. If cleared, the Detail window displays first. 

Disable Add Head/Spouse when Add Family — Normally, the program defaults to adding the head or 
spouse record when adding a family record. When this option is selected, the program will not 
automatically add a head or spouse. 

Disable Family/Member Name Change Help — Normally, the program asks several questions if the user 
changes family or member names. When this option is selected, the question dialog box is disabled. 

Default to Show Totals for All Funds — When selected, the display default for fund totals is show totals 
for all funds. 

Processes Should Affect Member Date Changed — When selected, this option alters the Screen Changed 
date on the member record every time a process is run. 

Rates can be Charges or Payments — When selected, this option sets a recurring activity as either a 
charge or a payment. If cleared, it will only allow you to have a recurring activity as a charge. 

Sharing Data Options 

In this section, you can control settings that are used when you share the database with other PDS Office 
programs. In Church Office, you must enable the selected field you want to share, then in the Initial Setup 
window of Formation Office, you must select to use the shared field. 

Share Church Inactive Flags — When selected, you have the option of sharing the Inactive status with the 
Church Office program. 

Share Family Keywords with Other Office Programs — When selected, you have the option of sharing the 
family keywords list with the Church Office program. 

Share Date Registered with Other Office Programs — When selected, you have the option of sharing the 
registration date with the Church Office program. 

Share Family Remarks with Other Office Programs — When selected, you have the option of sharing the 
remarks entered in the Families window with the Church Office program. 

Fund Recap Defaults 

Select if you want the totals in the Recap/Totals section of the Tuition & Fees window to default to totals 
to date or the grand total. 

Family/Member 

1st Name in Family Name — Enter a description for the first name entered in the Family Name dialog box, 
such as “Head of Household”. 

2nd Name in Family Name — Enter a description for the second name entered in the Family Name dialog 
box, such as “Spouse”. 
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Student Options tab 

Sacrament Sponsor Format — Select how sponsor names print on sacrament certificates. 

Student Information — Edit the default Student Field values. These values display as the tab names at the 
bottom of the student's Detail window. 

Personnel Options tab  

Other Benefits Names — Set up to four custom benefit names to display in the personnel's 
Health/Insurance window. 

Sharing Personnel Data Options— Select whether to share certain personnel data from Formation Office 
with the other Office programs. 

Changing Title Definitions 
To change title definitions, on the File menu, click Setup > Title Definitions. This dialog box displays the 
different available family and member title abbreviations and operates, similar to a keyword list. You can 
add new titles or delete titles you no longer use. The default values in this dialog box also include a full list 
of military titles.  

 
Fig. 15‐31. 

To add a new title  

1. On the File menu, click Setup > Title Definitions. 

2. On the Title Definitions dialog box, click Insert Abbreviations. 

3. The program inserts a blank line at the end of the list on which you can add an abbreviation and 
titles. 

4. Use Reorder Abbreviations to move items in the list. 

5. Click Save/OK, then Close. 

Reorder — To save time, you can move more frequently used titles/abbreviations to the beginning of the 
list. To reorder the list numerically and then alphabetically, click Reorder and click Sort. 

Restore Default Values — Return to the original list of titles/abbreviations installed with the program. 
Any changes or additions you made to the list are removed. 

Print List — You can print this list. We suggest you provide a copy of this list to all those entering data to 
use as a quick reference. 
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Address Abbreviations 
The Address Abbreviations list can be used in a process to modify your addresses and when printing 
reports.  

To add or edit address abbreviations, on the File menu, click Setup > Address Abbreviations. 

 
Fig. 15‐32. 

 Useful Information 

Modifying this list of address abbreviations after running the Change Address process does not 
automatically change any addresses. 

Unit Name Definition 
If you track attendance, you use a unit of time, such as hour or day. This window displays the terms used 
when tracking attendance, catechist certification, and service/retreats.  

 
Fig. 15‐33. 

To specify a term for describing units  

1. On the File menu, click Setup > Unit Name Definition. 

2. In Name for Attendance Units, Name for Certification Units, and Name for Service/Retreat 
Units, enter a unit name up to ten characters. 

3. Click Save/OK > Close. 
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Setting Up Email and Text Providers 

Email Server Setup 

In this window, you can configure the bulk e‐mail capabilities of the program. You can also adjust these 
parameters when you choose to send a letter via email. On the File menu, click Setup > Email & Text 
Setup. 

 
Fig. 15‐34. 

Email Server (SMTP) — SMTP stands for Simple Mail Transfer Protocol. Obtain these settings from your 
Internet provider’s website or system administrator. 

Email Server Port — The default setting is 25. However, you can obtain this setting from your Internet 
provider or system administrator. 

 Useful Information 

The settings you enter in the Email Server and Email Server Port fields are typically the same as what is 
entered in your email client software. 

Server Requires Authentication — If your server requires authentication, select this check box. Enter your 
email account name and password. Select either Use TLS (GMail) or Use SSL (AT&T) according to which is 
your email server. 

Server Limits Emails — Some servers restrict the number or size of incoming and outgoing email 
messages. If your server does this, select this option and enter the Maximum Emails in a Batch and the 
Time Delay Between Batches in seconds. 

If an Error Occurs, Delay 30 Seconds and Retry Once — If your email server experiences an error, you can 
request that the PDS program try to resend after a 30 second delay. 

Disconnect and Reconnect After Every Email — If you would like your server to disconnect and reconnect 
after each sent email, select this option. 
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Text Message Provider Setup 

You can maintain a list of cellular providers and their corresponding message server addresses. This setup 
dialog box gives information for popular text providers. To locate information for other providers, contact 
the provider. 

 Important Note 

In order to send text messages, you must enter the proper information on the Email Server Setup tab, as 
the messages are delivered by email to the cellular provider. 

 

 
Fig. 15‐35. 
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Batch Number and Tax Limits 
Batch numbers are automatically assigned during financial quick postings. The batch numbers on this 
window are updated as they are used.  

The IRS requires substantiation for tax‐deductible cash contributions and for Quid Pro Quo contributions 
above a specified amount. Tax Limits refer to the IRS donation substantiation regulations, and this 
information can be obtained from the IRS. Enter the amounts in this window, and update amounts as IRS 
regulations change. 

 
Fig. 15‐36. 

To set up Batch Numbers and Tax Limit Information  

1. On the File menu, click Setup > Batch Number and Tax Limit Information. 

2. Enter the Next batch number to use for the quick posting of financial information. 

3. In the field labeled "The IRS requires substantiation for tax‐deductible cash contributions of what 
amount (or more)", enter the beginning amount at which the IRS requires substantiation. 

4. In the field labeled "The IRS requires substantiation for Quid Pro Quo contributions above what 
amount", enter the amount above which the IRS requires substantiation for Quid Pro Quo 
contributions. 

5. In "Should tax deductible cash contributions made to one or more funds on the same day be 
combined", select Yes or No. For example, should a $150 contribution to the organization and a 
$150 contribution to the Building Fund Drive made on the same day be combined as a $300 
contribution and then require substantiation? 
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Setting Up Your Electronic Fund Transfer Provider 
A company such as Vanco, in collaboration with PDS, can process one‐time or recurring collections to 
major credit cards, checking, and savings accounts electronically. Use this feature for weekly, monthly, or 
periodic contributions, pledge drive payments, or tuition and fee payments. 

To set up the EFT feature  

1. Contact a clearing house company such as Vanco to obtain a company ID and password.  

2. On the File menu, click Setup > Electronic Fund Transfer. 

3. To stop a family's regularly scheduled EFT deductions if their PDS account balance is zero or if 
they've made a fund overpayment, select Check for balance due when assigning EFT charges. 

 Useful Information 

If you don't select this option, the scheduled deduction occurs regardless. 

4. Select what you use for EFT transactions, and enter your information. 

5. When you're finished, click Save/OK > Close. 

You must enter the family’s terms and rates for payment before you can obtain the family’s bank account 
or credit card information.  

Setting the Default Font for Reports 
You can change the default font used for all reports. 

 Useful Information 

Reports are designed using Arial font. Prior to printing, the font is changed to the default font for reports. 

 

On the File menu, click Setup > Default Font for Reports. Click Set Font to select a font and size. Click 
Reset Default to change it back to size 10 Arial font. 

 
Fig. 15‐37. 

You can also change the base font for a single report in the report layout window. 
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Setting Catechist Certification Requirements 
With this option, you can set up your diocesan and other requirements for catechist certification. To 
access the Certification Requirements window, on the File menu, click Setup > Certification 
Requirements. 

 
Fig. 15‐38. 

There are ten levels (I through IX and Renewal) available on the Certification Requirements window. Each 
level's tab contains these following side tabs: 

 Requirements Recap — Lists all the required courses, elective courses, other requirements, and 
total units required for certification. The Recap window provides a summary of information on 
the status of all levels of certification. If you delete a course or requirement from this list, you can 
remove the course or requirement from all windows. 

 Required Courses — Lists all the courses required for certification as defined by your 
organization. 

 Elective Course — Lists all the courses that are not necessarily required for certification as 
defined by your organization. 

 Other Requirements — Lists the other requirements needed as defined by your organization for 
certification. You can manually enter a course name and description. 

To insert requirements  

1. On the File menu, click Setup > Certification Requirements. 

2. Select the level you want to insert a requirement for. 

3. Click a side tab to insert either required courses, elective courses, or other requirements. 

4. Click Insert, and enter the requirement information. 

5. Click Save/OK. 

You can assign required courses, elective courses, and other requirements for a particular level. After you 
assign requirements, all catechists must complete the requirements before moving to the next level. 

To assign requirements for a certain level  

1. On the File menu, click Setup > Certification Requirements. 

2. Select a Level tab or the Renewal tab. 
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3. To assign only the required courses, the elective courses, or the other requirements, click the 
corresponding side tab, and click Assign Requirements. 

4. To assign all the requirements for the level, click Requirements Recap and click Assign Req. 

 Useful Information 

Requirements are also added to the Certification section of the Catechists window. 

5. Click either Remove Courses/Reqs or Keep Courses/Reqs to remove or keep the existing 
requirements on the Certification window. 

 

You can also add requirements for all requirement levels and courses to the Catechists window. 

To assign requirements for all levels  

1. On the File menu, click Setup > Certification Requirements. 

2. At the bottom of the window, click Assign All Requirements. 

3. Click either Remove Requirements or Keep Requirements to remove or keep the existing 
requirements on the Certification window 

 
You can use a list of courses from another certification level and add them to your current level. 

To borrow a course  

1. On the File menu, click Setup > Certification Requirements. 

2. On the Elective Courses tab, click Borrow. 

3. Select the certification level you want to borrow. 

4. Click Save/OK. 

5. After the list is inserted, click Line Delete to remove items that aren't needed. 

Additional Field Information  

Reorder — We recommend that you use Reorder to move more frequently used items to the beginning of 
the list instead of deleting items you don't always use from the list. 

Print — Print a summary of the certification requirements and units for all levels, and print a certification 
worksheet for the requirements levels. Use the worksheet to record units completed or to set up courses 
and units. 
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Setting Up Special Days and Holidays 
With this option, you can set up important dates in the current year. These special days display on the 
Home window upon entry of the program and anytime you revisit the Home window. On the File menu, 
click Setup > Special Days & Holidays. 

 
Fig. 15‐39. 

Additional Field Information 

Special Date Name — If you used the Automatic Setup for a New Year button to add a list of Special 
Dates, a name displays here for each date that is set up. When adding your own special dates, you also 
enter your own date name. 

Calculation for Next Year — Determines when your special day or holiday displays in your Home 
window. You cannot delete or modify these predefined calculations. 

Automatic Setup for a New Year — Set up a list of predefined dates. You can replicate dates from a prior 
year or set up predefined secular, Canadian, Catholic, Jewish, or Eastern Orthodox dates. 

 Add new dates for — Enter a date range to set up dates. 

 Repeat dates already in the list — Set up dates for the new year based on dates that were 
previously set up. 

 Select predefined dates — Set up dates recognized as holidays and Holy Days. Click View Dates 
to see which dates are already included in the list. 

 Remove Dates from a Prior Year — Remove old entries for a date range that you specify. 

Backup & Restore 
The most valuable component of your computer system is its stored data. Guarding it against loss due to a 
natural disaster or a database corruption is important, especially when you must access your data as 
quickly as possible. We recommend that you back up your data each day and also store it in a secure, off‐
site location. The following topics can help you protect your data.  

Everyone knows you need to back up your data to prevent data loss. However, not everyone knows how 
to implement a successful backup strategy. 
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Planning a Backup Strategy 
To help you plan a backup strategy, we recommend the following: 

 Commit to a plan that includes a schedule for making daily or weekly backups. 

 Test your backup process and restore your data monthly or quarterly. 

 Store at least one month's worth of data on multiple sets of backup media for extra protection. 

 Keep a log to record dates and details about your backups. Include when the backup happened, 
who made the backup, and which backup set was used. 

 Each month, run the Test the Program and the Fix Data Discrepancies processes to identify and 
repair small problems. 

About PDS Backups 
You can create backups of your data both automatically and manually. With the Automatic Backup 
feature, your current data is backed up on the day(s) you select. You can also create a manual backup of 
your data at any time. 

About Internal Archive Folders 
You can manage the number of automatic and manual backup files stored in internal archive folders on 
your hard drive. Your program data folder contains the following internal archive folders:  Weekly, 
Monthly, Quarterly, and Yearly. 

When a backup file is created, it's stored in the Weekly folder. Depending on your automatic backup 
setting, the old backup files are automatically moved or deleted when a backup is complete. 

 
The files are moved from one folder to another in the following ways: 

 Weekly to Monthly 

 Monthly to Quarterly 

 Quarterly to Yearly 

About Data Compression 
The backup process compresses your data files into a compact archive. Compression reduces the file size 
and the amount of time required to copy the files to a disk. Backup files have a .pds extension. Although 
standard compression programs can read the backup files, we recommend using the integrated restore 
feature of the PDS program to restore lost or damaged data. 

Rotating Backup Sets 
We don't recommend using the same set of disks each time you create a backup. To reduce or eliminate 
the chance of data discrepancies and corruption, use different sets of disks every time you back up your 
data. 

For example, if you back up your data each Friday, use at least four backup sets in order to provide better 
protection. Label these disks Friday 1, Friday 2, Friday 3, and Friday 4. If you reuse backup media, be sure 
to replace them regularly to guarantee performance. 
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Backing Up Data Manually 
A backup is essentially a snapshot copy of your data (not your program or computer) at the time the 
backup is created. When that backup is restored, or copied back into the program, it will erase whatever 
data is there and replace it with that snapshot. 

 
Fig. 15‐40. 

Before you back up your data, make sure: 

 You have enough storage media to complete the backup. PDS backup files require at least 0.5 MB 
of free space. 

 You disable your computer's Hibernate, Sleep, or Stand By options. 

 All PDS users are logged out. 

 Your backup media is preformatted. 

When backing up your data: 

 Do not shut down or turn off the power to your computer. 

 Do not log off of the computer at any time during the backup process. 

To back up your data manually 

1. On the File menu, click Backup/Restore > Backup Data. 

2. Enter a backup reason for each backup that you make. This reason prints on the backup report 
and displays when it is time to restore the data. 

3. Select a backup method. 

 Back up to a selected drive – Select when backing up to a floppy disk. 

 Back up to a specific folder — Select when backing up to the hard drive, CD‐ROM, or 
any other large‐media drive. 

 Back up to an Internet FTP Server — Select to back up the data to an Internet website. 

4. Select a backup folder. This can be any drive/folder on your computer or network. If you selected 
to back up to an FTP Server, enter the FTP Server information. 

5. Click Start Backup. 
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Backing Up Data Automatically 
With the Automatic Backup feature, you can set your PDS program to automatically perform backups on 
selected days. 

 OnDemand Customers 

If you use OnDemand, your backups are automatically made each night and stored on the OnDemand 
server, so you do not need to schedule automatic backups. 

 

Before you set up automatic backups, you must: 

 Install PDS on the computer or server that stores the data. 

 Make sure that the computer or server is powered on at the time when the automatic backup is 
scheduled to run. 

 Close all PDS programs installed on other computers. 

 Enter your email address in the License Information window. If the program can't complete the 
automatic backup process, you receive an email notification. 
 

 Useful Information 

The Automatic Backup feature is not a substitute for manual backups. We recommend creating manual 
backup files of your data regularly. 

Scheduling Automatic Backups for Off‐Hours Using Windows 
If you want to run your backups after midnight on the scheduled backup day, you can set up a Windows® 
scheduled task. This isn't required, but otherwise, the PDS Automatic Backup feature can only run when 
you open your program on the scheduled backup day. 

If you create backup files for multiple PDS programs, you must schedule a task for each program. Make 
sure that the start time for each program is at least 15 minutes apart from any other previously‐scheduled 
task start time. If your PDS program is installed on a network, you must use the shared network name. 

 Useful Information 

The following procedure is for Microsoft® Windows 8® users. For information on creating a scheduled task 
in an earlier version of Windows, see the help documentation for your version. 

 

To create a scheduled task  

1. Locate the Windows Task Scheduler on your computer. 

2. In the Task Scheduler window, click Create Basic Task. The Create Basic Task wizard displays. 

3. Enter a name for the scheduled task, and click Next. 

4. In the Task Trigger window, select how frequently you want to create automatic backups, and 
click Next. 

5. If necessary, select the time, day, or month when you want the update to occur, and click Next. 

6. In the Action window, select Start a program, and click Next. 
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7. In the Start a Program window, click Browse, select the PDS program application you want to 
create a scheduled task for, and click Open. The program path appears in the Program/script 
field, and should have an .exe extension. 

 Useful Information 

If the information does not display in the Program/script field, right‐click on the PDS desktop 
icon, and click Properties. Copy the information that displays in the Target field and paste it in 
the Program/script field of Windows Scheduler. At the end of the text, enter "BACKUP". 

8. In the Add arguments field, enter "BACKUP". Click Next. 

9. Review the information, and click Finish. 

Scheduling an Automatic Backup in Your PDS Program 

Once you create a scheduled task in Windows, you must set an automatic backup schedule in your PDS 
program. You can also set up the Automatic Backup process to run without scheduling a Windows 
scheduled task. 

 
Fig. 15‐41. 

To schedule an automatic backup  

1. On the File menu, click Backup/Restore > Backup Options. 

2. Select the day(s) of the week that you want an automatic backup to run. 

3. To select the internal archive folder where you store the automatic backup, click Browse. To use 
the default backup folder, leave this field blank. 

4. If your internal archive folder is on another computer, enter the UNC reference to the folder. 

   Useful Information 

This prevents problems for multiple workstations using different drive letters to access the 
shared folder. For example, enter "\\ServerName\ShareName" instead of "F:\Backup". 

5. Select a level of protection for your internal archive files. See more information about these 
option below. 

6. Click Close. 
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About the Minimum Option 

If you select the Minimum option, one backup file is stored in each internal archive folder. 

Folder 
Name 

Minimum Number of Backup Files in 
Each Folder 

Amount of Time Before Backup is Discarded or 
Moved 

Weekly  1 backup file  7 days

Monthly  1 backup file  30 days

Quarterly  1 backup file  90 days

Yearly  1 backup file  365 days

 

 

About the Moderate Option 

If you select the Moderate option, several backup files are stored in each internal archive folder. 

Folder 
Name 

Minimum Number of Backup Files in 
Each Folder 

Amount of Time Before Backup is Discarded or 
Moved 

Weekly  5 backup files  21 days

Monthly  2 backup files  60 days

Quarterly  3 backup files  270 days

Yearly  3 backup files  1095 days

 

About the Maximum Option 

If you select the Maximum option, the maximum number of backup files are stored in each internal 
archive folder. 

Folder 
Name 

Minimum Number of Backup Files in 
Each Folder 

Amount of Time Before Backup is Discarded or 
Moved 

Weekly  10 backup files  28 days

Monthly  4 backup files  90 days

Quarterly  6 backup files  360 days

Yearly  7 backup files  2555 days

Restoring Data from a Previous Backup 
This is the reverse of a backup. A backup is essentially a snapshot copy of your data (not your program or 
computer) at the time the backup is created. When that backup is restored, or copied back, into the 
program, it erases whatever data is there and replaces it with that snapshot.  

 OnDemand Customers 

 If you use OnDemand and need to restore a previous backup, contact Support at 1‐877‐737‐4457. 
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With this process, you can: 

 Restore data from a backup file. For example, if you enter a large amount of incorrect data, you 
can restore a previous version of the data then enter the correct information. 

 Move data to a newly purchased computer. 

 Replace files lost due to hard drive failure or file damage. 

 Useful Information 

You cannot restore backup data from read‐only media such as CD‐ROM disks. To restore data included on 
read‐only media, copy the file to a rewritable drive, then clear the Read‐only option in the Microsoft 
Windows file properties dialog box. 

 

 Be Careful 

When you restore data from a backup, you overwrite data entered after the backup was created. 

 

To restore data from a prior backup 

1. On the File menu, click Backup/Restore > Restore Data. 

 
Fig. 15‐42. 

2. Select where to restore the data from and which backup to restore, then click Next. You can 
restore data from all of the same places to which you can back up the data: Drive, Specific 
Folder, and Internet FTP Server. To restore data from the automatic backups done by the 
computer, select Internal Archive Folder. 

3. If you want to restore specific parts of the data, click Advanced Restore Options. For example, if 
you created a custom user report and someone deleted it, you can restore just this report using 
the Advanced Restore Options. Select the backup containing the report you want to restore, then 
select the check boxes of the files associated with this report, and click Apply/OK. 
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 Warning 

Do not use Advanced Restore Options unless you understand the database. If you restore an 
incorrect set of files, the program will not function properly. If this happens, use the PDS Rescue 
program to restore all your files.  

 

 
Fig. 15‐43. 

4. Click Start Restore to begin restoring data. 

Moving Archived Files to Another Computer 
With this process, you can move the active data file and the internal archive data from your hard drive to 
another computer. 

 
Fig. 15‐44. 
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First, you must save archive files from your old computer. 

To save archive files  

1. On the File menu, click Backup/Restore > Move to Another Computer. 

2. Select an archive method. 

3. Select or enter the drive or folder where you want to save your archive files. 

4. Click Save Archive Files to Disk. 

 

Before loading archive files to a new computer, you must set up the computer. 

First, install the PDS program. When you run PDS for the first time, the Registration/System Information 
wizard displays. Select New User to create an empty data file. 

To load archive files  

1. On the File menu, click Backup/Restore > Move to Another Computer. 

2. Select an archive method. 

3. Select or enter the drive/folder to load your archive files from. 

4. Click Load Archive Files From Disk. All of the internal archive files from the backup drive are 
decompressed, and the current data is restored. 

Testing, Fixing, & Rescue 
Use the Test and Fix utilities to examine the stability of the program and data, and view any data 
inconsistencies. We recommend running these utilities once a month. 

Testing the Program 
With this process, you can verify that data files are in good shape. The program and data files can develop 
discrepancies as a result of improper system shutdown, operating system failure, hard drive failure, 
computer virus infection, network failure, or other computer complications. To minimize this risk, back up 
your data regularly. 

We recommend periodically running this process to test for data discrepancies, missing files, or 
configuration issues. To access this process, on the File menu, click Test/Fix > Test the Program. A dialog 
box displays stating what parts of the program were tested. 

 
Fig. 15‐45. 
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Once the Test the Program process passes without errors, run the Fix Data Discrepancies process to verify 
that your data is correct. 

Fixing Data Discrepancies 
With this process, you can verify that the program does not contain data discrepancies. The program and 
data files can develop discrepancies as a result of improper system shutdown, operating system failure, 
hard drive failure, computer virus infection, network failure, or other computer complications. To 
minimize this risk, back up your data regularly. 

 Warning 

This process can repair some small problems with the data. If severe discrepancies exist, you can restore 
data from a recent backup. If this happens, however, all information entered since the last backup is lost. 

 

To fix data discrepancies  

1. On the File menu, click Test/Fix > Fix Data Discrepancies. 

2. If the "index out of date" error displays, select Reindex Tables. To remove empty space in the 
data tables, select Pack Tables. 

3. Click Fix Data. After the process is finished, a summary report displays. 

4. When you're finished, click Close. 

Using the Rescue Program 
The Rescue program is located on the program CD. If you downloaded your PDS program from the web, 
the Rescue program is in the Setup program, and its icon is a red cross. Use this to back up, restore, and 
run the Test and Fix utilities when you cannot open the program in the usual way. You can also use the 
Rescue program to erase data files and disable passwords.  

 
Fig. 15‐46. 

 Be Careful 

Use the Rescue program as a last resort for password information. If there are other security 
administrators, ask them to set up another password for you. 
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When you installed the program from the CD or downloaded it from our website, if you selected to Save 
Full Setup in Update Folder, then you can access the Rescue program using the setup installed on the 
computer in the program's Update folder. 

 
Fig. 15‐47. 

Before using the Rescue program, exit all open programs on your computer. All other users must exit the 
PDS program before you continue. 

To use the rescue program  

1. From either your PDS program CD or your local installation directory, double‐click and run the 
FormationOffice7Setup.exe file. 

2. To access the Rescue program, click the red cross in the bottom left of the Setup window. 

3. When you're ready to run the Rescue program, click Next. 

4. Select your program, and click OK. 

Disable Passwords 
You can disable all passwords if, for example, the security administrator has forgotten his or her password 
or an error prevents the program from starting correctly. 

The Disable Passwords process doesn't delete user settings or passwords, but it disables the requirement 
of providing a name or password when entering the program. 

To disable passwords  

1. In the Rescue Program dialog box, click the Disable Passwords tab. 

2. Verify or enter the path for the data folder. 

3. Click Disable Passwords. 
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Erase Data Files 
You can set up an empty data file, convert data from an old data file, or restore from a prior backup. 

 Be Careful 

Use this command only as a last resort. 

To erase data files  

1. In the Rescue Program dialog box, click the Erase Data Files tab. 

2. Verify or enter the path for the data folder. 

3. Make your selections. For more on these options, see the Additional Field Information below. 

4. Click Erase Data Files. 

Additional Field Information 

Keep License — Keep your program license information after erasing data files. If you don't select this 
option, you must re‐enter the license information when the program opens. 

Erase Files From Clipart — Erase clipart files from the Clipart folder located inside the Data folder. These 
files must be erased before reconverting from the old data file and should be erased if you have data 
discrepancies. 

Erase Files from Reports — Erase report files from the Reports folders, including easy and custom reports. 
These files must be erased before reconverting from the old data file, and should be erased if you have 
data discrepancies. 

SQL 

 Warning 

PDS is not responsible for any data changes made when you use this utility. It's provided solely for 
individuals who are familiar with database manipulation with SQL and need to correct an error in their 
data or run a specific query. 

 

Structured Query Language (SQL) is commonly used in database programs to access the raw data files. 

To structure query language  

1. In the Rescue Program dialog box, click the SQL tab. 

2. Verify or enter the path for the data folder. 

3. Enter the SQL statement, and click Exec to execute the changes made to the data fields. 

4. Click Open to process the query and display the results. 

5. Click Save Results to save the results in a Comma‐Separated Value (.csv) file. 
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Exercises 
Exercise #1 

Change the program name to “Sue’s Favorite Program”, but use your own name. 

Exercise #2 

Create a user profile for yourself, including a password. Make yourself a security administrator, and give 
yourself All Access to everything, including Individual Funds. 

Exercise #3 

Set the security method to ask for name and password. 

Exercise #4 

Add HRH – ‘Her Royal Highness’ – to the Title Definitions. 

 

Questions 
Answer these questions pertaining to additional features. 

Q: Where do you go to change the term used for tracking Service/Retreat attendance? 

A:                      

 

Q: Where do you maintain the names and addresses of the churches tracked in Sacraments? 

A:                      
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16: Sacramental Registers 
 

 Useful Information 
To use this feature, you must purchase it by calling 800‐892‐5202. For more information, visit 
www.parishdata.com/sacramentaltracking. 

 

With the Sacramental Registers feature, you can locate, view, manage, and print member sacrament 
records. Before you can create sacramental registers, you must set up your sacrament options. 

After setting up your sacrament options, you can define sacrament register options if you need to track 
the sacrament records of other churches in a multi‐church situation. For example, your church might 
maintain sacrament data for smaller churches in the same cluster or for missions. 

The sacramental registers are operated from the Sacramental Register tab after you briefly define some 
keyword associations through the File menu under Sacrament Setup. Changes made to the Sacramental 
Registers tabs are reflected in the Sacraments section of the individual's record and vice‐versa. 

Preparing to Use Sacramental Register 
First, while not required, you should update your list of sacrament place names to get rid of duplicate 
entries. Whenever you manually enter a place instead of selecting it from the drop‐down lists, it is added 
to the list of available places, even if that item is already in the list. Furthermore, a place might have been 
entered with one or more spellings. “St. Mary’s,” for instance, might exist alongside “St. Marys” and 
“Saint Mary’s.” If this is the case, you can combine duplicate sacrament place names. 

 
Fig. 16‐1. 

To combine duplicate sacrament place names  

1. On the File menu, click Sacrament Setup > Sacrament Place Names and Addresses. 

2. Click Combine. 

3. In the left pane, select the place names you no longer want to use. Hold down the Ctrl key while 
clicking to select more than one name. 
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4. In the right pane, select the place name that should replace the places you selected in the left 
pane. 

5. Click Add to List of Changes Below. 

6. Repeat this for any other sacrament places you want to combine. 

7. Review the list of changes in the lower pane. 

8. Click Combine/OK. 

 

Next, select the sacrament keywords to be used. Some like to specify their own sacrament keywords 
other than those built into the program. Because of this, the Sacramental Registers system process is not 
pre‐programmed to search for data associated with any specific sacrament keywords. So, defining which 
keywords you use to denote the various sacraments is a necessary step before using the sacramental 
register. 

 
Fig. 16‐2. 

To set up keyword definitions for the sacramental registers  

1. On the File menu, click Sacrament Setup > Sacrament Tab Names. 

2. On the Sacrament Definitions tab, select the keywords your organization uses to denote 
baptism, confirmation, first communion, marriage, and death. Typically, Name for Baptism will 
be Baptism, and so on. If necessary, click the Sacrament Names tab to see which keywords are 
being used in your program; these associations are reflected as the sacrament tab names in the 
Students window. 

3. Click Save/OK, then Close. 
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Finally, define sacrament register options. This is only necessary if you need to track the sacrament 
records of other churches in a multi‐church situation. Suppose, for instance, your church maintains 
sacrament data for smaller churches in the same cluster or for missions. Follow this procedure to specify 
those churches. 

 
Fig. 16‐3. 

To set up sacramental data for more than one church  

1. On the File menu, click Sacrament Setup > Sacrament Tab Names. 

2. On the Sacramental Register Options tab, select Our Data Contains Sacramental Register 
Information for More than One Church. 

3. Select up to five churches whose sacramental records are included in your database. 

4. Click Rebuild Sacramental Registers. 

 Caution 

When you click Rebuild Sacramental Registers, it removes all existing member information and 
rebuilds it. Non‐member information is not affected. If you click Cancel before the process is 
completed, all sacramental register information for existing parishioners is lost and you will have 
to run the process again.  
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About Creating Sacramental Registers 
Create your sacramental registers by opening the Sacramental Registers. 

 
Fig. 16‐4. 

To create your sacramental register  

1. On the Sacramental Register tab, click Sacramental Registers. 

2. The first time you use Sacramental Registers, the program compiles a list of records associated 
with sacrament keywords. 

3. Edit and update the records, as needed, in the grid. Click Save/OK after making changes. Changes 
made to a record here are reflected also in the Sacraments section of the Students window. 

4. Click Close. 

 Useful Information 
If you track sacraments for multiple churches (a cluster or missions, for example), a drop‐down list 
displays in the lower‐right corner of the Sacramental Registers window. Use this to filter the entries in the 
grid. 
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Additional Field Information 
Print Certificate Back — Click to display the Certificate Back Page dialog box. If you select Mark as Invalid 
for Marriage, then the statement "Not Valid for Marriage" displays on the back page of the certificate. 
Information entered in the Notations text box displays in the Notations section. 

 
Fig. 16‐5. 

Print Index — Print an index view (single‐line entries) of the register for the open current sacrament tab. 
Enter the volume you want to print. You are also asked whether to sort the entries alphabetically or by 
page number. 

Print Register — Print a detailed report of the register for the sacrament on the open tab. Enter the 
volume you want to print. 

Order — Sort the entries in the grid by volume/page, name, or date. 

Field View/Quick Posting — Use this view to see and edit the details of each record. For more on editing 
records using the field view, see About Editing Sacramental Records. 

Register Search — Search the sacramental registers for a record. 

Print Certificate — Print certificates for a record. 

Print Notification — Print a notification letter for Confirmation, First Eucharist, or Marriage. Print 
notification is not available for the Baptism or Deceased registers. 

Refresh Member Info — Refresh information within the member record. Click Refresh Member Info to 
compare the sacramental register and member record. Then the program can update the sacramental 
register with the member record information according to your selection in the Confirm dialog box. 

 Be Careful 

This is different from the Rebuild Sacramental Registers button located on the Sacramental Register 
Options tab. 
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About Adding Sacramental Records 
You can add sacramental records to each register for members as needed. 

 
Fig. 16‐6. 

To add a record  

1. On the Sacramental Register tab, click Sacramental Registers. 

2. Click the appropriate sacrament tab. 

3. Click Field View/Quick Posting. 

4. Click Add Next Entry. The fields on the tab clear. 

5. Enter the new sacrament record information, or click the double arrows in front of Name to 
open the Get Existing Member dialog box. If entering sacrament information for an existing 
member, select the member, then click Use/OK. 

6. Once you enter all relevant information for the sacrament, click Save/OK. 

About Deleting Sacramental Records 
You can delete sacramental records when needed. 

To delete a record  

1. On the Sacramental Register tab, click Sacramental Registers. 

2. Click Register Search, and enter the information for the record you want to delete. 

3. Click Search. 

4. In the grid, double‐click the record you want to delete. 

5. Click Delete Entry. 

6. Click Yes to confirm the deletion. 
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 Useful Information 
When you delete a member’s record in the Students window, the Sacramental Register retains 
any sacramental information associated with the member, unless you delete the sacrament 
record as described above. 

 

About Locating Sacramental Records 
If you know the type of sacrament and the name associated with a record, you can probably scroll 
through the list view to locate it. For a more advanced search, you can use the Register Search. 

To search for records in the Sacramental Registers  

1. On the Sacramental Register tab, click Sacramental Registers. 

2. Click Register Search. 

3. Select the check boxes to indicate which type(s) of sacraments to search. 

4. Enter as much or little information as you want to in the remaining fields. 

5. Click Search. A Search Results grid opens to display the results. 

6. Double‐click an entry to open the record. 

About Editing Sacramental Records 
The Sacramental Registers contain more detailed information than the Sacraments section of the 
individual's record. Once you have populated the tabs with existing records from your database, you 
might want edit or add more information. 

To edit records in the Sacramental Registers  

1. On the Sacramental Register tab, click Sacramental Registers. 

2. Locate the record you want to edit either by scrolling through the grid or by using the Register 
Search. 

3. Double‐click the name in the grid. The Register Entry view opens. 

4. Edit the fields as needed. 

5. Click Save/OK. 
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17: Appendix 
 

Predefined Fund Setups 
The program contains several predefined fund setups that you can use as models for your funds. 

Church Contributions 
Group  Activity Function

Donation to Church   

  Offering Payment‐Deductible 

  Holy Days Payment‐Deductible 

  Easter Donations Payment‐Deductible 

  Christmas Donations Payment‐Deductible 

  Total Donations Group Total 

Misc. Activities   

  Non‐Cash Donation Non‐Cash Contribution‐Deductible

  Fall Dinner/Dance $20 Quid Pro Quo 

  Flower Donation Payment‐Deductible 

  Homeless Shelter Payment‐Deductible 

  ISF Check Ignore

Church Contributions with Extra Contributions 
Group  Activity Function

Donation to Church   

  Offering Payment‐Deductible 

  Holy Days Payment‐Deductible 

  Easter Donations Payment‐Deductible 

  Christmas Donations Payment‐Deductible 

  Total Donations Group Total 

Extra Contributions   

  Missions Payment‐Deductible 

  Charity & Development Payment‐Deductible 

  Rice Bowl Payment‐Deductible 

  Bishop’s Relief Payment‐Deductible 
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  Special Needs Payment‐Deductible 

  Communication Payment‐Deductible 

  Home Missions Payment‐Deductible 

  Propagation of Faith Payment‐Deductible 

  Retirement Fund Payment‐Deductible 

  Emergency Fund Payment‐Deductible 

  Total Extra Group Total 

Misc. Activities   

  Non‐Cash Donation Non‐Cash Contribution‐Deductible

  Fall Dinner/Dance $20 Quid Pro Quo 

  Flower Donation Payment‐Deductible 

  Homeless Shelter Payment‐Deductible 

  ISF Check Ignore

Stewardship 
Group  Activity Function

Donations to Church   

  Pledged Payment Due Charge

  Pmt/Pledge Payment‐Deductible 

  Holy Days Payment‐Deductible 

  Easter Donation Payment‐Deductible 

  Christmas Donation Payment‐Deductible 

  Pledge Balance Balance

Misc. Activities   

  Non‐Cash Donation Non‐Cash Contribution‐Deductible

  Fall Dinner/Dance $20 Quid Pro Quo 

  Flower Donation Payment‐Deductible 

  Homeless Shelter Payment‐Deductible 

  ISF Check Ignore
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Formation 
Group  Activity Function

Formation Tuition   

  Formation Tuition Due Charge

  Pmt/Formation Tuition Payment‐Non‐Deductible 

  Pmt/Formation Tuition From Last 
Yr 

Payment from Last Year‐Non‐Deductible

  Catechist Tuition Credits Credits‐Non‐Deductible 

  Refund/Formation Tuition Refund‐Non‐Deductible 

  Formation Tuition Balance Balance

Next Year’s Tuition   

  Next Year Formation Tuition Due Charge

  Pmt/Next Year Formation Tuition Payment‐Non‐Deductible 

  Next Year Formation Tuition Bal Balance

Registration Fee   

  Reg Fee Due Charge

  Pmt/Reg Fee Payment‐Non‐Deductible 

  Pmt/Reg Fee from Last Yr Payment from Last Year‐Non‐Deductible

  Refund/Reg Fee Refund‐Non‐Deductible 

  Reg Fee Balance Balance

Next Year’s 
Registration 

 

  Next Year Reg Fee Due Charge

  Pmt/Next Year Reg Fee Payment‐Non‐Deductible 

  Next Year Reg Fee Bal Balance

Book Fees   

  Book Fees Due Charge

  Pmt/Book Fees Payment‐Non‐Deductible 

  Refund/Book Fees Refund‐Non‐Deductible 

  Book Fee Balance Balance

Sacrament Preparation   

  Sac Prep Fee Due Charge

  Pmt/Sac Prep Fee Payment‐Non‐Deductible 

  Refund/Sac Prep Fee Refund‐Non‐Deductible 

  Sac Prep Fee Balance Balance

Prior Year   
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  Prior Year Tuition Due Charge

  Prior Year Fees Due Charge

  Pmt/Prior Year Payment‐Non‐Deductible 

  Prior Year Balance Balance

Late Charges   

  Late Charge Due Charge

  Pmt/Late Charge Payment‐Non‐Deductible 

  Late Charge Balance Balance

Volunteer/Service 
Hours 

 

  Hours Pledged Hours Pledged 

  Completed Hours Hours Completed 

  Hours Remaining Hours Remaining 

Misc. Activities   

  ISF Check Ignore

School Tuition 
Group  Activity Function

Tuition   

  Tuition Due Charge

  Pmt/Tuition Payment‐Non‐Deductible 

  Pmt/Tuition From Last Yr Payment from Last Year‐Non‐Deductible

  Tuition Credits Credits‐Non‐Deductible 

  Scholarship Credits Credits‐Non‐Deductible 

  Refund/Tuition Refund‐Non‐Deductible 

  Tuition Balance Balance

Next Year’s Tuition   

  Next Year Tuition Due Charge

  Pmt/Next Year Tuition Payment‐Non‐Deductible 

  Next Year Tuition Bal Balance

Registration Fee   

  Reg Fee Due Charge

  Pmt/Reg Fee Payment‐Non‐Deductible 

  Pmt/Reg Fee from Last Yr Payment from Last Year‐Non‐Deductible

  Refund/Reg Fee Refund‐Non‐Deductible 



PDS Formation Office Appendix  17 - 5 
 

  Reg Fee Balance Balance

Next Year’s 
Registration 

 

  Next Year Reg Fee Due Charge

  Pmt/Next Year Reg Fee Payment‐Non‐Deductible 

  Next Year Reg Fee Bal Balance

Book Fees   

  Book Fees Due Charge

  Pmt/Book Fees Payment‐Non‐Deductible 

  Refund/Book Fees Refund‐Non‐Deductible 

  Book Fee Balance Balance

Graduation Fee   

  Graduation Fee Due Charge

  Pmt/Graduation Fee Payment‐Non‐Deductible 

  Refund/ Graduation Fee Refund‐Non‐Deductible 

  Graduation Fee Balance Balance

Special Activities   

  Science Fee Due Charge

  Pmt/Science Fee Payment‐Non‐Deductible 

  Refund/Science Fee Refund‐Non‐Deductible 

  Science Fee Balance Balance

Bus Fee   

  Bus Fee Due Charge

  Pmt/Bus Fee Payment‐Non‐Deductible 

  Refund/Bus Fee Refund‐Non‐Deductible 

  Bus Fee Balance Balance

Prior Year   

  Prior Year Tuition Due Charge

  Prior Year Fees Due Charge

  Pmt/Prior Year Payment‐Non‐Deductible 

  Prior Year Balance Balance

Late Charges   

  Late Charge Due Charge

  Pmt/Late Charge Payment‐Non‐Deductible 

  Late Charge Balance Balance
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Volunteer/Service 
Hours 

 

  Hours Pledged Hours Pledged 

  Library Hours Hours Completed 

  Playground Hours Hours Completed 

  Teaching Assistant Hours Completed 

  Service Hours Hours Completed 

  Hours Remaining Hours Remaining 

Misc. Activities   

  Gift – Sports Equipment Additional Gift‐Deductible 

  Gift – Donation to Library Additional Gift‐Deductible 

  ISF Check Ignore

Pledge Drive 
Group  Activity Function

Pledge Payments   

  Pledge Payment Due Charge

  Pmt/Pledge Payment‐Deductible 

  Initial Payment Payment‐Deductible 

  Deposit Payment‐Deductible 

  Payment to Reduce Rate Pay Down‐Deductible 

  Non‐Cash Donation Non‐Cash Contribution‐Deductible

  Volunteer Credits Credits‐Non‐Deductible 

  Fall Dinner/Dance $20 Quid Pro Quo

  Auction & Dinner $25 Quid Pro Quo

  Pledge Balance Balance

Volunteer/Service 
Hours 

 

  Hours Pledged Hours Pledged 

  Completed Hours Hours Completed 

  Hours Remaining Hours Remaining 

Misc. Activities   

  Church Furnishings Additional Gift‐Deductible 

  Stained Glass Additional Gift‐Deductible 

  ISF Check Ignore
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Extra Contributions 
Group  Activity Function

Extra Contributions   

  Missions Payment‐Deductible 

  Charity & Development Payment‐Deductible 

  Rice Bowl Payment‐Deductible 

  Bishop’s Relief Payment‐Deductible 

  Special Needs Payment‐Deductible 

  Communication Payment‐Deductible 

  Home Missions Payment‐Deductible 

  Propagation of Faith Payment‐Deductible 

  Retirement Fund Payment‐Deductible 

  Emergency Fund Payment‐Deductible 

  Total Extra Group Total 

Misc. Activities   

  ISF Check Ignore
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Status Icons 
These icons are used within the program to indicate certain characteristics of individuals. Below are 
figures that show these icons as they would be displayed on the Parents/Guardians windows, the 
Students windows, and the Catechists windows.  

 
Fig. 17‐1. 

 
Fig. 17‐2. 

 

Indicates the individual has a different last name than the family.
Displays in the Members window beside the family's name. 

 

Indicates the family or individual has confidential remarks.
Displays in the Families and Members windows beside the name. 

 

Indicates the individual has special circumstances.
Displays in the Members window beside the individual's name. 

 

Indicates the family or individual is also in Church Office.
Displays in the Also Visible In section of the Families and Members windows. 

 

Indicates the family or individual is also in School Office.
Displays in the Also Visible In section of the Families and Members windows. 

 

Indicates the individual is a student in School Office.
Displays in the Also Visible In section of the Members window. 

 

Indicates the individual is a teacher in School Office.
Displays in the Also Visible In section of the Members window. 

 

Indicates the individual is a catechist in Formation Office.
Displays in the Also Visible In section of the Members window. 

 

Indicates the individual is a student in Formation Office.
Displays in the Also Visible In section of the Members window. 
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18:  Answers 

Chapter 1 ‐ About Families 

Exercise Instructions 
Exercise #1 — Add your own family. Include the following information:  

 Your name, using the Family Name dialog box. 

 Your address. 

 Your work phone and home phone. Indicate that the home phone is unlisted. 

 Your email. 

 A family keyword, such as "Receives Newsletter." 

To do this 

1. On the Information tab, Families. 
2. In the Tasks group, click Add Family. 
3. In the Add Family dialog box, click Add New Family. 
4. In the Family Name field, start typing your last name. In the Family Name dialog box, enter the 

different parts of your name, then click Apply/OK. 
5. Enter your address, city, state, and ZIP code. If your city is not in the keyword list, click Add to the 

List. 
6. Enter your email address. 
7. Enter your phone number and a description. If the description is not in the keyword list, click Add 

to the List. 
8. Under Family Keywords, click Insert, and enter an appropriate keyword, such as "Receives 

Newsletter." If the keyword is not in the list, click Add to the List. 
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Answers to Questions 
Q:  What two things should not be used in ID numbers? 

A:  Leading zeros and letters of the alphabet. 

 

Q:  How many phone numbers can a family have? 

A:  A family can have an unlimited number of phone numbers. 

 

Q:  How many keywords can a family have? 

A:  A family can have an unlimited number of family keywords. 

 

Q:  Where can you record confidential remarks about a family? 

A:  In the Primary Information section of the Families window, under Remarks, select Confidential, then 

enter your remarks. 

 

Q:  How can you send a letter addressed directly to the family? 

A:  In the navigation pane of the Families window, click Individual Letter, Label. 
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Chapter 2 ‐ Students 

Exercise Instructions 
Exercise #1 — Add a student to your family. Use the following information:  

 Name — Miss Elizabeth Williams "Betsy" 

 Birth date — 12/10/2003 

 Grade — 3 

To do this 

1. On the Information tab, click Students. 
2. In the Tasks group, click Add Student. 
3. In the dialog box, select your family from the drop‐down list, then click Add to This Family. 
4. In the Name field, start typing the student's name. In the dialog box, enter the different parts of 

the student name, then click Apply/OK. 
5. In the Birth Date field, enter 12/10/2003. 
6. In the Grade/Degree drop‐down list, select 3. 

Exercise #2 — Add the following sacrament information for Betsy. 

 She was baptized on 12/15/2003 at this parish. 

 The baptism was performed by Fr. Robert Zello. 

 She is sponsored by Melissa Brown, a family friend. 

To do this 

1. In Betsy's student record, in the navigation pane, click Sacraments. 
2. On the Baptism tab, in the Date field, enter 12/15/2003. 
3. In the Status drop‐down list, select Yes, then in the Addl drop‐down list, select Perf. Here. 
4. In the Performed by field, enter "Fr. Robert Zello". 
5. Under Sponsors/Witnesses, enter "Melissa Brown". In the Type field, enter "Family Friend". If 

this type is not in the list, click Add to the List. 

Exercise #3 — Print the Baptismal Certificate for Betsy. 

To do this 

1. In Betsy's Sacraments window, click the Baptism tab. 
2. Click Print Certificate. 
3. Select a baptismal certificate, click Next twice, click Preview Report, then Print. 

Exercise #4 — Add an emergency contact for Betsy. Use the following information:  

 Contact Name — Mrs. Esther Williams, grandmother 

 Address — 123 Sugar Plum Lane, Glendale, AZ 85055 

 Home Phone — (623) 545‐9087 
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To do this 

1. In the navigation pane of Betsy's student record, click Contacts. 
2. Click Add Contact. 
3. Click No. 
4. In the Name field, enter "Mrs. Esther Williams". 
5. In the Relationship drop‐down list, enter or select Grandmother. 
6. Enter the address and phone information, then click Save. 

Answers to Questions 
Q:  What symbol indicates that the student has a different last name? 

A:  A yellow flower displays when a student has a different last name. 

 

Q:  What information can you add to the Communications window? 

A:  You can add student phone numbers, email addresses, and social media information. You cannot 
modify the other information because it displays information from the Families window. To change that 
information, you must go to the Families window. 

 

Q:  How many emergency contacts can a student have? 

A:  A student can have an unlimited number of emergency contacts. 

 

Q:  How can a student "borrow" a sibling's emergency contact? 

A:  When you click Add Contact, the program asks if you want to borrow a contact from a family 
member's record. Click Yes, select the contact you want to borrow, then click Use Marked Contact(s). 

 

Q:  What is the maximum number of sacraments that can display at once in the Sacraments window? 

A:  Eight, but you can display an unlimited number of sacraments on the Date List tab. 

 

Q:  Where do you change the order of the sacrament tabs? 

A:  On the File menu, click Sacrament Setup > Sacrament Tab Names. 

 

Q:  Where do you maintain the actual Sacrament Date names? 

A:  On File menu, click Keywords > Student/ Parent/Guardian Keywords > Sacrament Date Names. 

 

Q:  How do you print a Confirmation Certificate from the sacrament tab? 

A:  In the navigation pane of the student's record, click Sacraments, then on the Confirmation tab, click 

Print Certificate, and select one of the confirmation reports.   
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Chapter 3 – Parents & Guardians 

Exercise Instructions 
Exercise #1 — Fill out the information on the Parent/Guardian Personal window for the family you 
created in exercise #1:  

To do this 

1. On the Information tab, click Parents & Guardians. 
2. If you had the check boxes selected to add Head & Spouse in the first exercise, then there should 

be a record already started for you. If not, in the in the Tasks group, click Add Par/Grd. In the 
dialog box, select your family from the drop‐down list, then click Add to This Family. 

3. Enter the relationship, type, gender, and birthdate. 
4. Enter the martial status, grade, and other keywords. Click Add to the List if any of your keywords 

are not in the keyword list. 

Answers to Questions 
Q:  What is the difference between a Talent, a Ministry, and a Keyword? 

A:    A talent is a skill.               

  A ministry is an area of volunteer or interest.       

  A keyword is a particular attribute or indication of part of a specific group. 

 

Q:  Where would you record a parent’s attendance to a Sensitivity Training seminar? 

A:  On the Information tab, click Parents & Guardians > Safe Environment. In the Other Requirements 
section, click Insert. 

 

Q:  Where do you record a parent’s attendance to classes associated with their student’s sacraments? 

A:  On the Information tab, click Parents & Guardians > Volunteer/Prep Classes. 
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Chapter 4 – Class Schedules 

Exercise Instructions 
Create a session using the following information.  

 Name:  Learning the Saints 

 Year/Period:  2015/2016 

 Grade Level:  5th grade. 

 Time:  from 7pm to 9pm 

 Room:  Classroom 101 

 Date Range:  September through April 

 Frequency:  Every Third Wednesday of the Month 

 

To do this 

1. On the Information tab, click Class Schedules. 
2. In the Tasks group, click Add Class. 
3. Enter the session name and grade level. 
4. In the Catechists section of the Session Information window, click Insert, and select a catechist. 
5. Enter the time, room, and date range. Click Add to the List if the time and room are not in the 

keyword lists. 
6. Click Set Frequency. Select Weekly. Select the check boxes for ‘Every Third’ and ‘Wednesday’. 

Click Add to Class Dates.   
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Chapter 7 – Tuition and Fees 

Exercise Instructions 
 
Exercise #1:  Set up a fund. 

1. On the Administration tab, click Fund Setup. Click Add Fund. 
2. Enter the following values:  

Fund Identifier:  RE 

Fund Name:  Religious Education 

Due Date Based on:  Fund Period 

Recurring Charges:  First Day 

Period:  RE‐14, from July 2014 to June 2015 

Goal:  $20,000 

3. When the program asks if you want to use predefined fund activities or make your own group, 
select Make Group.  

4. Add the following group titles and activities:  

One Student Tuition 

One Student Tuition Due – Charge 

Pmt/One Student Tuition – Payment Non‐Deductible 

One Student Tuition Bal – Balance 

Two Students Tuition 

Two Students Tuition Due – Charge 

Pmt/Two Students Tuition – Payment Non‐Deductible 

Two Students Tuition Bal – Balance 

3 or More Students Tuition 

3 or More Students Tuition Due – Charge 

Pmt/3 or More Students Tuition – Payment Non‐Deductible 

3 or More Students Tuition Bal – Balance 

Registration Fees 

Reg Fee Due – Charge 

Pmt/Reg Fee – Payment Deductible 

Reg Fee Bal – Balance  

5. Click Save. 
6. Click Add to Fams. 
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Exercise #2:  Set up a family for a tuition payment of $10 each week for the entire fund period. 

1. On the Information tab, click Tuition & Fees.  
2. If you followed all steps in exercise 1, then this fund should be set up for everyone. Click Funds 

Used and select the RE‐14 fund. If you did not complete the last step in exercise 1 and this fund 
has not been added to this family, click Add Fund, then select fund RE‐14. 

3. Click Add Rate. 
4. Select the following values:  

Recurring Act:  One Student Tuition 

Terms:  Weekly 

Billing Period:  7/1/2014 to 6/30/2015 

Rate:  10.00 

5. Click Save. The total will calculate based on the rate, term, and billing period. 

Exercise #3:  Set up a family for a tuition payment of $50 each quarter from August 2014 to April 2015. 
When is the first payment due? 

1. Select a different family from exercise #2. 
2. Select fund RE‐14 if you completed the final step of exercise 1. Otherwise, this family does not 

have this fund added, and you need to add this fund. Click Add Fund, and select fund RE‐14. 
3. On the Rates/History/Keywds window, click Add Rate. 
4. Select the following values:  

Recurring Act:  One Student Tuition 

Terms:  Quarterly 

Billing Period:  8/1/2014 to 4/30/2015  

Rate:  50.00 

5. In the navigation pane, click Recap/Totals. Because the due dates are based on the fund period 
(starting in July), the first payment will be due October 1 (they missed the first fund period 
quarter of July‐August‐September). 

Exercise #4:  Set up a family for a tuition payment of $150 monthly, for a total of $2000. What special 
conditions must be made? 

1. Stay on the same family as exercise #3. 
2. On the Rates/History/Keywds window, click Add Rate. 
3. Select the following values:  

Recurring Act:  One Student Tuition 

Terms:  Monthly 

Billing Period:  7/1/2014 to 6/30/2015 

Rate:  150.00 

4. Click Save. The total will calculate as $1800. Change the total to $2000, and click Save. 
5. Click Leave Same Rate in the dialog box that appears.  
6. In reviewing the rate and total, you will see the original values of $150 per month with a total of 

$1800. Next to these amounts in parenthesis, you'll see ($350) for the final payment and 
($2000.00) for the total. If you go to the Recap/Totals window, you will see this family has a 
$150/monthly tuition with a final payment of $350, totaling $2000. 
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Exercise #5:  Set up one student of the family with a tuition payment of $20 Weekly and another student 
as $100 Monthly for the entire fund period. Which student's total will be higher? 

1. Select a different family than in exercises 2 and 3. 
2. Select fund RE‐14 if you completed the final step of exercise 1. Otherwise, this family does not 

have this fund added, and you need to add this fund. Click Add Fund, and select fund RE‐14. 
3. On the Rates/History/Keywds window, click Add Rate. 
4. For the first student, select the following values:  

Recurring Act:  One Student Tuition 

Terms:  Weekly 

Billing Period:  7/1/2014 to 6/30/2015 

Rate:  20.00 

5. Click Add Rate again. For the second student, select the following values. 

Recurring Act:  One Student Tuition 

Terms:  Monthly 

Billing Period:  7/1/2014 to 6/30/2015  

Rate:  100.00 

6. The student paying monthly will pay more ‐ $1200 versus $1060 for the student paying Weekly. 

Exercise #6:  Set up a family for a tuition payment of $100 per month, with a pay‐down of $300. 

1. Make sure the fund has a pay‐down activity. On the Administration tab, click Fund Setup, then 
position your pointer on the One Student Tuition Bal activity, and click Insert. When asked if you 
want to insert a predefined group of activities, select No. A new line is inserted above the 
Balance activity. Enter an activity name "One Student Pmt/Reduce Rate" and select a function of 
Pay Down‐Non Deductible. 

2. Click Save.  
3. On the Information tab, click Tuition & Fees. This should be set to the family used in exercise #5, 

but you can click Next Family in the navigation group to go to the next family. Select fund RE‐14 
if you completed the final step of exercise 1. Otherwise, this family does not have this fund 
added, and you need to add this fund. Click Add Fund, and select fund RE‐14. 

4. On the Rates/History/Keywds window, click Add Rate. 
5. Select the following values:  

Recurring Act:  One Student Tuition 

Terms:  Monthly 

Billing Period:  7/1/2014 to 6/30/2015 

Rate:  100.00 

6. At the bottom in the History section, click Insert and enter this posting:  

Date:  7/1/2014 

Activity:  One Student Pmt/Reduce Rate 

Amount:  $300.00 

7. Click Save. The rate now changes to $75 per month. ($100 x 12 months = $1200. $1200‐300, 
divided by 12, = $75) 

8. The rate has $75 in parenthesis, indicating the change. The total shows $1200 in parenthesis. 
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Answers Questions 
Q:  What three activity types would you need to track a Bus Fee? 

A:  Charge, Payment, and Balance. 

 

Q:  Can you post to fund 1‐14 after fund 1‐15 has been created? Why or why not? 

A:  Yes,because the prior fund periods are not locked or deleted when a new period is created. 

 

Q:  What is the difference between “Weekly” and “Weekly on Tuesday”? How is this distinction useful? 

A:  “Weekly” means every 7th day starting with the Billing Start Date. “Weekly on Tuesday” (or other day 
of the week) means every Tuesday (or selected day) within the billing period. This can be used to make 
sure you have 52 weeks in a year. 

 

Q:  What is the difference between Fund Period, Billing Period, and Calendar Year? 

A:  Fund Period is the named time frame on the Fund Setup window. Billing Period is the time period for 
the families/tuition or period the family is pledging. Calendar Year is January to December. 

 

Q:  What are the four rules for fund periods? 

A:    1. Fund periods cannot overlap.             

  2. Fund periods should not be less than one year.         

  3. Fund periods can cover more than one year.         

  4. Fund periods do not have to begin in January.         

 

Q:  What is special about Quid Pro Quo activities? 

A:  The activity must have the value of the item received as part of its name. 

 

Q:  What activity type would you use to post a payment that reduces the rate but not the total pledge? 

A:  Pay‐down deductible or Pay‐down non‐deductible. 

 

Q:  What activity type would you use to post stock? 

A:  Non‐Cash contribution. 

 

Q:  What section of the Tuition & Fees window would you access to see the family’s fund status through 
today? 

A:  Recap/Totals. 
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Chapter 8:  Quick Posting Processes 

Exercise 
Exercise #1:  Post geographic area "1A" to all families who live in Phoenix. 

1. On the Information tab, click Families. In the Other Tasks section of the navigation pane, click 
Quick Posting. Finally, click Area Posting. 

2. Select Automatic Updating. Click Next. 
3. On the Additional Selections tab, click <Click here to add new Condition>. Use the following 

selection: Fam.City is equal to Phoenix, AZ 
4. Click Next. Select Assign the Same Area to selected Families. Enter "1A". Click Next. 
5. After the program builds the list, click Next, then Finish. 

Exercise #2:  Post grade 3 to all eight‐year‐olds. 

1. On the Information tab, click Students. In the Other Tasks section of the navigation pane, click 
Quick Posting. Finally, click Grade Levels. 

2. Select Automatic Updating. Click Next. 
3. On the Additional Selections tab, click <Click here to add new Condition>. Use the following 

selection: Student.Age is equal to 8. 
4. Click Next. Select Assign the Same Grade Level to selected Students. Select grade 3 from the 

drop‐down list. 
5. Click Next. 
6. After the program builds the list, click Next, then Finish. 

Exercise #3:  Post a $10 late fee to families who are behind on their pledge in fund RE‐14. 

1. First, go to the Fund Setup window and add a group of activities for late fees. Click Insert. When 
asked if you want to insert a predefined group of activities, click Yes. Select the Formation 
predefined group, click Clear All, then select the Late Charges group which should select all 
activities within that group. Click Use/OK.  

2. On the Information tab, click Tuition & Fees. In the Other Tasks section of the navigation pane, 
click Quick Posting. Finally, click Post Family Fees. 

3. Select Automatic Updating. Click Next. 
4. On the Additional Selections tab, click <Click here to add new Condition>. Use the following 

selection: Fund Totals.Recap Balance is greater than 0. 
5. Click Next. Select Assign the Same fee to selected Families. Enter the following:  

Date:  today’s date 
Fund Identifier:  RE‐14 
Fee Name:  Late Charge Due 
Amount:  $10.00 

9.6. After the program builds the list, click Next, then Finish. 
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Answers to Questions 
Q:  Are quick postings used to update existing information or add new information? 

A:  Add new information. 

 

Q:  What must be set up before you can post a late fee to individual families? 

A:  A Late Fee group, including a Late Fee activity (charge type), a Payment of Late Fee activity (payment 
deductible type), and a Balance of Late Fee activity (balance type). 

 

Q:  Which quick posting would you use to assign fourteen‐year‐olds to a new confirmation class? 

A:  On the Information tab, click Students > Quick Posting > Classes or Sessions. 

 

Q:  Which quick posting would you use to record that students have completed Confirmation?  

A:  On the Information tab, click Students > Quick Posting > Dates. 

 

Q:  Which quick posting would you use to assess a $25 sacrament fee per student?  

A:  On the Information tab, click Tuition & Fees > Quick Posting > Post Student Fees. 

Chapter 9:  Processes 

Exercises 
Exercise #1:  Make families from ID 1 to 100 inactive. 

1. On the Information tab, click Families. 
2. In the Other Tasks section, click Processes. Finally, click Activate/Inactivate. 
3. Select Automatic Updating. Click Next. 
4. Select Make Families Inactive. Click Next. 
5. Click <Click here to add new Condition>. Use the following selection: Fam.ID  Number is 

between 1 and 100. 
6. Click Next. After the program builds the list, click Next, then Finish. 

Exercise #2:  Promote children in grades 1 through 12, marking 12th graders as Young Adult. 

1. On the Information tab, click Students. 
2. In the Other Tasks section, click Processes. Finally, click Grade Promotion. 
3. Select Promote both the Formation Grade and the School Grade, and click Next. 
4. Select 1 from the Begin Promotion with Grade drop‐down list. Select 12 from the End Promotion 

with Grade drop‐down list. 
5. Select the check box labeled Change the type for those currently in the last grade listed below 

from Child to Young Adult. 
6. Click Next. After the program builds the list, click Next, then Finish. 
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Exercise #3:  Change the status of members with Ministry of Lector to Actively Involved. 

1. On the Information tab, click Students. 
2. In the Other Tasks section, click Processes. Finally, click Change Ministries. 
3. Select Only include members with this specific ministry. Select Lector from the drop‐down list. 
4. Click Next. 
5. Select All Family Members, and click Next. 
6. Select Post Changes for All Members. Click Next. 
7. Select Assign the same changes to all selected family members. Select Actively Involved from 

the New Status for All drop‐down list.  
8. Click Next. After the program builds the list, click Next, then Finish. 

Questions 
Q:  Which process would you use to promote the entire 3rd Grade Formation class to the 4th Grade 
Formation class? 

A:  On the Information tab, click Students > Processes > Automatic Class/Session Promotion. 

 

Q:  Mrs. Finch, the Confirmation catechist, retired in the middle of the year. What process would you use 
to assign her classes to Mr. Novak? 

A:  On the Information tab, click Students > Processes > Catechist Exchange. 

 

Q:  Which process would you use to add 50 new students from Church Office to Formation Office? 

A:  On the Information tab, click Students > Processes > Quick Add from Shared Data File. 

 

Q:  Which process would you use to set up fund 3, Tuition, for the next school year, and add that fund 
period to all the families that had it last year? 

A:  On the Information tab, click Tuition & Fees > Processes > New Year Fund Setup. 

 

Q:  Which process would you use to combine duplicate family records? 

A:  On the File Menu, click System Processes > Combine Families. 
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Chapter 11:  Reports 

Questions 
Q:  What are the six steps to running a report? 

A:  Select WHAT report, settings OVERVIEW, WHERE to print, HOW it will look (layout), WHICH fund, 
family, student (selections), and PRINT. 

 

Q:  What are the six types of reports? 

A:  List, Letter, Label, Envelope, Form, and Export. 

 

Q:  How do you access reports? 

A:  You can access reports from different locations in the program. On the ribbon, click Information. In the 
navigation pane of the Families, Students, Parents & Guardians, or Tuition & Fees windows, click Reports. 
Or access all reports on the Reports tab. 

The program displays the available reports for the area of the program you are currently in. To see all 
available reports, select All Reports. 

 

Q:  Your neighbor church has created a wonderful family listing report. How would they save the report? 
How would you install it? 

A:  To save it:  go to Reports, highlight the report, and click Save as Custom Report. 

      To install it:  go to Reports, and click Add > Custom Report. 

 

Q:  What is a style? How many styles can you create? 

A:  A style is a saved set of formatting elements, such as page style or margin style. You can create an 
unlimited number of styles for each type. 

 

Q:  What are Smallest Margins? 

A:  Smallest Margins are a special margin style that uses the maximum possible printing area, as 
designated by the printer driver. 

 

Q:  What is Simple Selection – Never Saved? 

A:  Simple Selection is a special selection type that is used when you don’t want to save the selections you 
are about to use. 
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Chapter 12:  Keywords 

Exercises 
Exercise #1:  Make a new User Keyword. 

1. On the File menu, click Keywords > Student / Parent / Guardian Keywords > User Keywords > 
User KW 6. 

2. Enter the Keyword Name  "Ice Cream". Select Formation then select the check box to appear on 
the Students window. 

3. Click Insert and enter the three flavors under description. Click Save/OK, then Close. 
4. On the Information tab, click Students. Select or enter Strawberry as the flavor preference on 

any student record, in the Personal window. 
5. On the student's record, expand the Ice Cream keyword list, and click Manage. Replace 

"Strawberry" with "Cherry". Click Save/OK, then Close. 
6. View the student record from step 4. 

Exercise #2:  Combine two keyword entries. 

1. Expand the Ice Cream keyword list on the Students Personal window, and click Manage. Click 
Insert and enter "Black Cherry". Click Save/OK, then Close. 

2. Select Black Cherry as the flavor preference on any student record. 

3. Expand the Ice Cream keyword list on the Students Personal window, and click Manage. Click 
Combine.  

4. Select Black Cherry in the Select a Keyword to Change column. Select Cherry in the Change it to 
this Keyword column. 

5. Click Add to List of Changes Below. Click Combine/OK. Click Save/OK, then Close. 

6. View the student record from step 2. 

Exercise #3:  Delete a keyword entry. 

1. Expand the Ice Cream keyword list on the Students Personal window, and click Manage. Click 
Delete.  

2. Select the check box for Cherry. Click Delete/OK. 

3. Click Close. 

Questions 
Q:  How many User Keywords are available? What windows do they appear on? 

A:  Twelve. Eleven can be set up to appear on the Students and Parents/Guardians Personal window, and 
one appears on the Families Primary Information window. 

 

Q:  How many entries can you have in each keyword list? 

A:  Unlimited. 

 

Q:  What are the four commands available in every keyword list? 

A:  Insert, Delete, Combine, and Print. 
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Q:  What is the extra command on the Grade keyword list? 

A:  Re‐Order. 

Chapter 13:  View Listings and Easy Lists 

Exercises 
Exercise #1:  Get a list of children and young adults with different last names, showing grade and address. 

1. On the Information tab, click Students. 
2. In the navigation pane, click Easy Lists, then select Different Last Names List. 
3. Select Only Include Members with the Following Types. Select Young Adult and Child, then click 

Apply/OK. 
4. Click Customize View. 
5. Click and drag all fields, except ‘Mem Name’, from Fields you Want to View to Fields Available 

to View. 
6. Click and drag ‘Mem Grade’ and ‘Family Address Block’ from Fields Available to View to Fields 

you Want to View. 
7. Click Save/OK. 

Exercise #2:  Get a list of single female parents between the ages of 25 and 50 and send them a letter. 

1. On the Information tab, click Students. 
2. In the navigation pane, click Easy Lists, then select List of Parents. 
3. In the Gender drop‐down list, select Female. 
4. For Marital Status, select to Only Include Parents with the Following Marital Statuses, and then 

select Single, Divorced, and Widowed. 
5. For Age, select Include Parents of the Following Age, then enter Start with Age of 25 and End 

with Age of 50. 
6. Select Only Include Parents with Children, then click Apply/OK. 
7. Click Easy Letter. Refer to the Reports chapter of this training guide for details on modifying the 

text of a letter and using the report wizard. 

Exercise #3:  Get a list of students who are in the 1st Grade Formation class. 

1. On the Information tab, click Students. 
2. In the navigation pane, click Easy Lists, then select Class List. 
3. In the Class Name drop‐down list, select 1st Grade Formation. 
4. Click Apply/OK. 

Exercise #4:  Get a list of parents who have volunteered to be part of the car pool. 

1. On the Information tab, click Students. 
2. In the navigation pane, click Easy Lists, then select Parent Volunteer List. 
3. In the Volunteer Area drop‐down list, select Car Pool. 
4. Click Apply/OK. 
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Questions 
Q:  Which main program section includes financial fields as part of its listing screen's Customize View 
options? 

A:  The Tuition & Fees listing screen. 

 

Q:  The width of a column cannot be smaller than what? How could you make it smaller? 

A:  Its heading. Use Customize View to change the heading. 

 

Q:  Which command button would you use to get the original columns back in an Easy List? 

A:  Use Default Values to get the original columns back in Easy Lists. 

Chapter 14:  CASS & EZ‐Mail 

Exercises 
Exercise #1:  In step 1 of the EZ‐Mail feature, enter the following mailing specifications:  

1. On the File menu, click Bulk Mail / CASS > EZ‐Mail. 
2. On the Step 1:  Mailing Specifications tab, enter the mailing specifications. 

Zip Code:   Enter the zip code of your post office or your own if you do not know theirs. 
Mailing Class:   Standard‐class – Non Profit 
Your Permit Number:   1234 
Date of the Proposed Mailing:   1 week from today. 
Carrier Route Trays:   Yes 
Merge SCF:   Yes 
Number of Pieces:   60 
Weight of a Single Piece:   0.401 
Postage Payment Method:   Permit Imprint 
Postage Already on Each Piece:   $0.00 
Type of Discount:   DSCF 

12.3. Click Save/OK. 

Exercise #2 — Build an EZ‐Mail list of student addresses. Then, in the Select Report window, under 
Label/Envelope Reports in Upper Case, run the Student Mailing Label ‐ Barcode at Bottom report. Make 
sure you change the sort order to EZ‐Mail. 

1. On the File menu, click Bulk Mail / CASS > EZ‐Mail. 
2. Make sure you have completed the steps in exercise 1. 
3. On the Step 2:  Build the EZ‐Mail List, click Build a List of Student Addresses. 
4. Use the Select Students window to filter the list of students that will be included in your bulk 

mailing, then click Build List. 

 
 Important Note 

This step does not produce labels or envelopes; it merely identifies who you want to include in 
the EZ‐Mail list. 
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5. On the Information tab, click Students. 
6. In the navigation pane, click Reports, or on the Reports tab, click Student Reports. 
7. Expand the Label/Envelope Reports in Upper Case report category, then select Student Mailing 

Label – Barcode at Bottom. 
8. Click Next, or double click the report name in the Select Report list to begin the report wizard. 
9. Select the printer. 
10. Set the layout. 
11. On the Select Students step of the report wizard, in the Sort Order drop‐down list, select EZ‐Mail. 
12. Click Preview. 

Chapter 15:  Additional Features 

Exercises 
Exercise #1:  Change the program name to “Sue’s Favorite Program”, but use your own name. 

1. On the Quick Access toolbar, click  . 
2. For Program Name, enter your name then "Favorite Program". 
3. Click Save/OK, then Close. 

4. Return to the Home window to view this change. On the Quick Access toolbar, click  . 

Exercise #2:  Create a user profile for yourself, including a password. Make yourself a security 
administrator, and give yourself All Access to everything, including Individual Funds. 

1. On the Administration tab, click Users & Passwords. 
2. In the Tasks group, click Add User. 
3. Enter your name and a password. 
4. For Security Adm., select Yes. 
5. On the Access and Privileges window, click Mark All All Access. 
6. In the navigation pane, click Individual Fund Access, then click Mark All All Access. 

Exercise #3:  Set the security method to ask for name and password. 

1. On the Administration tab, click Users & Passwords. 
2. In the navigation pane, click Set Security Method. 
3. Select The User is asked for a Name and Password. 
4. Click Save/OK, then Close. 
5. You must exit the program and re‐enter before this setting takes effect. 

Exercise #4:  Add HRH – ‘Her Royal Highness’ – to the Title Definitions. 

1. On the File menu, click Setup > Title Definitions. 
2. Click Insert Abbreviations.  
3. Enter HRH for Abbreviation. Enter Her "Royal Highness" for mailing title and salutation title. 
4. Enter "Monarchy" for description. 
5. Click Save/OK, then Close. 
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Questions 

Q:  Where do you go to change the term used for tracking Service/Retreat attendance? 

A:  On the File menu, click Setup > Unit Name Definition. In the Service/Retreats Units field, enter the 
term you would like to use (i.e. Hours, Days, Units).  

 

Q:  Where do you maintain the names and addresses of the churches tracked in Sacraments? 

A:  On the File menu, click Sacrament Setup > Sacrament Place Names and Addresses. 
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